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Safety and reading instructions

Read this documentation before working with the PSS 5000 / PSI 6000 / PST 6000 weld
timers for the first time.

Store this manual in a place to which all users have access.

The products described were developed, manufactured, tested and documented in com-
pliance with the fundamental safety requirements of the EU Machine Directive.

Nevertheless, there still is some residual risk!

Warnings

There is a certain hierarchy of warnings in this manual. The warnings are printed in bold
letters and marked by a warning sign at the margin.

The hierarchy of the warnings is as follows:
1. WARNING
2. CAUTION
3. NOTE

WARNING!

The term WARNING will be used wherever danger is imminent.
The possible consequences may be death or severe injury (personal injury).

CAUTION!

The term CAUTION will be used wherever a dangerous situation is possible. 
The possible consequences include death, severe or light injury (personal injury), dam-
age to property (destruction of modules) or environmental hazards.
In any case, no warranty claims will be accepted in the event of non-compliance/the fail-
ure to observe this warning.

NOTE

The term NOTE will be used for making recommendations on the use. Here you can
find additional notes, recommendations, information, and tips.
Non-compliance with these recommendations may result in damage to property, e.g. to
the machine or the workpiece.

!

!
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Typographic conventions

General listing - Example: - The message is 
displayed on the
screen.

Activities D Example: D Insert floppy disk,
D Read value.

Screen displays, Italics Example: Battery empty
messages, displays, Dress request.
menu items

(Welding) parameters [in brackets] Example:                [Weld time],[Schedule].

Interface signals, keys, <Key> Example: Press <F8>
command buttons

Inputs: Values, texts CAPITAL LETTERS

Changes and additions to the previous documentation (revision bar on side).
 

Using the manual

The present manual for Weld Timers (WT) of the PSS 5000 / PSI 6000 / PST 6000 series
contains instructions for:

- Programming, and
- Operation

using the BOS-5000 software from Version 2.80.

The scope of the manual refers to the use of the weld timers as:

- PSS 5000 : �Stand-alone� module in a suitable switch cabinet
- PSI 6000 : integrated module in a medium-frequency power unit
- PST 6000 : integrated module in a thyristor power unit

Any other use is deemed inappropriate!
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Qualified personnel

The present manual is designed for specially trained technicians and engineers with
special knowledge of the welding technology.

They must have profound knowledge of:

- weld timers
- power units
- welding transformers

The term qualified personnel refers to

- engineering personnel familiar with the safety standards of the electrical and au-
tomation technology.

- commissioning personnel entitled to commission, earth and label electrical circuits
and equipment/systems in compliance with the standards of safety technology.

- operating personnel who have been instructed in operating installations in resis-
tance welding technology and who know the contents of the present documenta-
tion as far as operation is concerned.

WARNING!

An exception are persons with cardiac pacemakers!
Due to the strong magnetic fields arising from resistance welding, the function of cardiac
pacemakers may be disturbed. This may cause the death or considerable health dam-
ages to persons with cardiac pacemakers!
Therefore, these persons should avoid the welding system.

Please note our comprehensive range of training courses. More information is available
from our training center (Phone: ++49 / 6062 / 78-258).

!
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1 Installation

1.1 Notes on operation

The BOS-5000 user interface is used for a large number of timer types of the PSS 5000 /
PSI 6000 / PST 6000 series. For operation, general knowledge of Windows is required.

CAUTION!

Please note the Safety Instructions in all circumstances.
You should always exit Windows and BOS-5000 properly with the functions provided for
this purpose before you switch the programming terminal off.

- All inputs can be made with the mouse or the keyboard.

- Ghosted parameters are not active, i.e. an input is not possible, the function is not
available.

- Ghosted menu items cannot be selected when:
- the function is not available
- the user has no access privileges
- the function has been deactivated

- Some parameters depend on the timer type, therefore, they are not offered for all
timer types.

- A parameter description including the possible input range is displayed in the
status bar.

- The selection bar shows the current selection required for the corresponding func-
tion or the window.

Incorrect input values

If incorrect values have been input

- the current window cannot be closed
- the lowermost window bar shows the permitted input range
- an adjustment may have to be made in the Basic-Setup.

!

1
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1.2 General Prerequisites

The software BOS-5000 is stored on a CD and can be run when installed under
WINDOWS (WINDOWS is a registered trademark of Microsoft, Inc.). A floppy disk set
may be extracted from the CD, cf. section 1.4.

Requirements:
- Windows 3.1X, Windows 95, Windows 98, Windows NT 3.X / NT 4.0
- �486� processor or higher
- at least 24 MB of free RAM
- at least 50 MB free hard disk capacity

NOTE

The working speed of the software BOS-5000 depends on the processor speed and the
RAM.
We recommend using a state-of-the-art computer.

NOTE

For WINDOWS versions which do not provide the SHARE function the SHARE com-
mand must be installed before calling up WINDOWS.
This can be done manually at the DOS operating system level, however, you should
never forget it when restarting the computer.
If the SHARE command is to be called up automatically, SHARE must be entered in your
autoexec.bat file.
This is not required for WINDOWS 3.11 / Windows 95 / Windows NT because SHARE is
implemented in this version.
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1.3 Installing the Software BOS-5000 from the CD

NOTE

Close all Windows programs before installing the BOS-5000 software.

NOTE

Before starting with the installation of the BOS-5000 software, earlier versions should be
uninstalled, or the new installation should be made in another folder.

When installing the software in an existing BOS-5000 folder, you should previously save
the Upload file(s), the Timer and Spot References (Starting window - System - Save pro-
ject). Then you should uninstall the previous BOS-5000 version.

D Start the Setup.exe routine on your CD drive

D Select the language for the installation displays

The default folder for installation is PS5000. You may change this default setting with the
<Browse> button.

1
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D Select the interface between the software and the weld timer.
- OFFLINE timer: If the programming terminal is not connected to a timer and

you want to work in offline mode.

- appropriate interface if weld timers are connected.

Then the BOS-5000 software is installed on your computer and can be started after-
wards.
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1.4 Extracting a floppy disk set from the CD

D Choose the directory on the CD:
- 16 bit for 16-bit operating system (Windows 3.XX)
- 32 bit for 32-bit operating system (Windows 95 / 98 / NT3.X / NT4.X)
- language

D Copy the contents of the \DISK1 to \DISKn directories to one floppy disk each.

NOTE

If you use the Windows Explorer for copying, please note that in View - Options
(Windows 95) or in View - Folder Options - View (Windows 98 and Windows NT ) �Show
all files� has been activated.

D Start the Setup.exe routine on Disk1.

D Proceed analogously as described in Section 1.3

1
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2 Operating structure

2.1 How to create your first welding program

Timer-Reference Spot-Reference Operation

Starting window

File

Status

Exit <Alt> + <F4>

Upload

Download

Stepper Status<F2>

Fault table  <F3>
Current status

Programming

Data→WT <Ctrl> + <F2>

Param.→WT <Ctrl> + <F3>

Pg Back <F9>

Exit <Alt> + <F4>

Sct. 7.5 Sct. 7.6 Sct. 7.7

<F9>
<F11>

Shift +...

1 Auto. Upload

Sct. 7.8

Timer-Selection <F2>

Stepper <F3>
Program <F5>

Spot-Selection <F7>

Corr. Spots <F8>

Timer-Info <F9>

<Shift> +...

The Selection must
be made whenever

Programming is
called up

Spot-Info  <F11>

Change with <F9>
during 1st call

Auto. Upload

New Login <F12>

New  Login <F12>Operation

Sct. 7.4Sct. 7.3

Sct. 9.1 Sct. 11 Sct. 10 Sct. 12

Corr. Programs  <F6>

Sct. 4

Sct. 5 Sct. 6 Sct. 7

System: Password edit
New login <F12>
Save project / Load project
Offline / Online

Language
Help�

�

� � �

�

�

�

�

�...� your path towards your welding program

Timer-Change

Copy

Compare

Spot-Table → WT

Protocol <F8>

Weld current Protocol-Setup

Documentation

Auto data Õ WT

Spot-Table ← WT

Para. value import

Timer name → WT

Services Modify Diagnostics Selection Window

Counter Reset  <F4>
Correction        <F5>

Overview          <F6>

Programming

Quick-progr.

Prg. Correction <F7>

Scaling

I/O�s

Timer

Start Simulation

Timer�Selection <F2>
Spot-Selection <F7>
Timer/Spot Deselection

Timer-Info        <F9>

Spot-Info        <F11>

Active Selection

Services Welding-Parameters Basic-Setup Selection

Schedule

Stepper

Current-Monitoring

Time-Monitoring

Monitor Stepper

Pressure

Pressure-Stepper

Freely programmable Outputs

Safe Delete

Fault-Set-up

I/O Parameters

Thyristor Unit Setup

global Stepper Setup

Stepper-Curves

Tipdress-Curves

Electrode-Setup

Sequence-Setup

Weld Transformer Selection

2
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The BOS-5000 software is used to create the programs for Weld Timers (WT). Commu-
nication between the BOS-5000 and the timer is through the V24 or Feldbus (e.g. PRO-
FIBUS) interfaces.

In the sections below, the following issues will be addressed in order to start programming
with the BOS-5000:

- where the program data is stored.

- why you need a Timer-Reference.

- when to use a Spot-Reference.

- what the menu item Operation is used for.

- which menu items serve for Data Entry.

- how the Status messages are organized.

- where Diagnostics starts.

- how Protocols can be used for quality assurance.

- how to Backup Data.

- how to manage several V24 timers.
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2.2 Where is the program data stored?

Online timer

The program data is always stored in a timer connected via a COM port or the field bus
board.
The timer data can be viewed and changed.

Offline timer

The program data is stored in the programming terminal. The electrical connection of a
timer via V24 or the field bus is not possible.

Writing programs to an offline timer is useful in the familiarization stage or to prepare pro-
gramming in the workshop.

2
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2.3 Why do you need a Timer Reference?

The Timer-Reference serves to give the BOS-5000 operator software an image of the
welding network. The Timer-Reference defines which channel (interface) is used for the
timer and the timer name.

The following channels are available:
- serial port 
- Feldbus ( Profibus-FMS, Interbus-PMS)

For communication via the serial V24 interface, the timer address must always be set to
�1�. Communication via the Feldbus requires that each timer has a unique address.
In a field bus installation, the timer address, e.g. starting with address 4, is useful if several
programming terminals are used.

TimerCOM V24

Feldbus

Timer Timer

No. 4 No. 5

Timer-Reference, channels

PC

No. 1

Timer-Reference, Feldbus

Physical Feldbus address

Logical address (Timer name)

No. 4 No. 5

Feldbus, e.g. Profibus

1R8-AC 1R11-DC

PC

Whenever you work with BOS-5000 you must make a Timer or Spot Selection. The
Selection is based on the Timer and Spot Reference.
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2.4 When should you use a Spot Reference?

From engineering up to production, spot welds are usually referred to by numbers. Each
spot weld is produced by a specific program which holds the welding parameters. The
BOS-5000 user interface enables you to assign a certain program to a spot weld. The
selection of a weld timer and a program becomes easier if only the spot has to be se-
lected.

For Operation/Programming of BOS-5000, a Timer or Spot Selection frequently has to
be made. The Timer Selection is based on the Timer Reference.

Timer

Feldbus

Timer name (Feldbus address 7)

Spot Reference

Spot 40
  Spot 44

Spot Reference

Welding program
no. 1
- Weld time
- %I
 .
 .

Welding hardware

You have made the following assignment:
Spot 40 is welded by program 1 of timer no. 7
Spot 44 is welded by program 1 of timer no. 7

In the example, spots no. 40 and 44 are welded by the same program of a single weld
timer. These spots are referred to as corresponding spots. A change of the welding pa-
rameters will affect all corresponding spots.

2.4.1 Advantages of Spot Reference

In order to change the parameters of a spot within a large welding plant, you do not have
to find out which timer and program produces the spot to be changed. Provided that
Spot-Reference is correct, the PC will process the welding data of the correct program if
you enter the spot name.

2
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2.5 What is the Operation menu item used for?

Once you have defined the Timer-Reference and Spot-Reference, your welding net-
work configuration is complete. The individual welding programs for the weld timers or
spot welds are generated in the Operation menu item by entering the appropriate param-
eters.

This menu item is used to open the Operation window which offers the following functions
(displays and utilities):

- Plant visualization including fault and status messages in the Plant Layout.

- Operation of the weld timer, e.g. Counter Reset

- Parameter change (Programming).

- Protocol generation.

- Diagnostics function.

- Detailed status and fault messages.

- Data backup

Operation

Exit
Upload
Download
Auto Upload

Timer-Change
Documentation
Copy
Compare
Timer name -> WT
Spot-Table -> WT
Spot-Table <- WT
Protocol
Weld current Protocol-Setup
Auto Data -> WT

Counter-Reset
Correction
Prg.-correction
Overview
Programming
Quick-programming

I/O�s
Timer
Start Simulation

Stepper-Status
Fault-Table
Current Status

Operation

Selection

Timer-Selection
Spot-Selection
Timer-/Spot-Deselection
Timer-Info
Spot-Info

Scaling

Active Selection

Window

Auto. Upload

Help

Contents
Index
Help on Help
Info about ...

New Login

Para.values import

File Services Modify Diagnostics Status
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2.6 Which menu items serve for writing programs?

For Programming, at least a Timer Reference must have been made. In order to ensure a
greater operating ease (spot selection feature), a Spot Reference should be additionally
entered.

The Welding parameters can be addressed through

- Timer Selection
- Spot Selection

In Programming, various [Sequence] parameters and settings are adjusted to the re-
quirements of the welding task.

The following menu items are used for programming:

- Programming, which offers the complete range of parameters for data entry in vari-
ous windows and is primarily intended for writing new programs.

- Quick-programming which contains the fundamental sequence parameters in
only a few windows and is primarily intended for changing data of existing pro-
grams and for experienced operators.

Safe Delete
Fault Setup
I/O Parameters
Thyr.-Unit Setup
Weld Transformer Selection
Global Stepper Setup
Stepper-Curves
Tipdress-Curves
Stepper-Parameter
Sequence-Setup

Operation

. . .

Schedule
Stepper

File Services Modify Diagnostics

Programming
Quick-programming

Services Welding-Param-
eters

Basic-Setup HelpSelection

Current-Monit.
Time-Monitoring
Monitor-Stepper
Pressure
Pressure-Stepper

Freely Program-
mable Outputs

2
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2.6.1 Programming

 [2] Data entry

Timer Timer

 [3] Transfer

Programming steps

 [1] Select

[1] Select a timer.
[2] Enter data (Basic-Setup and/or Welding-Parameters).
[3] Transfer data to the timer.

Following Timer Selection, first the standard values are set to the values desired for the
welding task in the Basic-Setup. Then the Welding parameters are input.

2.6.1.1 Basic-Setup

NOTE

Recommendation: You should check all settings in the Basic-Setup and adjust these to
your welding equipment!

- Safe delete
Deletes either the protocol memory and/or the current actual value memories. By
selecting Safe delete, all parameter settings and Sequence parameters are set to
standard values.

- Fault Set-up
The timer messages are assigned a certain response behavior (fault or warning).

- I/O Parameters
Some weld timers offer the possibility of setting a [parity bit] for program selection
(evaluation only with parallel I/Os).
This option serves to define the functions of the <Weld complete contact> (WC).
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- Thyristor-Unit Setup
This option serves to enter characteristic data of your welding transformer and thy-
ristor unit (e.g. system voltage, thyristor type).

- Weld Transformer Selection
The transformer type used is specified when selecting an inverter.

- Global Stepper-Setup
The timer�s response to <maximum tip life> is defined.
The maximum [%I correction] and [pressure correction] is specified for subse-
quent Operation.

- Stepper Curves
By Programming the curve shape you determine the course of Stepping in the
cycles of stepper operation. The Stepper function serves to compensate for elec-
trode wear.

- Tipdress-Curves
By Programming the curve shape you define the initial value of the Stepper func-
tion for a new cycle in stepper mode. The Stepper function serves to compensate
for electrode wear.

- Electrode-Setup
By Programming upper limit values for [%I] and [pressure], you may limit current
regulation (maximum amount of current, or maximum phase angle) and the [force]
at the electrodes depending on the electrical or mechanical design of your welding
equipment and the sensors used..

- Sequence-Setup
In Sequence-Setup (e.g. [start-inhibit] on/off, [weld/no weld], [monitoring] on/off,
[control stopped] on/off, current measurement, etc.) you select the settings of the
welding schedule in:

- all programs

- a selected program

- The sequence modes are set

- single spot

- repeat

- seam

2



Operating structure BOS-5000

2-10 1070 078 217-104 (99.07) GB

2.6.1.2 Welding parameters

On the basis of the Basic-Setup, now the following Welding parameters must be entered:

NOTE

Recommendation: Check all welding parameters and adjust them to your welding task!

- Schedule
The [reference current] values (in kiloamperes or scale units) and the [schedule
times] of a spot weld are programmed. The [regulation mode] is defined.

- Stepper
In order to compensate for electrode wear, the Stepper function is switched on,
and a %I value is defined in percent which will be valid in the beginning of cycles in
stepper mode.

- Current monitoring
For quality assurance, Current monitoring is switched on, and a [tolerance band]
as well as a [reference current] can be programmed.

- Time monitoring
For quality assurance, Time monitoring is switched on, and a [tolerance band] as
well as a [reference time] can be programmed.

- Monitor Stepper
This function provides for a clean separation between current regulation and cur-
rent monitoring by programming individual stepper values as percentages.

- Pressure
If a pressure control valve is used, a [base pressure] value and a [pressure profile]
may be specified.

- Pressure-Stepper
In order to compensate for electrode wear, a Pressure stepper may be activated
and defined by selecting a previously programmed (in the Basic-Setup) Pressure
stepper curve.

- Freely programmable output 
For controlling an additional external device (e.g. additional solenoid valve), three
[off] and/or [on] times are defined for the schedule.
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2.7 How are status messages organized?

In the plant layout, every timer contained in the Timer Reference is represented by a
square symbol. The square timer symbol is subdivided into four fields. Colored displays
quickly indicate the status and fault condition of the timer.

The Status can be viewed separately for:

- the status of the steppers (prewarning, count).

- the active fault messages that have not yet been reset.

- the status of current control (%I prewarning) cf. section 7.6.3

2.7.1 Stepper Status

This function displays the count of the steppers that work with stepper function and the
remaining parts.

Electrodes replaced can be confirmed in this window.

2.7.2 Fault allocation

Events in the weld sequence can be defined as faults or as warnings.

- Faults will stop the timer. This function serves to call up detailed information and to
reset fault messages.

- Warnings are signalled and displayed at the programming terminal.

2.7.3 Current Status

99 Skt 0 Skt

Working point

The %I value is displayed that is currently used by the electrodes which work with the
Stepper function.

The [%I] output is displayed with respect to the [maximum %I]. This allows for con-
clusions on the conditions in the welding circuit.

2
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2.8 Where does Diagnostics start?

The Diagnostics function provides detailed status information on:

- I/O signals

- Current [schedule], steppers, [end of stepper] and [%I], date, time, messages con-
cerning the current schedule.

With the menu item Diagnostics / Start simulation you can run a program without any ex-
ternal action:

- Start simulation:  Program start with Weld / No weld.

- Output of <Weld complete> (WC)

- Fault acknowledgement <Fault reset>

2.9 How are protocols used for quality assurance?

Using the Protocol function you will generate a record of events and measured values of
the welding network.

All events are logged including their date and time and are available for selection:

- Error Protocol

- Weld Fault Protocol

- Data Change Protocol

- Weld Current Protocol
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2.10 How can I back up data?

The welding parameters are initially saved in the timer (exception: PC in offline mode)
only, not in the programming terminal. This is due to the possible connection of the timer
to an open field bus.

PC PC

Timer

Feldbus

Up to three programming terminals can be connected to various field bus systems. The
timer never becomes active by itself. It is always addressed by the programming terminal.
Since the programming terminals may be switched on or off at different times the active
programming terminals access the data in the weld timers.

2.10.1 Upload

This function serves to save all the weld data stored in the timer in a data file on a select-
able storage medium (fixed disk, floppy).

2.10.2 Download

This function serves to download the data previously saved with Upload to the connected
timer.

2



Operating structure BOS-5000

2-14 1070 078 217-104 (99.07) GB

2.11 How can several V24 timers be managed?

The Timer-Reference can only be entered for one V24 timer. However, if more than one
V24 timer is to be served, you may proceed as follows:

Online:

D Switch BOS-5000 into offline mode.

D Enter the Timer Reference and Spot Reference for the weld timers with channel
V24 (once), and the remaining timers with the field bus (e.g. Profibus).

D Select the V24 timer, or change the channel and timer address to V24 for the timer
to be programmed.

D Switch BOS-5000 into online mode.

D Enter the Welding parameters for the timer and transmit them with <Dat.-> WT>.

D Create an Upload file for programming and save it in a specific path (e.g.
C:\PSS5000\RESTBACK\WT1).

Proceed to next timer:

D Switch BOS-5000 into offline mode.

D Change the channel from field bus to V24 for the next timer in Timer Reference.
For the previous timer, you have to change the channel from V24 to field bus.

D Switch BOS-5000 into online mode.

D Enter the Welding parameters for the new timer and transmit them with <Dat.->
WT>.

D Create an Upload file for programming and save it in a specific path (e.g.
C:\PSS5000\RESTBACK\WT2).

For subsequent operation and program modification, the specific timer must always be
switched to the V24 channel in Timer Reference.

Offline:

D Switch BOS-5000 into offline mode.

D Enter the Timer Reference and Spot Reference for the weld timers with channel
V24 (once), and the remaining timers with the field bus (e.g. Profibus).

D Enter the Welding parameters for all timers and transmit them with <Dat.-> WT>.
The parameters are saved in the C:\PS5000\OFL_DATA subdirectory under the
name shown in the file name window in Timer Reference.

In offline mode, all weld timers can be accessed via the Timer selection.
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3 Starting BOS-5000

The  program is started through the BOS-5000 icon (Windows symbol). The Login win-
dow will be displayed.

****  DEMO

The user logs in by entering the user group and password and can now use the functions
assigned to the respective user level.

The various user groups are assigned different privileges for operating BOS-5000.
Example of a subdivision into different user groups:

Level Access type User group password
(secret, of course)

User

4) System administration (WE) Welding 
engineer

SPEC Mr. Superman

3) Copy data (ME) Maintenance
engineer

LIN77
EAGLE

Mr. Miller
Mr. Walker

2) Change data (FM) Foreman TAXI
SUN

Ms. Smith, M.
Mr. Stevens

1) Correct current values 
Acknowledge electrode change

(OP) Operator 4711
OL1
1Z1

Mr. Smith, K.
Mr. Olbert
Mr. Zales

When delivered, four user groups have been defined:

- SYSTEM
Is used by the systems administrator to establish the user privileges. For this pur-
pose, a system disk is required. It provides the highest user privileges.

- EVERYONE
Allows access to all users with the lowermost user privileges. Data can be viewed,
but not changed.

- DEMO
Gives access for first-time use. Welding parameters can be changed.

- Special
Allows any type of access, except password administration.

3
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NOTE

The DEMO user group should be deleted by the systems administrator when the various
user groups have been established.

Changes in the user groups can be made using the system disk.

NOTE

Documentation on system settings in the starting window: No. 1070 078 184
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3.1 Logging into the starting window

After a successful log-in, the Starting window will be displayed.

[1]

[1] The window title bar contains the user group entered during log-in (in this case
DEMO).

Depending on the user group, various functions (menu items, command buttons, in-
puts, ...) may be inhibited. Inhibited functions are displayed in gray letters.

NOTE

Every active program reduces the processing speed of your PC system. Therefore, you
should close (exit) all applications (programs) you do not need at the moment.

The functions of BOS-5000 can be started by activating the respective command button
or from the Mode menu. In the following sections, you will find a description of the con-
tents and functions of these modes.

3
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Your notes:
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4 Starting window

4.1 Mode in the starting window

Starting window

System

Spot-Reference
Operation

Exit

Timer-Reference

Mode Language Help

- Timer-Reference : Administration of weld timers, cf. section 5.

- Spot-Reference : Administration of spots, cf. section 6.

- Operation : Programming and Operation in production, cf. section 7.

- Exit : Quit BOS-5000 (alternatively <ALT> + <F4>)

4
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4.2 System in the starting window

Use the System menu to control important access privileges and system settings. Only
the authorized systems administrator has access to all menu items. 

Starting window

Save project
Load project
Offline
Online

SystemMode Language Help

Control Panel * (Windows Setup *)

Protocol memory Setup *
BOS-5000 Setup *

Password Edit
Access Control *

New  Login <F12>
Read User File *
Read Screenmask File *

* Only with special authorization (systems administrator)
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4.2.1 Password edit

When logged in, any user can change his or her password with this function. Password
entry is invisible. The existing user privileges remain intact. The next time you log in, your
new password will be effective and cannot be read any more not even by the systems
administrator.

4.2.2 New Login

Use this menu item to log in late. This may be necessary, for example, when several users
with different access privileges are working with BOS-5000. 

4.2.3 Save/Load Project

[1]

[2]

[3]

[4]

[2] Saves or loads the Timer and Spot References to/from the target directory [1].

[3] Saves or loads the Upload files to/from the target directory [1].

[4] New target directory selection for [1].

4
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4.2.4 Online/Offline

Online timer

The program data is saved in the weld timers connected via the COM port or the field bus
board. All operating, display and diagnostics functions may be used.
The process visualization in Operation shows the current status by the timer symbol in
the plant layout.

TimerCOM V24

Feldbus

Timer Timer

No. 4 No. 5

ONLINE

No. 1

- Programs can be loaded, changed, compared and tested

- Operator interventions are possible

- Warnings and errors are signaled and can be analyzed

- Protocols are available for display and printing

- Status displays for the electrodes may be displayed
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Offline timer

The program data is saved in the programming terminal. It is not possible to connect a
timer.

Writing programs for an offline timer is suitable for the familiarization stage or for prepara-
tory Programming in the workshop.
A program sequence cannot be started. Operation, display and diagnostics functions are
not available.

NOTE

Timer data modified in offline mode are saved in the selected directory by selecting
<Dat.-> WT>.

4
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4.2.5 Functions requiring special authorization

- Windows Setup

- Access Control

- Read User File

- Read Screenmask File

- Protocol memory Setup

- BOS-5000 Setup

These functions can only be performed by your systems administrator.
For the number of the documentation on system settings in the starting window, refer to
page 3-2. 
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4.3 Language in the starting window

English
NA English
Español

Deutsch

Svenska
Português
.............

Français

Starting window

SystemMode Language Help

The language of the user interface is changed over. Menu items that appear dimmed on
the screen are not available for selection.

NOTE

Only text in the user interface is displayed in the selected language. Text in the operating
system, the user texts and comments are not changed by this selection.

4.4 Help in the starting window

Starting window

SystemMode Language Help

Contents

Index
Help on Help

Info about ...

Help system of BOS-5000. Operation of the help functions corresponds to the Windows
standard. The Help on Help item offers assistance on how to use this function.
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5 Timer-Reference

Timer Reference is used to inform the program about the layout of the welding network. A
correlation is established between the weld timers and the welding plant.

The Reference table is used as a basis for the selection of the timer for Operation/Pro-
gramming.

TimerCOM V24

Feldbus
e.g. Profibus

Timer Timer

No. 4 No. 5

Timer reference, channels

PC

No. 1

5
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Inputs:

[1]

[2]
[3]
[4]

[5]

[6]
[7]
[8]

[9]

[1] Timer name
Unique name of a timer comprising maximally 40 characters. Since only the first 12 char-
acters will be displayed in subsequent representations, the first 12 characters of the vari-
ous timer names must be different. The �|�, <TAB>, and �;� characters are not permitted.

If the Feldbus interface is used, this interface uses the defined timer address internally.
Once Timer-Reference has been made, the user only needs to know the timer name.

NOTE

The Timer-Reference must be unique. Each timer address and/or timer name can only
be used once.

[2] Timer-Type
Selection from list of possible timers, cf. nameplates of timers in use.
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[3] Channel (hardware interface)
Selection of the data interface between the programming terminal and the timer.

- serial V24 data interface V24 (COM)

NOTE

The serial interface settings are entered by the systems administrator.

- Field bus (Profibus-FMS/Interbus-PMS)
When a field bus board is available in the programming terminal and suitable field
bus interfaces have been inserted in the weld timers, a network of weld timers may
be created.
The field bus interface internally uses the specified timer address. Once the Timer
Reference has been entered, the user no longer has to think about this address.
He will only use the timer name.

[4] Timer-Address
Each timer must have a unique address. Depending on the channel, the following inputs
are permitted:
- V24 channel : 1
- Profibus-FMS channel : 2 . . . 47
- Interbus-PMS channel: according to Interbus specifications

[5] Timer-Comment
Each timer can be given a comment with a maximum length of 40 characters. The only
purpose of a comment is to inform  the user. The �|�, <TAB>, and �;� characters are not
permitted. 

[6] Sortkey
The references made in the table are displayed in alphabetic order. The criterion (col-
umn) underlying the sorting sequence may be selected by this input. 

The following columns are available: Timer, Timer-Type, Timer-Address, Channel and
Sorting.

[7] Sorting
Determines the display sequence of the weld timers in the plant layout (ascending
numbers from left to right). In the case of identical values, the order will depend on the
timer name.

[8] File name
The first eight characters (DOS delimiter) of the timer name are memorized as timer
name (e.g. for Upload files) which may be changed by the user.

5
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[9] Command buttons:

- < >

Scrolling in the reference table:
First line, page up, one line up,
one line down, page down, last line.
Whenever the cursor has been moved within the Timer Reference table, the file of
the currently highlighted timer will be fully displayed in the input range.

- <Insert>
Insert a new timer from the input range into the table.
The data from the input range will be accepted to the reference table as a new
entry. The new timer name and/or the new timer address must not be previously
contained in the table for reasons of uniqueness (error message).

- <Change>
The data from the input range are transferred to the line marked in the table. All
existing data will be replaced.

- <Delete>
In order to delete one or several timer references from the table, these must be
marked in the Clear column.
Deletion must be confirmed.

NOTE

All spots linked to a deleted timer will also be deleted, cf. section 6.

- <Clr. All>
Deletes all timer references (and thus all spot references) from the reference table,
cf. <Delete>.
Deletion must be confirmed.

- <Import>
Reads a reference table from an ASCII file (previously generated with Export). Any
drive, directory, and file name may be specified. 

NOTE

Importing a reference table will delete the currently displayed reference table.
If you want to retain the existing timer references, you first have to export them.

- <Export>
Saves the reference table as an ASCII file. Any drive, directory, and file name may
be selected or entered. 
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Column configurator

The �Change column width of the reference table� function is integrated in the header bar
of the reference table.

For every column, the column width can be changed by entering the number of char-
acters in the Size input box. Entering zero will cause the column to disappear.

Operation with the mouse

D Clicking with the left mouse button in the header bar of the reference table will dis-
play the Column configurator window.

Operation without a mouse

D <TAB> selects the column.

D <Enter> opens the Column configurator window.

5
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6 Spot-Reference

Spot welds in manufacturing are usually designated by numbers. Each spot weld is pro-
duced by a concrete program. Using Spot-Reference, you can allocate spot names, pro-
grams, timer names and comments.

Timer

FeldbusPC

Timer name (Field bus address 7)

Spot-Reference

Spot 40
  Spot 44

Welding hardware

You have made the following assignments:
Spot 40 is welded with program 1 of timer no. 7
Spot 44 is welded with program 1 of timer no. 7

Welding program
no. 1
- weld time
- %I
 .
 .

In the example shown, spot welds No. 40 and 44 will be welded by the same program of
the timer. These are referred to as corresponding spots. If the welding parameters are
changed, this change will affect all corresponding spots.

6
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Timer

FeldbusPC

Timer name (Field bus address 7)

Spot-Reference

Welding hardware

You have made the following assignments:
Spot 40 is welded with program 1 of timer no. 7
Spot 44 is welded with program 1 of timer no. 7
Spot 48 is welded with program 1 of timer no. 7
Spot 49 is welded with program 1 of timer no. 7

Change of corresponding spot 48:
Spot 48 shall be welded with program 11 of timer no. 7

Spot 40

Spot 44

Spot 48 Spot 49

Welding program
no. 1
- Weld time
- %I

Welding program
no. 11
- weld time
- %I

The welding parameters of a single corresponding spot can not be changed. A new pro-
gram for this spot has to be created first, in order to change the welding parameters for
this corresponding spot.

Required changes:

- The robot must select the new weld program number with program start (Example:
Program 11 must now be selected in place of program 1 for spot 48).

- The welding parameters must be set up for the new program (Example: the param-
eters for the additional program 11 must be programmed).

- The Spot-Reference must be changed accordingly (Example: Spot 48 will now be
welded by program 11 instead of program 1).
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Inputs:

NOTE

A functioning Spot-Reference presupposes a Timer-Reference. If a Timer in the Refer-
ence is deleted, then the related spots are deleted as well.

[1]
[2]

[3]
[4]

[5]

[6]

[1] Spot name
Unique name of a spot weld comprising maximally 40 characters. All spot names within
Spot-Reference must be different. The �|�, <TAB>, and �;� characters are not permitted.

[2] Timer name
Selection of a timer from the range of available timers (cf. Timer-Reference section)
which contains the program for the spot.

[3] Program-No.
Number of the welding program (0 to 255, depending on timer type) to be used for welding
this spot.

[4] 1., 2., 3. comment
Every spot weld can be additionally described by up to three comments (max. 40 charac-
ters each). Comments may give detailed information to the user. The �|� character is not
permitted. 
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[5] Sortkey
The Spot-References in the table are displayed in alphabetical order. The sorting se-
quence refers to the active column name.

[6] Command buttons:

- < >

Scrolling in the reference table:
First line, page up, one line up,
one line down, page down, last line.
Whenever the cursor has been moved within the reference table, the data of the
currently highlighted spot will be fully displayed in the input range.

- <Insert>
Insert a new spot from the input range into the table.
The data from the input range will be accepted to the reference table as a new
entry. The new spot name must not be previously contained in the reference table
for reasons of uniqueness (error message).

- <Change>
The data from the input range are transferred to the spot marked in the table. All
existing data will be replaced.

- <Corr.Spots>
Displays the list of corresponding spots (same program no. and same timer name)
of the spot marked in the reference table.

- <Delete>
In order to delete one or several spot references from the table, these must be
marked in the Clear column.
Deletion must be confirmed.

- <Clr. All>
Deletes all spot references from the reference table.
Deletion must be confirmed.

- <Import>
Reads a reference table from an ASCII file (previously generated with Export). Any
drive, directory, and file name may be specified. When this command button has
been activated, the standard Windows dialog for opening a file will be displayed.

NOTE

Importing a reference table will delete the currently displayed reference table.
If you want to retain the existing spot references, you first have to export them.
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NOTE

The import function will not be executed unless all spot data is compatible with the stored
Timer−Reference.

- <Export>
Saves the reference table as an ASCII file. Any drive, directory, and file name may
be selected or entered. 

Column configurator

The �Change column width of the reference table� function is integrated in the header bar
of the reference table.

For every column, the column width can be changed by entering the number of char-
acters in the Size input box. Entering zero will cause the column to disappear.

Operation with the mouse

D Clicking with the left mouse button in the header bar of the reference table will dis-
play the Column configurator window.

Operation without a mouse

D <TAB> selects the column.

D <Enter> opens the Column configurator window.
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Your notes:



OperationBOS-5000

7-11070 078 217-104 (99.07) GB

7 Operation

- Plant visualization with status messages and Diagnostics

- Change Welding parameters and transmit them to the timer

- Save, compare and log welding programs

- Perform operator interventions

- Fault analysis

Operation

Exit
Upload
Download
Auto Upload

Timer-Change
Documentation
Copy
Compare
Timer name -> WT
Spot-Table -> WT
Spot-Table <- WT
Protocol
Weld current Protocol-Setup
Auto Data -> WT

Operation

Selection

Timer-Selection
Spot-Selection
Timer-/Spot-Deselection
Timer-Info
Spot-Info
Offline-Path-Selection
Active Selection

Window

Auto. Upload

Help

Contents
Index
Help on Help
Info about ...

New Login

Para.values import

File Services

Counter-Reset
Correction
Prg.-correction
Overview
Programming
Quick-programming

I/O�s
Timer
Start Simulation

Stepper-Status
Fault-Table
Current Status

Modify Diagnostics Status

Scaling

7
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7.1 Plant layout

The plant layout shows all weld timers contained in the Timer Reference.

A square symbol is used for process visualization which indicates the current status of the
individual timer by means of color changes.
Every timer symbol is subdivided into four fields.

Timer symbol

Gray : Timer not available
Green : No message or warning present
Turquoise : Offline timer

Green : Timer without message
Yellow : Timer with warning

Green : Timer without message
Red : Timer signals general fault
Orange : Timer signals welding fault

Green : Stepper/s without message
Yellow : Stepper/s with warning
Orange : Stepper/s signal/s tipdress request

Green : Stepper/s without message
Red : Stepper/s reached max. tip life
Orange : Stepper/s signal/s tipdress 

  required

Warning or heat
warning

Fault or max. tip life

Timer name

[1]

[1] Red border: Monitoring stopped or Control stopped is active (not displayed with all timer
types)

Ti
m

er
S

te
pp

er

2

NOTE

If the color in the upper part of the timer symbol changes:
<F2> Information on timer, e.g. fault table.
If the color in the lower half of the timer symbol changes:
<F3> Information on stepper, e.g. warning table
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[1]

[2]
[3]

[5]

[4]

[1] Timer symbol
[2] Timer name
[3] Feldbus address
[4] Timer marked and preselected by clicking once with the mouse
[5] Command buttons

You may mark a timer in the plant layout by clicking once with the left mouse button on the
respective symbol. A border appears around the timer which is now active if command
buttons for timer-related activities are selected.

By clicking once with the right mouse button, the context menu for a timer may be called
up.

A double-click with the left mouse key marks a timer in the plant layout and opens the
Diagnostics window for this timer, cf. section 7.5.

Command buttons:

- <F2 Prew.-Step>: The Prewarning Stepper function indicates the wear (counts)
of the steppers in a table with the option to intervene directly, e.g. Electrodes have
been replaced, cf. section 7.6.1.

- <F3 Error Table>: The error table contains the current error messages of the weld
timers with the option to intervene directly, e.g. Reset faults, cf. section 7.6.2.

- <F5 Correction>: The %I correction provides for %I adjustment of a certain elec-
trode by the operator within predetermined limits, cf. section 7.4.2.

- <F6 Overview>: Selection and display of parameters of one timer, cf. section
7.4.4.

7
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- <F11 Quick-Prog.>: Using the quick-programming function, the fundamental
welding parameters are displayed in a summary format where they can be
changed and transferred to the timer. The actual %I and time values are displayed,
cf. section 7.4.6.

- <Diagnostics>: The Diagnostics function offers detailed information concerning
the timer status, the schedule and the steppers. The status messages are a helpful
tool for troubleshooting. The last or current schedule is displayed including its sta-
tus. The stepper parameters are displayed or mapped in an individual prewarning
table. Interventions, such as Control Reset, are possible, cf. section 7.5.

- <Timer-Change>: A timer change is supported by the Timer-Change function.
The data of the timer to be replaced are transmitted to the programming terminal
and downloaded to the new timer after the change, cf. section 7.3.5.

- <F7 Prg.-corr.> The Program correction function provides for %I adjustment by
the operator within predefined limits, cf. section 7.4.3.

- <Scaling>: The Scaling function adjusts the conversion factors for current/%I
and force/voltage to the actual situation, cf. sections 10.11 and 10.12.

7.1.1 Other function keys in the plant layout

- <F1> Help function.

- <F8> Protocol, cf. section 7.3.11.

- <F9> Programming, cf. section 8, volume 2.

- <F12> New Login, cf. section 7.2.1.

- <Shift> + <F2> Timer Selection, cf. section 7.7.1.

- <Shift> + <F7> Spot Selection, cf. section 7.7.2.
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7.2 File in Operation

7.2.1 New Login

cf. section 4.2.2

7.2.2 Exit

Close the Operation program section.

7
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Your notes:
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7.3 Services in Operation

Functions for commissioning, operation during production, data backup and documenta-
tion:

- Upload and save the programmed files of a timer to the programming terminal and
vice versa.

- Upload and download parameter data as ASCII files.

- Transfer all data to the programming terminal and back transfer to the timer to sup-
port a timer change.

- Create a documentation.

- Copy welding programs within one timer or from one timer to another for quick pro-
gram creation.

- Compare welding programs, e.g. in order to recognize changes.

- Transfer of the Timer name to the timer.

- Transfer the Spot-Reference to the timer and from the timer.

- Protocol of all messages generated by a timer.

- Activate Weld current protocol on the programming terminal.

- Download Auto.Data from the programming terminal to the timer.

Operation

Upload
Download
Auto Upload

Timer-Change
Documentation
Copy
Compare
Timer name -> WT
Spot-Table -> WT
Spot-Table <- WT
Protocol
Weld current Protocol-Setup
Auto Data -> WT

Para.values import

File Services Modify Diagnostics Status

NOTE

Some functions are not available for offline weld timers.
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7.3.1 Upload

Saves the programmed data from a timer to the programming terminal.

NOTE

Upload files created with previous BOS-5000 releases (up to release 2.69) can no longer
be used with BOS-5000 release 2.70 or higher.

RESTBACK

Timer

Link via V24 / field bus

Upload

Download

C: \ PS5000

OFL_DATA

Saving the program files and command values:

Online timer -> RESTBACK directory

Upload

No Upload

No Upload

RESTBACK

C: \ PS5000

OFL_DATA
Data in timer

Program and command value memory

Protocol memory

Actual value memory

NOTE

The Upload function is only available for online timers.
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Performing the Upload

D Select Operation - Services - Upload.

D Upload for one timer: Select timer (pink-colored border), if no timer is selected, the
Upload will be performed for all weld timers.

D The default target directory for saving the Upload file is RESTBACK, if necessary,
enter a different <Path select>.

D The default file name displayed in the file name window is the name allocated in
Timer Reference. If necessary (existing Upload file should not be replaced), the
name can be changed by selecting <File-Reference> (only possible if one timer
has been selected at maximum).

D Start Upload with <Read file from control>.

NOTE

BOS-5000 default names are used for the upload files. Default values are also available
for the target directory and drive, however, these may be changed in a dialog.
Recommendation: Use the default values in order to maintain a clear overview at any
time. 
Attention: Existing files in the selected directory will be replaced!

NOTE

Comments from the Upload function will be saved in the Upload file and can be viewed
with the Download - File info function.

7
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7.3.2 Download

The uploaded data will be downloaded from the programming terminal to the timer.

NOTE

Upload files created with previous BOS-5000 releases (up to release 2.69) can no longer
be used with BOS-5000 release 2.70 or higher.

RESTBACK

Timer

Link via V24 / field bus
C: \ PS5000

OFL_DATA

Downloading the previously uploaded program
files and command values:

Online timer  -> RESTBACK directory

Upload

Download

Download

No Download

No Download

RESTBACK

C: \ PS5000

OFL_DATA
Data in timer

Program and command value memory

Protocol memory

Actual value memory

NOTE

The Download function is only available for online timers. During the download, the timer
is not ready for operation. Program start is not possible.
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Performing the Download

NOTE

Download can only be used to transmit files which have previously been saved with
Upload.
The timer type and timer address should be identical, otherwise a message is output. If
the data is downloaded in spite of the message, incorrect data have to be expected, e.g.
weld times in cycles or milliseconds.

D Select Operation - Services - Download.

D Download for one timer: Select timer (pink-colored border), if no timer is selected,
the Download will be performed for all weld timers.

D The default source directory for the Download file is RESTBACK, if necessary,
enter a different <Path select>.

D The default file name displayed in the file name window is the file name (name of
Upload file) allocated in Timer Reference. If necessary, select another file name
with <File-Reference> (only possible if one timer has been selected at maximum).

NOTE

BOS-5000 default names are used for the Download file, the source directory and the
drive, however, they can be changed in a dialog.
Recommendation: Use the default values in order to maintain a clear overview at any
time.
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Your notes:
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7.3.3 Auto. Upload

The program files of selected timers can be automatically saved. This automatism can
only be activated, changed, and cancelled by the systems administrator.

Settings:

- Daily at a certain time of the day

- Weekly on a certain day of the week and at a certain time of the day

- Monthly on a certain day and at a certain time of the day

NOTE

Auto. Upload files created with previous BOS-5000 releases (up to release 2.69) can no
longer be downloaded with BOS-5000 release 2.70 or higher.

Auto. Upload
RESTBACK

C: \ PS5000

OFL_DATA

No Upload

No Upload

Data in timer

Program and command value memory

Protocol memory

Actual value memory

NOTE

The Auto. Upload function can only be used together with online timers.
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Activating Auto. Upload

D Select Operation - Services - Auto. Upload.

D Select timer for Auto. Upload.

D The default target directory for saving the Upload file is AUTOBACK, if necessary,
enter a different <Path select>.

D The default file name displayed in the file name window is the name allocated in
Timer Reference.

D Enter Auto. Upload and switch into background with <Minimize>.

NOTE

BOS-5000 default names are used for the target directory and the drive, however, they
can be changed in a dialog.
Recommendation: Use the default values in order to maintain a clear overview at any
time.

NOTE

The �normal� user can view this window without the privilege to make changes.
The Auto. Upload window (if activated) is shown as a symbol in the Operation window.
The menu item �Window, Auto. Upload� may also be used to visualize the activated win-
dow.
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7.3.4 Parameter values import/export

Welding or sequence parameters of one or all programs of a timer will be exported from
the timer to a parameter file (ASCII file) and saved in the RESTBACK directory (default
setting). From this directory, they can be uploaded to the timer.

Structure of a parameter file

Using a text editor (ASCII editor), you can create, modify or view the parameter data.
Another possible use of this function is to accept the parameter data from a data base.

The parameter data display comprises at least two lines:

1st line   ROBOT1   |00|22|33

2nd + subsequent line/s    ROBOT1   |02|05|01

2nd parameter no.
1st parameter no.
Parameter group
Timer name

2nd parameter value
1st parameter value
Program or electrode (stepper) no.
Timer name

7
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Parameter values import/export

D Select Operation - Services - Para. values import/export.

D Select timer for Para. values import/export.

D The default source or target directory for the Para. values import/export function is
RESTBACK, if necessary, select a different drive and directory.

D Enter the name of the Parameter file (default filename extension .TXT).

D Start Para. values import/export by clicking on <Start>.

NOTE

BOS-5000 default names are used for the source and target directory and the drive, ho-
wever, they can be changed in a dialog.
Recommendation: Use the default values in order to maintain a clear overview at any
time.
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7.3.5 Timer change

This menu item supports the replacement of weld timers. The programmed data, counts,
and actual values are read from the timer to be replaced and then transmitted to the new
timer.

NOTE

In contrast to the Upload and Download functions, the current counts and actual values
are included in the export and import.
The current counts of the steppers are accounted for if %I stepping and/or the tip dressing
function is active.
Therefore, you can always continue working immediately after having replaced a timer.

Old New

Program data, counts,
actual values

Program data, counts,
actual values

(1)

(2)

NOTE

Unlike the Upload, the timer data is not saved.
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Performing a Timer change

D Select Operation - Services - Timer change.

D Select timer for Timer change.

D Start Timer change with <Read file from control>.

D Replace timer.

D Continue Timer change with <Download file to control>.
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7.3.6 Documentation

The program and stepper parameters of all programs whose weld schedule has not been
stopped, will be combined in two readable files.

- Text file (file extension = .TXT) for further processing with Excel or similar software.

- Printer document (file extension = .PRN) to be output on a printer. 

PC

Timer

Printer

C:\
Docu 7
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Creating a documentation

D Select Operation - Services - Documentation.

D Select timer for Documentation.

D The default target directory for saving the Documentation files is DOCU, if necess-
ary, select or create a different drive and directory with <Create Path>.

D The default file name displayed in the file name window is the name allocated in
Timer Reference.
- Print Documentation immediately:

Function is active: the Documentation will be created as a printer document
and printed.
Function not active: The Documentation files will be created in the target di-
rectory.

- Print all parameters: contains all timer data (e.g. program and stepper para-
meters)

- Print only program parameters: only contains program parameters.

D Start Documentation by clicking on <Start>.

NOTE

BOS-5000 default names are used for the target directory and the drive, however, they
can be changed in a dialog.
Recommendation: Use the default values in order to maintain a clear overview at any
time.
Attention: Any existing files in the selected directory will be replaced!
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7.3.7 Copy

Similar welding programs can be created quickly at low effort by simply copying and
changing programs.

C: \ PS5000

OFL_DATA

RESTBACK

Copy Upload file / programs

Copy timer data/programs
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Copying

D Select Operation, Services, Copy.

D Use <File -> Timer> to copy all or individual programs of an Upload file to a timer.

D Use <Timer -> Timer> to copy all or individual programs from one timer to
another.

All files from an Upload file

D Select the drive and directory of the Upload file to be copied.

D Select the timer data.
- Timer files (data)
- Program data
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D Select the target timer.

D Start copying by clicking on <Start>.

NOTE

Canceling the copying process will destroy the copied data in the target timer.
Data existing in the target will be replaced.

Program contained in an Upload file

D Select File -> Timer.

D Select the source drive, directory and Upload file for copying.

D Select the program data and the program to be copied.

D Select the target timer.

D Select the target program number/s (e.g.: 1,2-6,18).

D Start copying by clicking on <Start>.

Please note the instructions given in section �All files from an Upload file�.

7
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All data of a timer

D Select Timer -> Timer.

D Select the source timer for copying.

D Select the timer data

D Select the target timer for copying.

D Start copying by clicking on <Start>.

Please note the instructions given in section �All files from an Upload file�.

Program data of a timer

D Select Timer -> Timer.

D Select the source timer for copying.

D Select the program data and the program to be copied.

D Select the target timer.

D Select the target program number/s (e.g.: 1,2-6,18).

D Start copying by clicking on <Start>.

Please note the instructions given in section �All files from an Upload file�.



OperationBOS-5000

7-251070 078 217-104 (99.07) GB

7.3.8 Compare

- Timer data with an Upload file

- Timer data of two different weld timers

- Timer data contained in two different Upload files

C: \ PS5000

OFL_DATA

RESTBACK

Compare Upload file / timer
data

Compare timer data / 
timer data

7
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Perform comparison

D Select Operation, Services, Compare

D <Timer -> File> compares all program data of a timer with an Upload file (avail-
able for individual new timers)

D <Timer -> Timer> compares all program data of a timer with another timer.

D <File -> File> compares all data of an Upload file with that of another Upload file
(available for individual new timers).

NOTE

The <Timer -> File> and <File -> File> functions are available for a few timer types only.

Result of comparison

After the comparison, the message All datas are identical will be displayed if no discrep-
ancy was found.

In the case of differences, an �X� will be shown below the parameter name.

In order to obtain detailed information concerning this difference, move the cursor to the
desired line and select <Detail-Info>.

The data differences between the source and the target will be displayed.
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All timer data with Upload file 

D Select Timer -> File.

D Select the timer.

D Use <Path-select> to select the directory containing the Upload file for the com-
parison (the RESTBACK directory is the default).

D Select the Upload file to be compared with <File-Reference>.

D Start the comparison by clicking on <Start>.

NOTE

BOS-5000 default names are used for the Upload file, the source directory and the drive,
however, they can be changed in a dialog.
Recommendation: Use the default values in order to maintain a clear overview at any
time.

7
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NOTE

Some of the Compare functions are not supported by all weld timers.

Compare timer data with timer data

The system compares all timer data (program data without actual values, without
counters) of two timers.

D Select Timer -> Timer.

D Select the first timer.

D Select the timer data.

D Select the second timer.

D Start the comparison by clicking on <Start>.

Compare timer program with timer program/s

The system compares a source program with one or several program/s of the same or
another timer.

D Select Timer -> Timer.

D Select the first timer.

D Select the program data.

D Enter the program number to be compared (source).

D Select the second timer.

D Enter the program number/s (target) for the comparison (e.g.: 1,3-8,23).

D Start the comparison by clicking on <Start>.

Compare Upload file with Upload file

The system compares one Upload file with another Upload file.

D Select File -> File.

D Select the first Upload file.

D Select the timer data.

D Select the second Upload file.

D Start the comparison by clicking on <Start>.
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Compare one program of an Upload file with one or several program/s of an
Upload file

The system compares one program of an Upload file with one or several program/s of an
Upload file.

D Select File -> File.

D Select the first Upload file.

D Select the program data

D Enter the program number/s of the first Upload file to be compared.

D Select the second Upload file.

D Enter the program number/s of the second Upload file to be compared
(e.g.: 1,3-8,23).

D Start the comparison by clicking on <Start>.
7
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7.3.9 Timer name -> WT

The timer names are initially stored in the Timer Reference in the programming terminal
only.
This function copies one or all timer names from the Timer Reference to one weld timer or
all weld timers.

This feature provides for �software-labelling� of the timers.

Transmitting timer name to timer

D Select Operation, Services, Timer name -> WT.

D Select timer for transmission.

D <Timer name -> WT> to one timer.

D <Timer name -> All WT> to all timers (only useful for networked systems).
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7.3.10 Spot-Table -> WT, Spot-Table <- WT

The spot table is initially stored in the Spot Reference in the programming terminal only.
The spot table from Spot Reference is copied to a timer, or a previously transmitted spot
table is restored to the programming terminal.

Transmitting the spot table to the timer is required whenever the serial spot addressing
function via a V24 I/O interface of the timer is to be used (type-specific timer function).

NOTE

Serial spot addressing is reserved to timers with a serial V24 interface. Weld timers with
24 VDC I/O�s, Profibus-DP or Interbus-S interfaces do not provide this feature.

Performing Spot-Table -> WT, Spot-Table <- WT

D Select Operation, Services, Spot-Table -> WT/Spot-Table <- WT.

D Select a timer as source/target for the transmission.

D <Download file to control>: from programming terminal to timer.

D <Read file from control>: from a timer to the programming terminal.

NOTE

The timer only saves the spot name including the relevant program number. Comments
are not saved in the timer and get lost during transmission to the programming terminal. 
The <Read file from control> function will replace the spot table available in Spot Refer-
ence on the programming terminal. In order to prevent this, the spot table must previously
be exported to a file, cf. page 6-5.
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7.3.11 Protocol

Events and measured values in the welding network (or a timer) will be logged in the fol-
lowing protocols including their date and time of occurrence:

- Error Protocol
Logging of errors in the Ready state of the welding equipment.

- Weld Fault Protocol
The events detected by weld current monitoring are logged, e.g. values above or
below the tolerance band or an open measuring loop.

- Data Change Protocol
Changes in welding parameters are logged including their comment. The old value
and the new value of the parameter are entered in the protocol.

- Weld Current Protocol (must be activated with the Weld current protocol-Setup,
cf. section 7.3.12.
For a selected timer, the following data is logged for every completed program:
- Stepper counts
- Monitoring and regulation modes
- Command and actual current values of the weld times in kA
- Phase value of the weld times in %I
- Actual and command time values of the weld times

All protocols can be printed or saved in a dBase file according to choice.
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Example of a protocol

D Select Operation, Services, Protocol.

D Select the desired protocol in the File window.

Selection fields:
- File: Selection of the type of protocol.

- Error Protocol
- Weld Fault Protocol
- Data Change Protocol
- Weld Current Protocol, cf. section 7.3.12       

- Sortkey: The records of a protocol are displayed in the sorting sequence selected
in this box.
- No.
- Date/Time
- Timer

Command buttons:

- < >

Scrolling through the table on the screen:
First line, page up, one line up,
one line down, page down, last line.

7
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- <Update>
Updates the table contents.

- <Print>
Prints selected lines of the displayed protocol. For printing, you must mark the be-
ginning and end of the printing area in the Index column.The lines marked for print-
ing will be displayed as from:/until:. If no selection is made, the current page will be
printed.

Column configurator

The �Change column width of the protocols� function is integrated in the header bar of the
protocols.

For every column, the column width can be changed by entering the number of char-
acters in the Size input box. Entering zero will cause the column to disappear.

Operation with the mouse

D Clicking with the left mouse button in the header bar of the protocol will display the
Column configurator window.

Operation without a mouse

D <TAB> selects the column.

D <Enter> opens the Column configurator window.
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7.3.12 Weld Current Protocol Setup

D Select Operation, Services, Weld current Protocol-Setup

- inactive: deactivates weld current logging.

- active: activates weld current logging.

D Select the timer and close the Operation window

NOTE

To activate the changes made to the Weld Current Protocol (inactive -> active and vice
versa), Operation must be finished and called up again.
By calling up Operation again, the connected timer will be re-initialized and transmit the
stored current values to the programming terminal.

Example of a weld current protocol

7
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NOTE

An active weld current protocol puts additional strain on the interfaces or the Veldts.
Recommendation: Limit the protocol to critical times.
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7.3.13 Auto. Data -> WT

This menu item serves to turn automatic transmission of modified data to the timer on and
off.

- On : check mark in the Auto. Data -> WT line

-  Off : no check mark in the Auto. Data -> WT line

Auto. Data -> WT = off:
Changes to the weld data must be transmitted to the timer in order to become active.
Transmission is performed via the <Dat.->WT> command button or with <OK>. All data
modified in the respective window will be transmitted.

Auto. Data -> WT = on:
When a modified input field is exited, the window for data transmission to the timer is auto-
matically displayed.

Recommendation:

Set �Off� during commissioning in order to change several values in a window.

If data is changed sporadically after a while (for example during production run), set �On�
to activate data transmission immediately when the input field is exited.

7
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Your notes:
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7.4 Modify

Supports the Operation of the welding system during production by offering the following
functions:

- Reset counters in the timer (e.g. after an electrode change)

- Correction of [%I] and [pressure] for one or all programs of a timer for compensat-
ing temporary variations of [%I].

- Program correction of [%I] and [pressure] for one program for compensating tem-
porary variations of [%I]

- Status display of sequence parameters in an Overview

- Programming and display of all parameters of a timer.

- Concise display of the fundamental program parameters in Quick-Programming.

- %I and pressure Scaling in order to adjust the internal characteristics to the actual
conditions

NOTE

Individual functions can be protected against inadvertent changes by users from a differ-
ent user level, cf. section 3.

Operation

File Services Modify Diagnostics Status

Counter-Reset
Correction
Prg.-correction
Overview
Programming
Quick-programming
Scaling

NOTE

Some functions are not available for offline timers.
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7.4.1 Counter-Reset

The counters for the wear, the dressings, and the spots are incremented with every spot
weld depending on the values programmed in the Stepper function. When an electrode
has been replaced, the counters have to be reset.
For commissioning, or in the event of a fault, it may be necessary to reset the counters
manually.

NOTE

Counters can be set to desired values in:
- Actual value, cf. section 7.4.7
- Prewarning-Table / Detail-Info, cf. section 7.6.1

Resetting counters by means of input signals

The input signals designated �Program no.� have to different meanings:

- When the binary code (program no.) is applied and Start becomes active, the se-
lected program is executed.

- When the binary code (now: stepper no.) is applied:
- and the <Tip dressed> signal becomes active, the electrode counters will

be affected (in this case: reset counts and increment dressing counter).
- and the <Electrode replaced (A2)> signal becomes active, the counts and

dressings will be set to 0.

Program selection

Start

+

Program schedule

Tip dressed

+

- Counts     Õ reset

- Dressings Õ +1

Electrode replaced (A2)

+

- Counts  Õ 0

- Dressings Õ 0

= = =

  Program selection/Stepper no.

Special case: By selecting program 0, the counters of all electrodes (0 to n, n = number of
electrodes of the timer type) will be affected.
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Performing a Counter-Reset

D Select Operation - Modify - Counter-Reset.

Inputs and selection:

- All Steppers:
Reset the counters of all electrodes (0 to 31)

- Steppers:
Reset the counter of the specified electrode no.

- Programs:
Reset the counters of the electrodes assigned to the specified programs.

- Stepper no. or Program no.:
Values can be input in this field only if Steppers or Programs has been selected,
respectively. Use this field to enter the number of the desired stepper or the desired
program. Several steppers or programs can be input in the format �2-4,9� (= reset
for nos. 2, 3, 4, and 9).

NOTE

Every welding program uses only one electrode. Several welding programs can use the
same electrode.

Examples Progr. No.

Electr. No.

1  2  3  4

1
or

1  2   3  4

1       2
or

  1   2   3   4
     
1   2   3   4

To effect the allocation: program <-> electrode, use the menu item Sequence Setup in
the Basic-Setup menu.
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7.4.2 Correction

A Correction-setting in percent for the parameters [%I ] and [pressure] is offered for an
electrode, a program, or all programs. 
Using this Correction, pressure changes or temporary, process-related %I changes can
be implemented rapidly without changing programming as such, cf. section 7.4.3.

NOTE

The Correction option offers more correction features than the Program-Correction func-
tion.
By entering different user privileges for different user levels, a distinction can be made
between these two operations.

The correction settings act in addition to the basic values [Schedule] and [Pressure]. Two
settings are possible:

- One Stepper

NOTE

One stepper may have been assigned to several programs.

- Single program, identical to section 7.4.3
- All programs

Example:

Pro-
gram

Base
% I

Step-
per

Corr. (E) Corr. (P) % I Current
[kA]

1 9 kA 1 +2 % +1 % +2 % + 1 % = +3 % 9.27 kA

2 10 kA 0 % +2 % + 0 % = +2 % 10.2 kA

3 12 kA -2 % +2 % - 2 % = ±0 % 12.0 kA

4 10 kA +2 % +2 % + 2 % = +4 % 10.4 kA

NOTE

The Correction function internally adjusts the reference current to be monitored, cf. sec-
tion 11.3.
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Performing a Correction-Setting

D Select Operation - Modify - Correction.

[1]

[2]

[3]

[4]

[5]
[6]

[7]

Command buttons:

- <Dat. ->WT>: Transmits the data to the timer or cancels the transmission. A com-
ment may be optionally input which is entered in the Data Change Protocol.

- <Prg.-Selection>: Select another program. If the Correction-Setting of the
previously edited program has been changed, the data will be transmitted to the
timer before the Program-Selection window is displayed.

Inputs and selection:

[1] %I: Slide control for setting the correction value in percent for [%I] for the selected
electrode (E).

[2] Pressure: Slide control for setting the correction value in percent for [pressure] for
the selected electrode (E).

[3] %I: Slide control for setting the correction value in % for [%I] for the selected pro-
gram (P).

[4] Pressure: Slide control for setting the correction value in percent for [pressure] for
the selected program (P).

[5] All Programs: Program-specific correction (P) for all programs, electrode-spe-
cific correction (E) only for those programs which work with the displayed elec-
trode.

[6] Program: Correction is valid for the program specified in the Prog.-No. field.

[7] Prog.-No.: Enter the program number/s (e.g. 10, 15-20, 27)
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NOTE

The upper and lower limits of the Correction-Setting for [%I] and [pressure] are specified
in Programming - Basic-Setup - Global Stepper-Setup. (Recommendation: Assign
higher user level to this function).

The slide controls can be shifted to the right and left with the mouse or the cursor keys.
The respective value is displayed in the window.
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Your notes:
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7.4.3 Program-Correction

A correction in percent for the parameters [%I ] and [pressure] is offered for a program.
Using this correction, pressure changes or temporary, process-related %I changes can
be implemented rapidly without changing programming as such (identical with %I-Corr.
(P), Press.-Corr. (P), cf. section 7.4.2).

NOTE

The Program-Correction function enables you to make limited program corrections
compared to the Correction function.
By assigning different user privileges and user levels, a distinction can be made between
the two operations.

The correction settings act in addition to the basic values (Schedule and Pressure) on a
single program that uses this electrode, cf. section 7.4.2.

NOTE

The Correction function internally adjusts the reference current to be monitored, cf. sec-
tion 11.3.
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Performing a Program-Correction

D Select Operation - Modify - Program-Correction.

[2]

[1]

NOTE

Operation of the Program-Correction depends on the selected timer type.

The correction value for the electrode (all programs using this electrode) is displayed in
the Program-Correction window, but cannot be changed here. Changes can be made in
the Correction-Setting window, cf. section 7.4.2.

NOTE

The %I correction value [P] in figure 3.27 is identical to the value in window 3.10, right-
hand side.

Command buttons:

- <Dat. ->WT>: Transmits the data to the timer or cancels the transmission. A com-
ment may be optionally input which is entered in the Data Change Protocol.

- <Prg.-Selection>: Select another program. If the Correction-Setting of the
previously edited program has been changed, the data will be transmitted to the
timer before the Program-Selection window is displayed.

Settings:
[1] %I Corr. (P):

Slide control for setting the correction value in percent for [%I].

[2] Pressure Corr (P): 
Slide control for setting the correction value in percent for [pressure].
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NOTE

The upper and lower limits of the correction of [%I] and [pressure] are specified in Pro-
gramming - Basic-Setup - Global Stepper-Setup.  (Recommendation: Assign higher
user level to this function).

The slide controls can be shifted to the right and left with the mouse or the cursor keys.
The respective value is displayed in the window.
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7.4.4 Overview

Selection and display of parameters of a timer for all programs or steppers. Depending on
the selected parameter, the active status is displayed (highlighted by different color) for
every program no. or stepper no.

- Gray: turned off, deactivated

- Pink: turned on, active

Viewing the Overview

D Select Operation - Modify - Overview <F6>.

Example of an overview: The Start-Inhibit (P) parameter shown in the upper right corner
is disabled in program 1.

Command button:
- <Timer-Select>: Selects a timer for the Overview.

The parameter to be displayed must be selected in the upper right corner of the Overview:
- Start-Inhibit (P)

- Weld/No weld (P) (firing)

- Time monitor

- Current-Monitoring

- PHA 2.WLD (phase value)

- KSR 2.WLD (constant-current regulation)

- KUR 2.WLD (constant-voltage regulation)

- Used stepper

7
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7.4.5 Programming

NOTE

The comprehensive Programming function is described in separate chapters, cf. volume
2, sections 10 and 11.
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7.4.6 Quick-Programming

NOTE

For a description of the parameters in Quick-Programming, please refer to volume 2.

NOTE

The operation of some parameters depends on the timer type used.

This menu item serves to display the fundamental welding parameters in compressed
format in two windows, modify them and transmit them to the timer. Quick-Programming
provides a tool for modifying the welding parameters and is intended for advanced users
with the experience necessary to judge the consequences of inputs. For beginners, this
menu item provides a quick overview of the welding parameters.

Window 1:

- General program control of a weld timer and the control modes.

- Program-specific schedule modes.

- Program-specific schedule times and %I parameters.

- Program-specific [stepping], including wear values.

Window 2:

- Monitoring mode and status of Monitoring Stopped.

- Monitoring values for standard and mixed monitoring modes for current and time
monitoring.

- Status of the freely programmable output and status of the pressure profile

- Electrode number

The following actual values are displayed:
- Stepper values for [%I] actual values and [pressure].

- Current monitoring actual values for standard and mixed mode.

- Time monitoring actual values for standard and mixed mode.

- Counts, dressings, %I and pressure correction

7
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Quick-Programming window 1

D Select Operation - Modify - Quick-Programming.

[1]

[2]

[3]

[4]

[5]

[6]
[7]

Command buttons:
- <OK>

Closes the window and transmits data to timer or cancels the transmission.

- <Dat.-> WT>: 
Transmits the data to the timer.
If the Auto. Data -> WT function has been activated (checkmark) in the Services
menu, modified parameters will be automatically transmitted when the next input
window is displayed.
For interdependent parameters (e.g. slope and slope time), a modified parameter
first has to be transmitted to the timer before the related second parameter can be
changed.

- <New-Sel>: 
Corresponds to the Selection window, cf. volume 2, section 12.

- <Prog +>: 
next program (current program number + 1).

- <Prog ->: 
previous program (current program number - 1).

- <Page <>>: 
Toggles between window 1 and window 2 and vice versa.

- <Act. Val.>: 
Displays the actual values.
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Inputs, displays, and selection:

[1] Timer and program number

[2] Data for sequence control for all programs.

[3] Data of control modes for the selected program.

[4] Setup data for the selected program.

[5] Schedule times and %I parameters for the selected program.

[6] Stepping parameter data for the selected program.

[7] Stepper data for the selected program.

NOTE

When the data in window 1 or window 2 have been modified, the data will be transmitted
to the timer if command buttons <OK>, <Dat.−>WT>, <New−Sel>, <Prog +>,
<Prog −>, <Page <>>, or <Act.Val.> are activated. The transmission can be can-
celed.

7
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Quick-Programming window 2

[1]

[2] [3]

[5]
[4]

[6] [6] [6]

[7]

The window contains the same command buttons as window 1.
Inputs and selections:

[1] Timer and program number

[2] Monitoring mode Standard or Mixed.

[3] Monitoring stopped on/off.

[4] Electrode number.

[5] Monitoring parameters of Standard mode.

[6] Monitoring parameters of Mixed mode.

[7] Status of the freely programmable output and the pressure profile on/off.
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7.4.7 Actual values

[1]

[2]

[3]

[4]

[5] [6]

Displays:

[1] Timer and program number

[2] Program-related actual values for the [%I] stepper, [pressure] stepper values and
monitoring.

[3] Program-related actual values for current monitoring for Standard or Mixed mode.

[4] Program-related actual values for time monitoring.

[5] Program-related actual values of the electrode for %I and pressure correction and
details concerning the actual wear and the number of dressings.

[6] Program-specific actual values for %I and pressure correction
Example:
%I correction for the selected electrode +2.0%
%I correction for the selected program +4.0%
Total correction +6.0%
Program 1 uses a %I correction of 6.0%.

NOTE

The actual values of the welding parameters are displayed, direct interventions are not
possible.
For an explanation of the individual parameters, please refer to volume 2.
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Set counter

If a used electrode is installed (with x counts) you should adjust the counts and dressings
within the timer to the value of the replacement electrode.
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7.5 Diagnostics

The following functions are provided for commissioning or troubleshooting:

- Status display of the inputs and outputs.

- Display of the timer name, timer type and the release number of the timer software.

- Timer status including fault message and fault table.

- Information and status of the current or last [schedule] of the welding process.

- Setting of date and time in the weld timer.

- Information on the stepper, e.g. Tipdress request, Tipdressing, Prewarning, Pre-
warning Table and End of Stepper.

- Information on the [%I], e.g. Prewarning, maximum value and Prewarning Table.

- Start simulation of a selected program from the programming terminal.

Operation

File Services Modify Diagnostics Status

I/O�s
Timer
Start Simulation

NOTE

The Diagnostics function is not available for offline weld timers.
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7.5.1 I/O�s: inputs and outputs

The digital inputs and outputs of the selected timer are displayed in a list including their
signal statuses 0 or 1. The list display is cyclically updated by the programming terminal
and serves as a commissioning or troubleshooting tool.

Display:

- Inputs: Digital inputs of the timer including status display 0 or 1 and designation
(I = external input, S = internal input, S = serial input only for a timer with serial
I/O interface).

- Outputs: Digital outputs of the timer including status display 0 or 1 and designation
(O = external output, S = internal output, S = serial ouput only for a timer with serial
I/O interface).

Troubleshooting of I/O�s

D Select Operation - Diagnostics - I/O�s.

The I/O�s shown depend on the timer type and are not available for all timer types.

- <Speedrefresh>: Changes over the time interval between any two scans of the
timer by the programming terminal (normal and high-speed). With Speedrefresh
you may scan short-time status changes.

NOTE

Shortening the time interval between data updates puts additional strain on the data
transmission over the field bus.
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Your notes:
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7.5.2 Diagnostics - Timer

The status messages are a tool for troubleshooting. The last or current schedule includ-
ing its status are displayed. The most important stepper parameters are displayed or
mapped in an individual <Prewarning-Table>.

Timer status

D Select Operation - Diagnostics - Timer.

[1]

[2]

[3]

[4]

[5]

Command buttons:
- <<Reset with WC>

Reset when the displayed fault in the timer has been corrected and output the WC
contact. The timer is switched to Ready state.

- <Reset with Reweld>
When the fault has been corrected, the displayed fault in the timer is reset, and the
spot is rewelded.

- <Stepper Status>:
 Displays the Prewarning table, cf. section 7.6.1.

- <Current Status>: 
Displays the Current Prewarning information window, cf. section 7.6.3.

- <Last Weld>
Data concerning the last weld, e.g. commanded / actual currents.
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- <Date/Time>
Displays the internal data and time of the programming terminal and the timer,
transmits this data to one timer or all timers.

- <Info all>: Displays the timer name, timer type and software release of all con-
nected weld timers.

- <Control-Reset>: Resets the timer�s CPU, comparable to cycling power to the
timer.

CAUTION!

The outputs of the timers are reset by <Control-Reset>. If this function is activated
during the welding schedule, the schedule will be aborted. Opening the welding
gun during the welding process may cause strong welding splashes.

Displays:
[1] Timer: Faults and warnings of the timer are displayed and entered in the fault

table. When the cause of the fault or warning has been removed, the display must
be acknowledged and reset with <Reset with WC>, <Reset with Reweld>, or
<Control-Reset>.
More information can be displayed in a window by activating the <Fault Table>
command button (cf. section 7.6.2).
- The Status field shows the timer�s response to an event (Ready off/on).

[2] Actual Cycle: Information and status descriptions of the [actual cycle] are dis-
played. For example, if the schedule is disturbed and the timer is waiting before the
[SQZ] because the <pressure contact> is missing, the Interval field will read
SQZ, and the Status field will show Waiting for press.cont. 1/2.
- The Interval field shows the current sequence of the [schedule]. The status

of this sequence is signaled in the Status field.

[3] Last Weld: Status display of the previous cycle. Events are shown as texts.

[4] Steppers - Stepper: The display shows stepping information for the electrodes of
the timer.
- The display includes the numbers of the electrodes which are in tip dress

request, dressing prewarning or end of stepper status.

[5] Current: This field contains information concerning the [current] of the electrodes
of the timer.
- The display shows the numbers of the electrodes in prewarning or

maximum (end of stepper) status.

!
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7.5.3 Date / Time

This function is used to display the date and time of the programming terminal and the
timer. The data can be transmitted in order to synchronize the date and time data in the
programming terminal and the timer.

The entries in the protocol memory are saved together with the date and time stored in the
timer.

Command buttons:
- <Date/Time -> WT>: Transmits the date and time from the programming terminal

to the timer.
- <Date/Time -> all WT>: Transmits the date and time from the programming termi-

nal to all weld timers.

NOTE

In the BOS-5000 Setup, you may activate the automatic transmission of the date and
time to the weld timers. This function will then become active with each Upload,
Auto.Upload and Timer Change.
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7.5.4 Start Simulation

A welding program is selected and started from the programming terminal. The timer
must not be controlled externally in this case.

- Internal firing can be enabled and disabled from the programming terminal.

Performing a Start simulation

D Select Operation - Diagnostics - Start Simulation.

[1]

[2]

[3]
[4]
[5]

Displays:

[1] The messages are automatically updated in the Actual Cycle field. The current in-
terval of the schedule and its status will be displayed.

Input and selection fields:
[2] Weld program chosen:

Enter the program no. for Start Simulation.

7
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[3] Start with ignition (on/off) (function depends on timer type):

On: The schedule of the specified program number is started with welding
current. The <Weld complete> (WC) signal is output.

Off: The stored Start signal is removed.

CAUTION!

If the electrodes are closed and firing is enabled, welding splashes may be pro-
duced when the Start Simulation function is carried out. Danger is also imminent
with manual guns because they are closed by �remote control� with Start Simula-
tion. 
The selection of Start �On� will initiate the Start Simulation function, i.e. the timer
will start the welding schedule with welding current if the appropriate conditions
(e.g. <WI release>) are met.
If conditions are missing, e.g. <WI release> or <monitoring contact>, Start �On�
will remain stored until all conditions for Start Simulation are met.
When all conditions are present, the schedule will be performed with welding cur-
rent if the Start signal is stored!

[4] Start without ignition (On/Off) (function depends on timer type):

On: The schedule for the specified program number is started without welding
current. The <Weld complete> (WC) signal is output.

Off: The stored Start signal is removed.

CAUTION!

Danger is also imminent with manual guns because they are closed by �remote
control� with Start Simulation. 
The selection of Start �On� will initiate the Start Simulation function, i.e. the timer
will start the welding schedule without welding current if the appropriate condi-
tions (e.g. <WI release>) are met.
If conditions are missing, e.g. <WI release> or <monitoring contact>, Start �On�
will remain stored until all conditions for Start Simulation are met.
When all conditions are present, the schedule will be performed without welding
current if the Start signal is stored!

[5] [WC] (On/Off):

On: The <Weld complete> (WC) output is controlled independent of other
conditions.
The parameters for the <Weld complete> (WC) signal are input in the Basic
Setup - I/O parameters.

Off: The <Weld complete> (WC) output is cleared.

!

!
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Command buttons:

- <Fault reset with reweld>:
A fault during Start Simulation is reset. The cause of the fault must have been cor-
rected beforehand. If Start is present, the timer is switched to Ready state, and the
spot is rewelded. If the spot is rewelded without any faults, the <Weld complete>
(WC) signal is output.

- <Fault reset with WC>:
A fault during Start Simulation is reset. The cause of the fault must have been cor-
rected beforehand. The <Weld complete> (WC) signal is output if Start is present,
the timer is switched to Ready state.
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7.6 Status

Operation

Stepper-Status
Fault-Table
Current Status

File Services Modify Diagnostics Status

NOTE

The Status function is not available with offline timers.
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7.6.1 Stepper Status

Each spot welds causes a certain wear of the electrode depending on the current used,
i.e. it leads to a certain amount of wear. The electrode has to be replaced at the End of
Stepper.

Computation of wear:

Wear  =  (spot weld   x   wear factor)

With a wear factor = 1.0, the wear corresponds to the total number of spot welds. With a
wear factor > 1.0 fewer spot welds will be welded with the same wear, with a wear fac-
tor < 1.0 there will be more spot welds with the same wear.

In this window, the electrodes assigned to all weld timers, the remaining parts, and their
current wear status are shown as a percentage in a numerical and graphical display.
The wear-related parameters are programmed in Programming - Welding parameters -
Stepper.

NOTE

The values in the Prewarning-Table will be automatically updated in selectable time in-
tervals.

7
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Calling up the Prewarning Table

D Select Operation - Diagnostics - Timer - Stepper Status, or

D Operation - Status - Stepper Status, or

D the <F2 Prew.-Step> command button in the plant layout.

[1] [2] [3]

The table shows all weld timers and electrode numbers for which Stepper has been acti-
vated, and where the current wear (counts) is larger than 0%. 

Displays with respect to the Stepper parameters:

[1] Electrode wear (counts) as a percentage.

[2] Remaining number of parts until the End of stepper is reached.

[3] Bar chart showing the wear including a display of the electrode status by a color
change:
Red : End of stepper
Orange : Tipdressing required
Yellow : Prewarning reached
Green : Condition without warning or fault.

Sortkey: 
Select the sortkey for the display in the upper right corner:

- Count % (wear)
- Remaining parts
- continuous
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Command buttons:

- <Electrode changed>: Resets the counter when electrodes have been replaced.

- <Update>: Updates the displayed data

- <Detail-Info>: Displays additional information on the electrode.

Command buttons:

D <Set counter>, activates the input options in the Counts and Dress Counter
boxes.

If a used electrode is installed you should adjust the current counts and dressings within
the timer to the value of the replacement electrode.

7
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7.6.2 Fault-Table

The Fault-Table lists the current faults and warnings of a timer. It contains all current
faults and warnings that have not been reset.

The displayed faults and warnings have certain causes. When the individual causes of
the faults or warnings have been removed and reset, the displays in the Fault-Table will
be refreshed.

NOTE

The displays in the Fault-Table will be automatically updated in selectable time intervals.

Troubleshooting using the Fault Table

D Operation - Status - Fault Table

D <F3 Error Table> command button in the plant layout

Command buttons:

- <Update>: Updates the displayed data to the current timer status.

- <Detail-Info>: Displays additional information on the marked fault.
For this purpose, a new window is opened which displays the command and actual
values, the date and time of occurrence of the fault or the warning, depending on
the type of fault.
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- <Reset with WC>: Resets the marked fault.
The cause of the fault must have been removed beforehand. The <Weld Com-
plete> (WC) is output if Start is present, the timer is set to Ready state.

- <Reset with Reweld>: Resets the marked fault.
The cause of the fault must have been removed beforehand. If Start is present, the
weld timer is set to Ready state, and the spot weld is repeated. If the spot is re-
peated without a fault, the <Weld Complete> (WC) contact is output.

- <Help>: Contains information on possible causes and suggestions for correcting
the fault/warning.

7
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7.6.3 Current Status

For all weld timers with active [Stepper], the following will be displayed:

- the related electrodes

- the %I output with respect to the maximum current (numerical and graphical dis-
play)

The %I parameters are programmed in the Basic-Setup - Electrode-Setup.

NOTE

The values in the Current-Prewarning-information will be automatically updated in se-
lectable time intervals.

Calling up the Current Prewarning Information

D Select Operation - Diagnostics - Timer - Current Status or
Operation - Status - Current Status.

[1] [2]

The table shows all weld timers including their electrode numbers for which Stepper is
active and whose current counts are larger than 0%.
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Displays with respect to the %I limitation (Basic-Setup - Electrode-Setup):

[1] %I value of the electrode in percent, referred to the programmed %I limit.

[2] Bar chart for [%I], status display by way of color change.
- red : end of stepper
- yellow : prewarning reached
- green : no warning or fault.

Command buttons:

- <Update> : Updates the displayed data.

- <Detail-Info> : Displays additional information on the [%I].

7
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Your notes:
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7.7 Selection

Operation

File Services Modify Diagnostics Selection

Timer-Selection
Spot-Selection
Timer-/Spot-Deselection
Timer-Info
Spot-Info
Active Selection

NOTE

Menu items Timer-Selection, Spot-Selection, and Timer/Spot Deselection have a toggle
switch function. If the menu item is checked, it is �activated�.
Selecting (activating) one of these items automatically deactivates the previously active
item.

7.7.1 Timer-Selection

The Timer-Selection serves as a default setting for Operation and Programming.

The list of available timers is displayed for selection. When you have made a Timer-
Selection, you should make a Program-Selection.

D Select Operation - Selection - Timer-Selection.

The Timer-Selection is always followed by a Program selection, even if the subsequent
function, e.g. Diagnostics relates to the whole timer.

7
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7.7.2 Spot-Selection

The Spot-Selection serves as a default setting for Operation and Programming.

NOTE

Precondition: A Spot-Reference with the appropriate spot names must have been
created.

D Select Operation - Selection - Spot-Selection.

Command buttons:

- < >

Scrolling in the displayed table:
First line, page up, one line up,
one line down, page down, last line.

Sortkey: The records of the table will be displayed according to the order selected in this
field:

- alphabetically according to spot names
- according to program numbers
- alphabetically according to timer names.
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NOTE

By entering characters in the Spot name field, the spot with the closest match will be dis-
played.

7.7.3 Timer / Spot-Deselection

A timer/spot selection is cancelled. The timer symbol previously marked by a frame in the
plant layout for selection loses this selection mark.

NOTE

This function is designed for operation without a mouse.

7.7.4 Timer-Info

D Select Operation - Selection - Timer-Info.

NOTE

The Timer-Information can only be displayed if a Timer-Selection or Spot-Selection has
previously been made.

7
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7.7.5 Spot-Info

D Select Operation - Selection - Spot-Info.

NOTE

The Spot-Information can only be displayed if a Spot-Selection has previously been
made.

7.7.6 Active Selection

Information concerning the timer currently selected for operation.

D Select Operation - Selection - Active Selection.
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7.8 Window

This function is used for activating the Auto. Upload window from the background if no
mouse is available, cf. section 7.3.3.

Users without master privileges may not change the settings of Auto. Upload.

7.9 Help

- Contents

- Index, can also be called up with <F1>

- Help on Help

- Info about ... (BOS-5000 release)

Operation

Help

Contents
Index
Help on Help
Info about ...

Services Modify Diagnostics Status

7
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Your notes:
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8 Fundamental principles

8.1 Structure of a Welding System

A welding system is mainly composed of the following:

- Weld timer (Timer) with an up-front control system consisting of
- a programmable logic controller PLC
- a robot control or
- a manual control mechanism for electrode guns

- a welding transformer

- a welding gun with electrodes, pressure (monitor) contact and solenoid valve,

- a current sensor (toroid)

I

O

O

I

Start

Weld complete
WC

Solenoid valve

Weld times

Monitor contact

Welding transformer

Weld timer

Progr. no.

PLC

Timer

Current sensor

Actual current value
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In automated welding installations the exchange of the I/O-signals is increasingly exe-
cuted via field buses.

A more refined application of the welding technique is medium-frequency welding with
1 kHz. In contrast to 50 Hz welding with pulsating welding current, 1kHz welding is done
with direct current.

The new generation of welding installations has weld timers and inverters integrated into
one device.

Robot
Control

I/O
50Hz

1kHz

serial I/O via field bus

Mains

Firing

Timer Inverter

Actual current value

I/O
module

Welding transformer
with rectifier

Monitor
contact

Solenoid valve

Proportional
valve

Synchron.

integrated control unit PS 6000
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8.2 Tasks of the Weld Timer

In order to obtain a controlled welding process, the weld timer has to control or regulate
several functions.

- Adjustment of the [Welding Current Intensity]

- Adjustment of the [weld time] in cycles or milliseconds
- A difference is made between short-, medium- and long-time welds.

- Output of a voltage signal for the solenoid valve in order to close the electrodes

- Output of a voltage signal for a proportional pressure valve in order to control the
electrode pressure

- Control, regulation and monitoring of the weld sequence (schedule)

- Weld complete or fault message for the [Schedule]

+
-

+
- -

 ÉÉÉÉÉÉÉ
ÉÉÉÉÉÉÉ

Welding transformer

I

+

Solenoid
Current

SQZ WLD HLD

Start

F

F = Electrode force
I = Current
Solenoid = Solenoid valve

For performing the actual welding process, the timer can be operated with an automatic
control system or controlled manually by an operator. This may result in different operat-
ing modes.
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8.3 Modes

Single spot (for spot welds, projection welds, butt welds, ...)

A start signal at the input of the weld timer turns on the welding [sequence]. Once the weld
has been completed, the timer issues the Weld Complete (WC) contact.

For a new [sequence], the start signal has to be toggled off/on. Single spot mode is suit-
able for applications involving robots, welding machines, automatic welding machines,
and manual electrode guns.

from robot
(PLC)

to robot
(PLC)

Producing a spot weld Producing another spot weld

Start

Solenoid

Weld
complete

8.4 Repeat mode (for spot welds in manual systems)

As in single spot mode, the weld timer responds to the start signal and performs a spot
weld.

For as long as the start signal is high, the solenoid is switched off after the [hold time].

The welding gun opens. The [OFF Time] runs. The operator can pull the welding gun to
the next spot.

After the [OFF Time], the solenoid valve is activated again, and a new spot is welded.

This [sequence] will be repeated for as long as start is active. Repeat mode is suitable for
manual electrode guns and for manually operated welding machines.

OFF

Start

Solenoid

Weld complete

Producing a spot weld Producing additional spot welds
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8.5 Seam Mode (for roller seam welding)

NOTE

A difference is made between seal welds and stitch welds!

Stitch welds

When the rolling electrodes pass over the parts to be welded the material is joined by
individual spot welds. The [cool time] separates the [weld times] of the individual spots.

Seal welds

The [cool time] of seal welds is very short, or even 0 cycles. Thus, the spots lie closely side
by side or overlap each other.

Seam operation is performed for as long as start is active. When the start signal is turned
off, the [current impulse] is cancelled synchronously with the mains. After that the hold
time is running. Seam operation is used with roller seam equipment.

ÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÍÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈ
ÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈÈ

Cool time Weld time
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8.6 Current Block Operation

In the welding example 8.2 the welding current for the spot weld was applied during a
single [weld time]. However, the process may require to work with short consecutive cur-
rent blocks.

A spot weld may comprise a maximum of 3 current blocks. The [cool time] separates the
current blocks.

+

-

+

-

+

-

SQZ

+

-

1. WLD
weld current

1.
CT

+

-

+

-

2. WLD
weld current

+

-

+

-

+

-
 

3. WLD
weld current

3.
CT HLD

1. current block
(Preheating time)

2. current block 3. current block
(Postheating time)

Start

Solenoid

Preheating Time (1. WLD)

- This function is used to prewarm the metal with lower heat prior to the actual weld. 
- Optional programming of a current (preheating current) with [weld time] (Preheat-

ing Time 1. WLD).

2. Current Block / 2. Weld Time (2. WLD)

- This function is used to perform the actual spot welding procedure.
- The current (%I) is delivered to the welding spot in form of one or more [Current

Impulses]
- 2. Current Block / 2. Weld Time must always be programmed.

Postheating Time (3. WLD)

- This function is used to perform a postheating of the metal with lower heat after the
actual weld.

- Programming a postheating current with [Weld Time] (Postheating Time 3. WLD)
is optional. Postheating prevents weld stresses in the material.
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8.7 Current Upslope/Current Downslope

The [Slope] function is used to increase the commanded current from an initial value up to
a programmed final value. This function is equally possible in impulse mode and in simple
mode (no impulses). The same is valid for Current Downslope.
The upslope time [UST] and the downslope time [DST] can be specified by parameters.

The [Slope] function reduces the switch-on current peak and thus also the stress on the
electrical welding devices (e.g. the welding transformer).

only current upslope ramp in the 2. WLD only current downslope ramp in the 2. WLD

current upslope and current downslope ramp in the 2. WLD

UST DST

8
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8.8 2. Current Block Consisting of Impulses

The number of [impulses] determines how often [2. weld time] and [2. cool time] alternate.
The [2. cool time] is always interposed between the [impulses] of the [2.weld time].
(Examples: without the 1st and 3rd weld time)

UST = 0 DST = 0

2. WLD = 3 2. CT = - IMP = 1

UST = 0 DST = 0

2. WLD = 3 2. CT = 2 IMP = 2

UST = 0 DST = 0

2. WLD = 3 2. CT = 2 IMP = 3

Example 1

Example 2

Example 3

2. Weld time

2. Weld time

2. Cool time

2. Weld time

2. Cool time 2. Cool time

- The upslope and downslope times are independent from the [impulses], they take
place within the [2. current block].

- The upslope time starts with the beginning of the [1. impulse].
- The downslope time terminates with the end of the last [impulse].

UST = 6 DST = 2

2. WLD = 3 2. CT = 2 IMP = 3

UST DST

Example 4

2. Cool time

2. Weld time

2. Cool time
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8.9 Schedule (Sequence)

A [Schedule] (sequence) is a diagram, which displays the welding process as a function
over time. This time axis is thereby subdivided into different segments.

Schematic welding process over time (Flowchart)

[1] [3][2] [4] [5]

[6a]

[7] [9] [10] [11] [13]

t1. SQZ  SQZ 1. WLD 1. CT

2. WLD

( UST) (DST) 3. CT 3. WLD  HLD OFF

t t

[5]

[6a]

[7]

2nd Weld time with enabled slope

Schedule (Sequence) diagram Schedule (Sequence) diagram

USTDST

2. WLD

UST DST
[12]

[8]
[5] [7]

Imp.

[6a]

1 2 3 4 5 6 7

 [6b]current block

2nd Current block with enabled slope and
pulse operation (e.g. with 7 impulses)

2.
W

L
D

8
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[1] 1. SQZ [Pre-Squeeze Time]
- The [pre-squeeze time] (1.SQZ) starts immediately after the start signal in

the three operating modes single spot, repeat mode and seam mode.
- When welding repeated spots, the [1.SQZ)] runs only for the first spot of the

series.
- The welding gun starts its closing motion at the beginning of the [1. SQZ]. No

current flows in this time segment.
- The [1.SQZ] precedes the [SQZ] [Squeeze Time], in order to achieve a com-

plete closing of the gun even in case of a long closing distance, e.g. with a
manual gun.

[2] SQZ [ Squeeze Time]
- The working pressure of the electrodes is built up during the [SQZ]. The

welding gun must be closed when the [SQZ] begins. No current is generated
in this time segment.

- If a manual electrode gun is closed with start, the path the electrodes have to
travel before they are closed is usually fairly long. The process requires
some time.
If a program works in repeat mode, the electrode gun is not opened widely
during the short [OFF Time] (OFF) because the solenoid valve is immedi-
ately activated again.
Therefore, only a shorter [Squeeze Time], [SQZ], is required for the 2nd and
subsequent spots.

[3] 1.WLD [1st Weld Time]
- Current is generated during the 1. Weld Time [1. WLD] to pre-heat the part

being welded and to prepare for the actual weld.
[4] 1. CT [1st  Cool Time]

- The [1.WLD] is followed by a cooling time without heat generation, to allow
stress relief of the part being welded. The welding gun remains closed.

- After the end of this time segment, the actual welding process starts.
[5] UST [Up Slope Time]

- If [Slope] is enabled, the current (%I) output increases gradually during a
given time period, starting with an initial current and stopping at the pro-
grammed current. This time period is also called �Slope time to pro-
grammed current�.

- The [UST] is part of the 2. WLD [6a] and/or the [2nd Current Block] [6b].
- The [UST] may be part of a complete [Impulse] or composed of several [Im-

pulses].
- The [1.WLD] and [3.WLD] use no [Slope].

[6a] 2.WLD [ [2nd Weld Time]
- With non-pulsed operation, the main weld starts at the beginning of the

[2.WLD]. The [2.WLD] consists of a single [Impulse].
[6b] [2nd Current Block]

- With pulsed operation, the main weld starts at the beginning of the [2. Cur-
rent Block]. The second current block consists of up to nine [Impulses] with
the length of  a [2. WLD] each.
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[7] DST [Down Slope Time)]
- During this time period, the current for producing the spot weld is gradually

reduced.
- If [Slope] is enabled, the current (%I) output decreases gradually during a

given time period, starting with the programmed current and stopping at the
final current. This time period is also called �Slope time to final current�.

- The [DST] is part of the [2.WLD] [6a] and/or the [2nd Current Block] [6b].
- The [DST] may be part of a complete [impulse] or composed of several

[Impulses].
- The [1.WLD] and [3.WLD] use no slope.

[8] 2. CT [2nd Cool Time]
- During the build-up of the [2. Current Block] with [Impulses], the [2. Cool

Time] determines the interval between the single [Impulses]. During these
[Cool Times] no current output takes place.

[9] 3. CT [3rd  Cool Time]
- With the welding gun closed, the [2. WLD] or [2. Current Block] is followed by

a [Cool Time] without current output to allow stress relief of the welded part.
[10] 3.WLD [3rd Weld Time]

- In the [3. WLD] a last current output may be given for post-heating purposes.
This post-heating improves the structure of the welded part and serves to
relieve weld stresses.

[11] HLD [Hold Time]
- The welding process ends with the [HLD]. No current output takes place

during the [HLD]. The weld spot is fixed in position during this cooling period.
The solenoid valve closes at the end of the [HLD] and the welding gun opens
up.

[12] [Impulse]
- This parameter determines the number of [impulses] which make up the

2nd Current Block.
[13] OFF [OFF Time]

- This time period is only used for repeat operations. The parameter deter-
mines the time period before the next [SQZ] during which the welding gun is
open and the part to be welded can be moved to the next spot position.

NOTE

Current Cycles (cycles) or milliseconds (ms) are the units of measurement for program-
ming the individual times. A time entry consists of a multiple of this unit. 
Kilo Ampere (kA) is the unit of measurement for programming the intensity of the welding
current under constant current regulation. 
Scale units (%I) are used for programming the intensity of the welding current for
constant voltage or phase angle regulation.

8
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8.10 Stepper function/Stepping/Tip dressing

This function provides for stepping of the welding current in order to compensate for the
electrode wear. Stepping is done through stepping-curves that are set in Basic-Setup.

The following data is required:

- End of Stepper (max. counts (wear))

- [Current] (Stepping current in percent (%I))

- Number of the stepper curve (0-9).

Current

%I

100%

End of Stepper

No. of Stepper curve

[1]

[1] Prewarning
The <Prewarning> signal indicates that the [End of Stepper] will be reached soon.

[2] Tip Dressing
In order to improve the electrode�s tool life the electrode can be processed cyclically (tip
dressed).

The stepping and the tip dressing functions can be combined.

maximum
wear

Example: three tip dress steps

[1]
[2]

[2]
[2]

Current

Determination of curve shape by
no. of stepper curve

%I Stepper

%I tipdressing

Determination of curve shape by
no. of tipdress curve
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The following data is required:

- number of tip dress steps
- [Current] (percent Stepper at the beginning of a new tip dressing cycle)
- number (0 to 9) of tip dressing curve

Tip dress request (timer-specific)

The <Tip dress request> [2] signal indicates that machining (tipdressing) of the elec-
trodes will be necessary soon.

8
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8.11 Wear Factor

Electrode

Wear

- intensity of current

- materials

- electrode pressure and electrode material

effective contact surface effective contact surface

Some factors controlling wear:

Examples for the wear factor:

low current                    -  wear factor =  0.8

high current                 -  wear factor =  1.3

sheet metal, steel         -  wear factor =  1.0

galvanized sheet metal - wear factor  =  2.8

(the cited values are not intended to be standard values)

With a wear factor = 1.0, the wear is the sum of the completed spot welds. With a wear
factor greater than 1.0, fewer spot welds will be completed with identical wear. With a
wear factor smaller than 1.0, more spot welds will be completed with identical wear.

Summing up, many spots with a low wear factor may result in the same wear as few spots
with a high wear factor.

Example: Effect of wear factor and wear on the possible number of welds with different
welding programs.

Program
number

Wear
factor

 Number of
Spot Welds

Wear

2 0.8 100 80

5 1.0 80 80

9 2.0 40 80
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8.12 Start Interlock

When the first cycle of the [Weld Time] starts for a spot weld, the timer remains locked in,
i.e. even if the start signal becomes logically 0, the initiated spot weld will be completed
including the [Hold Time] (applies to single spot and repeat mode).

Only the <External Weld Time Termination> or the <Stop> signal can interrupt this pro-
cess.

Start 1. SQZ WLD HLD

Interlock

8
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8.13 Prelift (timer-specific)

In order to reach the welding position of the parts to be welded with an open electrode gun
it is useful to open the gun wider than normal.
The signal <Prelift> serves to activate a 2nd cylinder which opens the gun to the wider
position. If Prelift is active, the welding program cannot be started. 
Vice versa, Prelift is not possible while start is active. The <Start> and <Prelift> signals
are mutually interlocked in the timer.

Prelift, function in connection with manually operated gun (manual electrode gun)

À

Á

Â

open

Gun in neutral
position

closed

Signals

Prelift ON, no Start

no Prelift, no Start

no Prelift, Start ON

Prelift, function in connection with a PLC (robot control)

À

Á

Â

open

Gun in neutral
position

closed

Signals

no Prelift, no Start

Prelift ON, no Start

Prelift ON, Start ON

The robot-prelift function can work differently from the timer-prelift function. The robot
uses the prelift function mainly to put the robot gun in the central position. To close the gun
the signals <Prelift> and <Start> must be high. This function does not use the timer-pre-
lift.
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8.14 Weld Complete Contact (WC)

Normally the output of the <Weld Complete> contact begins at the end of the [Hold
Time]. The beginning and the duration of the WC output can be programmed. They spec-
ify the number of cycles before the end of the [Hold Time] and for how long the <Weld
Complete> (WC) signal is output.
Even in the case of high negative values, the earliest time the WC is issued, is one cycle
after the end of the [Weld Time].

WC

START

14 3 2

End of
HLD

HLD = 4WLD

WC beginning = -2

8
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8.15 Automatic Spot Repetition

If current monitoring is enabled and the fault �no current� or �current too low� occurs, auto-
matic spot repetition is possible.

- Spot repetition with current values below the tolerance range (maximum number
of repetitions).
A spot is repeated only once at the most.
All repetitions are counted and if their maximum number is exceeded it is reported.
A weld within the tolerance band resets the repetition counter.

The gun remains closed, [Squeeze Time], [Weld Time], ... , [Hold Time] are started again.

If the Repeat factor, i.e. the maximum number of repetitions, is exceeded, the timer loses
its ready state.

NOTE

The Current Monitoring function must be active for automatic spot repetition.
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8.16 1. Half-Cycle/1.Half-Cycle after Cool Time (1. HC a. PAUSE)

Activating the first current halfcycle of each weld can be limited to a certain value in order
to protect the welding transformer and the thyristor unit. The default value is 55 %I and
can be adjusted.

For lower [Current] values (0...55%I) the 1st halfcycle is not changed. If higher values are
programmed (56...99%I), only the 1st halfcycle is limited to 55%I.

- Limit 1. halfcycle
The first halfcycle of a weld is limited.

- 1. Half-cycle after Cool time
When welding with several [Weld Times]/[Impulses], an additional limitation can
be programmed after each [Cool Time].

CT
1. Half-cycle after cool time CT55 %I

1st impulse 2nd impulse

8
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8.17 PHA: Phase Angle Regulation

Programming the electrical [Current Command Value] (activation of the sinusoidal half-
wave) is done in [Scale Units] (%I). The current intensity is exclusively determined by the
electrical quantities in the welding circuit.

There is no regulating function; the programmed [Scale Units] serve as command values.
Current and Time monitoring can be enabled.

120 99

31°

-150

130°

programmable range

180°0°

high current low current

Half-cycle of mains voltage

- electrical degrees

- scale units (%I)

phase angle, fixed value determined
by programming
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[PHA] without regulation, with monitoring

Command Current
value in %I

Firing Mains

Thyristor unit

Welding transformer

Current sensor
(toroid)

Actual current value

Measured value
conditioning

- Actual  kA value
- average PHA

Actual value display

- Tolerance band

Current monitor Status fault

Reference current in kA

without regulation

with monitoring

In sequence

In current monitor

in the timer external

D Current monitoring requires a current sensor (toroid).

8
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8.18 KUR: Constant Voltage Regulation

NOTE

The KUR regulation mode cannot be selected for all types of weld timers.

The Constant Voltage Regulation [KUR] must be programmed in [Scale Units] (%I).

This mode is used when the mains voltage fluctuates and the [KSR] regulation mode is
not available. The primary voltage of the weld transformer is measured and used to adjust
the phase angle accordingly in case of mains voltage fluctuations.

regulation of the phase angle,
depending on the mains voltage

120 99

31°

-150

130°
180°0°

programmable rangehigh current low current

Half-cycle of mains voltage

- electrical degrees

- scale units (%I)

While in the Starting Window - Operation - Modify - Programming - Basic-Setup - Thy-
ristor-Unit Setup menu enter:

- the nominal mains voltage (Supply-Volt.)

- the transformer ratio of the feedback transformer (Prim. Transf. Ratio).

These two entries, the measured voltage from the feedback transformer and the actual
current value, determine the control of the phase angle which compensates for mains
voltage fluctuations in the regulation mode [KUR].

NOTE

A voltage measuring circuit (feedback transformer) is required. This transformer�s pri-
mary winding lies parallel to the primary winding of the welding transformer. The secon-
dary winding feeds the UPR timer input.
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[KUR] (voltage regulation) with current monitoring

Controller

Firing

Mains

Thyristor unit

Welding transformer

Actual voltage value

%I

UMains nominal

Measuring
transformer

Measured value
conditioning

- Actual kA value
- Mean phase
   angle in %I

Actual value display

- Tolerance band

Current monitor Status fault

Current sensor
(toroid)

Actual current value

Reference current
in kA

nom. winding ratio

D The mains nominal voltage must be entered.

D A measuring transformer is required, the transformer ratio must be entered.

D A current sensor (toroid) is required.

8
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8.19 KSR: Constant Current Regulation

Programming of the welding current command value is done in kilo Amperes (kA). The
current measuring device (current sensor or toroid) determines the actual current which
is then compared to the command value. The following controller processes the differ-
ence and controls the phase angle in such a way that the current command value can be
reached. It is the standard mode for robot electrode guns.

[KSR] with regulation and with monitoring

Controller

Firing

Mains

Thyristor unit

Welding transformer

Current sensor

Actual current value

Measured value
conditioning

- Actual kA value
- Mean phase
   angle in %I

Actual value display

- Tolerance band

Current monitor Status fault

Difference
Command
value in kA

with regulation

with monitoring

Reference
current in kA

In sequence

In current monitor

R
eg

u
la

ti
o

n
M

o
n

it
o

ri
n

g

D A current sensor is required.

D Regulation on/off - Monitoring on/off - Regulation mode standard/mixed - Monitor-
ing mode standard/mixed - Current monitor on/off - enter reference current - enter
tolerance band.
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8.20 Current Monitoring

The actual current for Current Monitoring is determined by the following measuring pro-
cedures.

- In standard mode, an actual current is determined for the entire welding cycle (in-
cluding all cool times). The measuring time runs from the beginning of the 1. Weld
Time [1. WLD] till the end of the 3. Weld Time [3.WLD].

- In mixed mode, a separate actual current is determined for each weld time (pre-
heating [1.WLD], main weld [2.WLD], post-heating [3.WLD]). If the main weld con-
sists of several [Impulses] with intermediate cool times, the current is only
measured during the [Weld Times] of the [Impulses].

8.20.1 Standard Current Monitoring

Standard

Reference current I mean v.

Actual current (1 value)

t1 t2 t3 t4 t5

Measuring time

The mean current value is determined for the entire time pe-
riod and compared to the reference current. The cool times are

included in monitoring.

1.
WLD 3. WLD

2. WLD with impulses

Tolerance band

8.20.2 Mixed Current Monitoring

Mixed

Reference
current I3

Actual
current
I3

Reference current I1

Actual current I2

1.
WLD

3. WLD

t1 t2 t3
Measuring time 1 Measuring time 3

2. WLD with impulses

∑ Measuring times = t1+t2 +t3

Reference current I2

Actual current I2

(1) Tolerance band

(1)

(1)

(1)

Measuring time 2 =

8
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In the above examples, the time characteristics of the current curve is idealized and
shown as a rectangular impulse. In reality, there is a recovery and a decay at the begin-
ning and at the end of each rectangular impulse. For some timer types the current mea-
surement can be restricted to the constant part of the current flow by entering a fade-out
time at the beginning of the impulse and by enabling �Trail Current Off�. The best fade-out
time must be determined through several trials.
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8.20.3 Fade-out Time and Trail Current

NOTE

Programming of the fade-out time and deactivation of the trail current depend on the timer
type used.

The fade-out time (time for current increase at the beginning of a pulse) and the �Trail
Current off� function (trail current at the end of the pulse) apply to each rectangular pulse
of the entire [Sequence].

two weld times including cool time without fade-out time

Mixed
measuring

time 2

1. CT1. WLD 2. WLD t

Mixed
measuring

time 1

**

two weld times including cool time with fade-out time

Mixed
measuring

time 1

* * Fade-out time
** Trail current

t1. WLD 2. WLD

Mixed
measuring

time 2

Measuring
without

trail current

1. CT

***

Measuring
without

trail current

8
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8.21 Time Monitoring

The actual time for Time Monitoring is determined by the following measuring proce-
dures.

- In Standard mode, a reference time is entered and monitored for the entire welding
[sequence].

8.21.1 Standard Time Monitoring Mode

[1]

[2][2]

[1]

[2]

[1]

tt

t

one weld time
two weld times without cool time

Reference time

two weld times with cool time

Reference time

Reference time

[1] Reference time for Time Monitoring
[2] Tolerance band of good welds
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8.22 �7-Item-Check�

If you encounter a timer with an unknown condition, you should first check the following 7
items:

- 1. Program no.:
Which program is started (e.g. by the robot), which program do you see at the pro-
gramming unit?
(Is Start 1 or Start 2 active?)

- 2. Which mode is active? SINGLE, REPEAT or SEAM?
For repeat mode one OFF-time is required.
Is Weld on/Weld Off (external/internal) enabled?

- 3. Number of [Weld Times]/[Impulses]:
- One [Weld Time]:

Only [2. Weld Time] and [Current] are used.
- With preheating:

[1. Weld Time] and [1. Current] are also used.
- With postheating:

[3. Weld Time] and [3. Current] are also used.
- [2. Current Block] with [Impulses]:

[No. of Impulses] > 1, [2. Cool Time] may be used.

- 4. Stepper yes/no?
- Valid curve shape?
- Are the [current values] %I or kA entered correctly?
- Is the wear factor entered correctly?
- Does the program use the correct electrode?
- Has an electrode reached the �End of stepper�?

- 5. Current function PHA-KSR-KUR
- Is the tolerance band entered?
- Is the right reference current used?

- 6. Is Inhibit Regulation switched ON/OFF?

- 7. Is Inhibit Monitoring switched ON/OFF?

8
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Your notes:
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9 Programming

9.1 Services

- Transmit timer data to the weld timer

- Transmit parameters to the weld timer

- Exit Programming, return to Operation window

Starting window

...

Timer-Reference Spot-Reference Operation

File Services Modify Diagnostics

Programming F9

Services
Welding-Pa-

rameters Basic-Setup Selection Help

Data -> WT CTRL + F2
Param. -> WT CTRL + F3
Pg.Back F9
Exit ALT + F4

9
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9.1.1 Data -> WT (<Ctrl> + <F2>)

Transfers all program data from the current window to the selected program and/or the
selected electrode. This function is available only in the Welding Parameters windows
and in some of the Basic Setup windows.

NOTE

Offline data are stored in the selected offline directory. Already existing files are over-
written.

D Select Starting window - Operation - Modify - Programming - Services - Data ->
WT.

Command buttons:

D <OK>: 
transmits data to the timer or cancels data transmission, closes the window.

Data transmission can be given a comment. The comment (max. 48 characters) is saved
in the protocol memory for data modifications of the timer.

Changes made at the programming unit will not become effective unless they have been
transferred to the timer.

If in Operation - Services, the menu item Auto. Data -> WT is checked (activated) this
window will be automatically displayed whenever a modified input field is exited.
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9.1.2 Param. -> WT (<Ctrl> + <F3>)

Transfers individual parameters to selected programs and/or for selected electrodes
from the current window. This function is available only in the Welding Parameters win-
dows and in some of the Basic Setup windows.

NOTE

Offline data are stored in the selected offline directory. Already existing files are over-
written.

D Select Modify - Programming - Welding parameters / Basic-Setup - Services - Pa-
ram. -> WT. This function can also be activated by clicking with your right mouse
button on an input field.

According to the type of the parameter a window with variable contents will be displayed.

The last modified parameter is transferred.

Example: Window for the time monitoring parameter

Input and/or selection fields:
- All programs

The displayed parameter is changed in all programs of the timer.

- Stepper
The displayed parameter is changed in those weld timer programs that work with
the displayed electrode.

- Program
The displayed parameter is changed in the program/s that is/are listed in the input
field Prg. No.

- Prg.No.
Enter the program number(s) for data transmission. It is also possible to enter sev-
eral programs at the same time.
- Example: 2-5,7,11,22-24,

Transmission for programs 2, 3, 4, 5, 7, 11, 22, 23 and 24.

9
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Example: Window for the stepper parameter

Input and/or selection fields:

- All steppers
The displayed parameter is changed for all steppers (electrodes) of the timer.

- Stepper 
The displayed parameter is changed for the stepper(s) (electrode/s) of the timer
that is/are listed in the Elec.No. input field.

- Elec.No.
Enter the stepper (electrode) number for data transmission. It is also possible to
enter several steppers at the same time.
- Example: 2-4,9 

Transmission for electrodes 2, 3, 4 and 9.

9.1.3 Pg.Back (<F9>)

Change back from the current Programming window to the Operation window showing
the plant layout (alternatively <F9>). Programming is put into background.

The Operation menu is displayed.

9.1.4 Exit

Exit Programming.
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10 Basic Setup

Many parameters are timer- and plant-specific and have to be determined  in the Basic-
Setup when starting the system.
In Basic Setup basic functions are assigned to the timer (WT) (e.g. the reaction of the WT
to events in the weld circuit). They adapt the WT to the environment of the welding equip-
ment (e.g. selection of the thyristor unit). By assigning electrodes and programs and by
further definitions you prepare the programming of the welding parameters.

- Delete memory in the timer
- Response of the timer to events (e.g. deviations from command values) in the

sequence
- Definition of I/O parameters
- Definition of the electrodes parameters and maintenance concept ...
- Entries for all timers such as Start-Inhibit, Max. Weld Time ...
- Interaction with different units like AC, inverter ...
- Measurement, control, and monitoring processes ...
- Sequence modes Single, Repeat, and Seam.

Starting window

Operation

Modify

Programming F9

...

Weld transformer Selection

Timer-Reference Spot-Reference

File Services Diagnostics

SelectionBasic-Setup

Fault Allocation (Fault Setup)
I/O Parameters
Thyristor-Unit-Setup

Global Stepper Setup
Stepper-Curves

Services Welding parameters

Stepper-Setup (Electrode-Setup)
Sequence-Setup

Safe Delete

Tipdress-Curves

Help

Operation of Basic-Setup

In order to operate the Basic-Setup the windows Timer-Selection and Program-Selection
are opened. If no timer or spot has been selected yet, an appropriate dialog will be
opened.

10
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10.1 Safe Delete (Delete Memory)

Memories in the timer are deleted or set to default values. For this purpose, the desired
data must be selected. It will be deleted with the <Delete> command button without an
additional query.

D Select Starting window - Operation - Modify - Programming - Basic-Setup - Safe
Delete.

All history fault and changes

The protocol memory contains (including time and date):

- fault messages

- current fault messages

- data changes

- current values

All history of dynamic weld data

The actual values memory contains:

- Actual current, voltage and phase values of the last weldings including time and
date

- counter status (e.g. electrode wear)

All program data

All Welding Parameters and Basic Setups are set to default values. Data that are e.g.
relevant for setting up the interfaces (V24 and fieldbus) are copied from the timer�s flash
memory to its random access memory (RAM).

NOTE

This will delete all welding parameters and basic setups previously set in the weld timer.
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10.2 Fault Allocation

The displayed list contains the types of faults and the timer�s response upon their occur-
rence. With the command buttons <Warning> and <Fault> the appropriate response of
the timer can be assigned to the marked fault type.
Each change is transmitted to the timer as soon as the command button is pressed and
becomes effective immediately.

D Select Starting window - Operation - Modify - Programming - Basic-Setup -
Fault-Setup.

Command buttons:

- <New Sel> corresponds to the Selection menu in Programming,
see chapter 12.

- <Warning> selects Warning for the marked event. 
When the event occurs, the timer will not lose its Ready state. Other [sequences]
can be performed.
The output Warning (type-specific) is set and a message is displayed at the pro-
gramming unit.
The source of the warning is to be eliminated, the message acknowledged. Warn-
ings concerning the [sequence] are cleared with the next <Start>.

- <Fault> selects Fault for the marked event.
Upon occurrence of the event the timer loses the Ready status. No further [se-
quences] are possible.
The output Welding Fault (not available for all types) is set and a message is dis-
played at the programming unit.
The source of the fault is to be eliminated, then the fault message is to be acknowl-
edged.

NOTE

Changing the fault type in the Fault Allocation window becomes active even if the window
is exited with <Cancel> .

10
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Your notes:
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10.3 I/O Parameters

Signals of the I/O interface are defined.

- Parity (only in timers with parallel I-interface)
When starting a welding program a parity check can verify the program selection.
Parity check serves the safety of the program selection using parallel inputs.

- <Weld complete> (WC)
Announces the end of the welding process to external timers, especially in auto-
mated welding installations.

D Select Starting window - Operation - Modify - Programming - Basic-Setup - I/O
Parameters.

[1]

[2]

[5]

[3]

[4]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to timer.

- <New Sel> New Select corresponds to the Selection menu in Programming, see
chapter 12.

10
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Parity

Examples for the meaning of the parity bit:
Program number = 1 + 4 + 16 + 64 = 85 or 2 + 4 + 8 = 14

Bit8 127

64

32

16

8

4

2

1OFF ON

Choose Parity

OFF not used

Odd Even

Parity bit

85 8514 14 85

l

l

l

l

l

l

l

l

l

l

ll

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

l

ON ONOFF

127

64

32

16

8

4

2

1OFF ON

OFF

ONOFF

The parity bit is used when a program is selected using parallel inputs.

Inputs and selections:

[1] Choose Parity

- OFF
Parity bit is not evaluated.

- Even
The sum of the program selection bits with status 1 must result in an even
number. If not it must be supplemented with the parity bit with status 1 in
order to become even.

- Odd
The sum of the program selection bits with status 1 must result in an odd
number. If not it must be supplemented with the parity bit with status 1 in
order to become odd.

When parity errors occur the message Program Parity Fault  is displayed.

NOTE

Parity is not applicable if the program is selected via an I/O bus.

[2] <Weld complete> WC with error in the [sequence]
In automated welding installations it might be necessary to output <Weld Complete>
also in the case of errors; for fault definition, see section 10.2.

- WC with error

- ON
<Weld complete> WC is also issued if an error is detected.

- OFF
<Weld complete> WC is issued only if no errors are detected during
[sequence].
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<Weld complete> WC without errors in the sequence

In automated welding installations the WC is processed by external control mechanisms
(e.g. robot controls). The duration and the starting time are thus dependent on the de-
mands made on the external processes.

[3] WC Period, minimum duration of WC signal in cycles or milliseconds (depending
on type of timer) with starting signal turned off.
Input range: 0 to 50 cycles (or 0 to 1,000 ms). If no start is pending, a WC pulse of
the set duration is given, starting at the point of output. If start is still pending the
WC remains as long as the start signal.

[4] WC Start Time
Normally, WC starts with the end of the hold time (HLD).
Negative values cause the beginning of the WC before the end of the HLD. The
earliest possible start time of the WC is after the first cycle (ms-WT: millisecond) of
the hold time (HLD).
Positive values activate the WC after the end of the hold time (HLD).

Start

1 2 3

Example: With Start deleted and with the operation modes Single, Repeat and
Seam, HLD=3 cycles, WC Period 3 cycles, WC start time 1cycle before HLD end.

WC period

+  value-  value

HLD = 3 cycles
WLD

t

t

Start

1 2 3

Example: with pending start and operation mode Single, WC start time 0 cycles
before HLD end.

WC period

+  value-  value

WLD

t

t

t

t

HLD = 3 cycles

4 5

In order to activate a proportional valve some timers have a pressure output.
[5] Operating mode pressure output, setting of signal (type-specific).

- 0 - 10 V
- 0 - 20 mA
- 4 - 20 mA

10
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10.4 Thyristor-Unit Setup

The timer must have the technical data of the thyristor unit used.

D Select Starting window - Operation - Modify - Programming - Basic-Setup - Thyri-
stor-Unit Setup.

�Stand-alone� module PSS 5000

[1]

[2]

[5]

[3]

[4]

Integrated modules PSI 6000/PST 6000

[6]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to timer.
- <New Sel> New Select corresponds to the Selection menu in Programming, see

chapter 12.
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Inputs and selections:

[1] Supply Volts, valid for PSS 5000, PSI 6000, PST 6000 (only for regulation mode
KUR)
Enter the nominal supply voltage of the welding transformer here.
The nominal supply voltage is used as a control parameter.

[2] Prim. Transf. Ratio (only for regulation mode KUR)
The KUR function employs a feedback transformer. Enter its nominal transformer
ratio here, e.g. 380V : 24V=15.833.
If your feedback transformer works at a lower or higher voltage rating enter the
nominal transformer ratio all the same.

[3] Thyr. Type, thyristor type, valid for PSS 5000
The selection of the thyristor unit type (AC, DC 2-phase, DC 3-phase, inverter) pro-
vides the timer with additional technical information.
For PSI and PST types there is no Info display.

[4] Thyr. Temp, thyristor temperature contact
Specify whether the contact of the thyristor unit is open (normally-closed contact,
off) or closed (normally-open contact, on) in the event of a fault.

[5] Ignition type
Setting up the type of drive power to the thyristor unit:

- Standard 5 kHz impulse chain (burst)

- CNOMO, predetermined impulse generation.

[6] Thyr. Type, thyristor type, (power unit type), valid for PSI/PST.
With the selection the timer receives further technical data.

10
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10.5 Weld Transformer Selection

For several functions of the thyristor units PSI/PST and the weld timer it is necessary to
select or enter the technical data of the welding transformer and the diodes in the secon-
dary circuit of the welding transformer.

NOTE

The Welding Transformer Selection will only be displayed if the integrated timer PSI is
selected.

D Select Starting window - Operation - Modify - Programming - Basic-Setup - Weld
Transformer Selection.

When using Bosch weld transformers (diode type and diode selection are known):

[1] [2]

[5] [8]
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When using other weld transformers:

[1] [2]

[6]

[3]

[5]

[4]

[7]

[8]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to timer.

- <New Sel> New Select corresponds to the Selection menu in Programming, see
chapter 12.

Inputs and selections:

[1] Transformer Type
Select the model of the used transformer (name plate). This and the number of
transformers lets the PSI recognize the maximum current of the welding installa-
tion.
The selection of another transformer (non-Bosch) requires further entries after
transmitting this setting to the timer.

[2] Number of Transformers
Enter the number of the used transformers (with parallel connection). 
This and the type of the transformer lets the PSI recognize the maximum current of
the welding installation.

[3] (Nominal) Transformer Ratio (only with setting Other Transformer)
For nominal transformer ratio of the weld transformer see name plate.
With primary current control, sensors are used that are incorporated in the primary
circuit. The transformer ratio of the transformer is necessary in order to convert the
primary current values into secondary current values.

10
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[4] Maximum Secondary current (only with setting Other Transformer)
Enter the maximum secondary current taken from the name plate of the trans-
former. The maximum welding current is limited to this value.

[5] Diode Supervision
Monitoring of secondary diodes (diodes in the secondary circuit of the weld trans-
former) is turned on or off.

CAUTION!

If diode monitoring is turned off the thyristor unit and the diodes can be destroyed. There
is no warranty for damage when diode monitoring is turned off.

[6] Diode Type (only with setting Other Transformer)
The type of the diode must be selected if diode monitoring is turned on and non-
Bosch transformers are used.

[7] Number of Diodes (only with setting Other Transformer)
Enter the number of diodes in parallel connection if diode monitoring is turned on
and non-Bosch transformers are used.

[8] Switch-Off Temperature
The maximum junction temperature of the diodes of 150 °C in relation to 30 °C wa-
ter temperature is displayed. The value refers to the specification of the selected
type of diode.

!
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Your notes:
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10.6 Global Stepper-Setup

- Behavior of the timer when end of stepper has been reached.

- Presetting the maximum number of allowable corrections for all electrodes that the
operator can make in the Operation window.

D Select Starting window - Operation - Modify - Programming - Basic-Setup - Global
Stepper-Setup

[1]

[3]

[4]

[2]

[5]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to timer.

- <New Sel> New Select corresponds to the Selection menu in Programming, see
chapter 12.
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Inputs and selections:

[1] Stop at end of stepper, when maximum electrode wear has been reached. 
Is effective if Stepper function is activated.

- ON
When the end of the stepper for the electrode in question has been reached
a new sequence with this electrode is not possible.

- OFF
When the end of the stepper for the electrode in question has been reached
further sequences with this electrode can be started.
With automated welding installations it might be wise to report reaching the
end of the stepper with a signal in order to continue welding and finish the
current  piece of work.

NOTE

Continuing welding with an electrode that has reached the stepper end can lead to quality
problems.

NOTE

Stop at end of stepper: The next start is not enabled before the electrode has been re-
placed and electrode replaced has been confirmed (reset counter). The acknowledge-
ment of the electrode replacement can also be done using the BOS-5000 software.

Correction settings allow the operator to make temporary adjustments of the parameters
[%I] and [pressure] without changing the basic setup.

The possible regulating range is given:

[2] maximum positive [%I correction]

[3] maximum negative [%I correction]

NOTE

If current monitoring is active the current monitoring value is adjusted automatically.

[4] maximum positive [pressure correction]

[5] maximum negative [pressure correction]

10
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10.7 Stepper Curves

Ten stepper curves can be defined for the stepper. The application of the curves is done in
the Stepper window.

The electrode wear compensation for [%I] and [pressure] is done according to the shape
of the curve of this menu item.

The application of a stepper curve should compensate changes (wear of the electrode)
and is closely connected to the electrode maintenance concept.

As a first approximation, the characteristics of the curve are similar to those of an e-func-
tion. But the actual curve is based on practical experience and depends on the electrodes
alloy and the welding task.

For  Stepper, see section 8.10.

D Select Starting window - Operation - Modify - Programming - Basic-Setup -
Stepper-Curves.

[1]
[2]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to timer.
- <New Sel> New Select corresponds to the Selection menu in Programming, see

chapter 12.
- <Curve +> next curve (current curve number +1).
- <Curve -> previous curve (current curve number -1).
- <->PC> transmits the curve data from the timer to the programming unit.

All parameters are stored in the timer. In order to avoid entering all stepper/tipdress
curves individually in each timer, you may transfer your stored curves from a timer
to the programming unit <->PC>. When you have selected the next timer, you can
transmit the curves from the programming unit to this timer.

- <PC->> transmits the curve data from the programming unit to the timer.
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Inputs:

The necessary (desired) %I change is to be entered as a percent change compared to
[basic current]. The count value describes the electrode wear [end of stepper].

Wear = 100% corresponds to [end of stepper].

For each curve the current (%I) changes for ten count values are entered. The following
count value always has to be equal to or higher than the previous one.
Falling %I changes in percent can also be entered.

The entries have immediate effect on the graphic course of the curve. Entries in the com-
ment field are optional.

[1] Current (%I ) changes in % (definition of the curve shape)

NOTE

The %I change of 100% refers to the change curve, not to the absolute start and end cur-
rent.

[2] Count values (electrode life) in % (definition of the curve shape)

Current

Counts (wear)

%

Tipdressing request

Electrodes have been dressed

Example:

Counter starting section 2.0
Counter stepper section 10.0
Count (wear) factor 1.0
Tipdressing request 1.0

9.0 9.0 9.02.0 2.0 2.0

last tipdressing before End of Stepper

Tipdress Curve

Stepper Curve

*1

*1

*1

*1

End of Stepper

10
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10.8 Tipdress Curves

The purpose of a Tipdress Curve is to compensate for changes of an electrode after
tipdressing through its participation in the Stepper. The application is done in the Stepper
window.

The shape of the curve is based on experience which depends on the electrode mainte-
nance concept. As a first approximation, a straight line can be assumed.

Ten Tipdress curves may be programmed.

For tipdressing, see section 8.10.

D Select Starting window - Operation - Modify - Programming - Basic-Setup  -
Tipdress curves.

[1]
[2]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to the timer.

- <New Sel> New Select corresponds to the Selection menu in Programming, see
chapter 12.

- <Curve +> next curve (current curve number +1).

- <Curve -> previous curve (current curve number -1).

- <->PC> transmits the curve data from the timer to the programming unit.
All parameters are stored in the timer. In order to avoid entering all stepper/tipdress
curves individually in each timer, you may transfer your stored curves from a timer
to the programming unit <->PC>. When you have selected the next timer, you can
transmit the curves from the programming unit to this timer.

- <PC->> transmits the curve data from the programming unit to the timer.
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Inputs:

The necessary (desired) %I change is to be entered as a percent change compared to
[basic current]. The count value describes the electrode wear [end of stepper].

[Wear] = 100% corresponds to [end of stepper] or the maximum wear in one
tipdressing interval.

For each curve the %I changes for ten count values are entered. The following count val-
ues always has to be equal to or higher than the previous one.
Falling %I changes in percent can also be entered.

The entries have immediate effect on the graphic course of the curve. Entries in the com-
ment field are optional.

[1] Current (%I) changes in % (definition of the curve shape)

NOTE

The %I change of 100% refers to the change curve, not to the absolute start and end
current.

[2] Count values (electrode life) in % (definition of the curve shape)

Current

Counts (wear)

%

Tipdressing request

Electrodes have been dressed

Max. no. of dressing operations

Example:

Counter starting section 2.0
Counter stepper section 10.0
Count (wear) factor 1.0
Tipdressing request 1.0

9.0 9.0 9.02.0 2.0 2.0

last tipdressing before End of Stepper

Tipdress Curve

Stepper Curve

*1

*1

*1

*1

End of Stepper

10
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10.9 Stepper-Setup

In this window controller specific values for each electrode are entered individually.

They depend on the weld transformer, the current sensor (toroid sensor), the welding
installation and, if applicable, on the thyristor unit. Some parameters can be determined
by Scaling. After that they must not be altered by other inputs.

D Select Starting window - Operation - Modify - Programming - Basic-Setup  -
Electrode (Stepper) Setup.

[1]

[2]

[3]

[8]

[10]

[10]

[4]

[5]

[6]

[7]

[9]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to the timer.

- <New Sel> New Select corresponds to the Selection menu in Programming, see
chapter 12.

- <Cal. Press.> selects pressure calibration with which the real characteristics of
the pressure output voltage in relation to the electrode pressure (kN) are deter-
mined, see section 10.11.

- <Scaling> selects scaling with which the real values of the current measurement
and control loop are determined, see section 10.12.
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Inputs:

Limit

[1] %I Limit. (%I Limitation)
The controller can reduce the phase angle (electrical degrees) to this value (in-
crease current) at the most. The input is made in scale values, separately for each
electrode.

[2] %I-Prew. (%I Prewarning)
When the controller reaches this value, the message %I Prewarning will be dis-
played (imminent limitation of phase angle).
The input is made in scale values (value < [1]).
In KSR and KUR regulation modes this function serves e.g. to detect cable losses
in the secondary circuit.

[3] 1. HC Limit (Limitation of First Halfcycle)
Limits activation (of the making current) of the first halfcycle of a weld schedule in
order to protect the transformer, the thyristor unit and the net, see section 8.16.
The input is made in scale values.

[4] Upper Curr. Limit (Upper Current Limit)
The purpose of this limit is to protect the devices in the welding installation. During
the later programming [reference current values] given in kA can be entered up to
this value. The timer includes correction values from the stepping table and the %I
correction. 
Example:
Upper current limit = 16.8 kA
Upper %I stepping = 120 %

The parameter kA in the window Welding-Parameters - Schedule cannot be
higher than 14.00 kA.

10
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[5] Toroid sensitivity
Bosch sensors have a working sensitivity of 150 mV/kA. If you use other sensors
enter their sensitivity here.

NOTE

The accuracy of your current feedback depends on this value. Use only calibrated preci-
sion sensors or use the current scaling feature.
The value input for the toroid sensitivity is changed by current scaling and must not be
changed afterwards by an input.

[6] Electrode range (Current measuring range)
A timer with an automatic measuring range setting will show the current range.
If the timer has not automatic measuring range setting, the electrode range must
be entered as a function of the toroid sensitivity.
The electrode range must correspond to the relevant working range of the current.

PSS 5000

PSI/PST 6000

*) Lower values are displayed with
undefined accuracy.
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Inverter

Enter two points for inverters that have a linear [1] current response curve:

[7] Current at 0 %I (scale values)

[8] Current at 50 %I (scale values)
- The timer will automatically calculate the inversion values.

kA

10,58

3

0 50 100 %I

[1]

Calculated by
the timer

(input)

(input)

NOTE

The values of the inverter�s characteristic are altered by current scaling and must not be
changed afterwards by an input.

Pressure

Determines the characteristic of the pressure output value for activating external pres-
sure regulating valves.
The transmission ratio of the pressure regulating valve, the pressure and the electrode
gun defines the resulting electrode pressure.

[9] Max Pressure
The timer�s pressure output is limited to this maximum value (mechanical safety
function). Calculation also considers Pressure Correction, Pressure Stepping and
Pressure Profile.

10
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[10] Conv.-Factor (Conversion factor in kN/Volt)
In order to program the pressure in kN it is necessary to enter the value. The timer
will output a voltage calculated with the conversion factor (not available for all
types).

kN

max. pres-
sure

10 Volts[2] conversion factor

[2]

NOTE

The value of the conversion factor input is changed by pressure calibration and must not
be changed afterwards by an input. 

[11] Zero adjust in kN/V (not available for all timer types)
The characteristic of the pressure regulating valve and the timer might have a zero
shift. This input adjusts the characteristic to the working zero of the pressure regu-
lating valve.

NOTE

The value of the zero adjust input is changed by pressure calibration and must not be
changed afterwards by an input.
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Your notes:

10
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10.10 Sequence Setup

- Basic setup for all programs

- Setup for a specific program

- Assigning the electrode to a program

D Select Starting window - Operation - Modify - Programming - Basic-Setup  -
Sequence-Setup.

[1]

[2]
[4]

[10]

[14]

[6]

[15]
[16]
[17]

[3]
[5]

[7]

[8]
[9]

[11]
[12]
[13]

NOTE

A selection of the objects of a window is shown, depending on the timer used and the
selected program functions.

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to the timer.

- <New Sel> New Select corresponds to the Selection menu in Programming, see
chapter 12.

- <Prog. +> next program (current program +1)

- <Prog. -> previous program (current program -1)

- <Act. Val.> Current actual values as a basis for setting the sequence parameters.
See volume 1, section 7.4.7.
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Inputs and selections:

[1] Timer and program selected for sequence setup.

For all programs:

[2] Start Inhibit (T): T = Timer related sequence inhibition.
- On

The sequences of all programs are inhibited, regardless of the program-
specific start (sequence) inhibition (P).

- Off
The sequences of all programs have been enabled. The program-specific
start (sequence) inhibition (P) may still act on a program sequence.

NOTE

When Start inhibition is active while program start is given, the message �Start Inhibited�
will be output.

[3] Control Stopped
- On

The actual values of the sensor are not processed anymore. Programs with
KSR/KUR control modes are welded with the last phase angle. An active
stepping function will be considered.

- Off
The welding current is controlled. Programs working in KSR/KUR control
modes require the actual value message from the sensor.

NOTE

In case of failure of the current sensor (in KSR/KUR mode) turning on Control Stopped
activates an emergency operation (depending on the type of the thyristor unit). 
Caution: There is no actual current control, check your welding spots.

[4] Weld/No Weld (T): : Activation signal Thyristor, T = timer related ignition
- On

Activation of the thyristor unit is enabled but still dependent on the external
Weld/No weld and/or on the program-related internal Weld/No weld (P).

- Off
Activation of the thyristor unit is disabled independently from the external
Weld/No weld (timer input) or the program-related internal Weld/No weld
(P).

NOTE

Program start with Weld/No weld internal (T) = Off initiates a sequence without welding
current, independent from the external weld/no weld setup or the internal weld/no
weld (P).

10
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[5] Monitoring stopped
- On

For the KSR/KUR regulating modes (see section 11.3) monitoring of the
actual current in the programmed tolerance band is turned off in all pro-
grams.

- Off
For the KSR/KUR regulating modes (see section 11.3) monitoring of the ac-
tual current in the programmed tolerance band is turned on. Monitoring is
now dependent on the programmed current and/or time monitoring of the
programs.

NOTE

In case of failure of the current sensor (in KSR/KUR mode) turning on Control Stopped
activates an emergency operation (depending on the type of the thyristor unit). 
Caution: There is no control of the actual current, check your welding spots.

[6] Max. Welding Time:
Specification of the maximum duration of the current pulse in the [1st weld time]
(1.WLD), [2nd weld time] (2.WLD) and [3rd weld time] (3.WLD) in [sequence] pro-
gramming. Later programming of the [welding times] is limited to this upper limiting
value.

[7] Max. Repeat Welds:
Welding of a welding spot below the tolerance band can be repeated only once.
When repeating its current values have to stay within the tolerance band, see sec-
tion 8.15.
Specification of the maximum admissible number of consecutive rewelds if the ac-
tual current value is within the conditional tolerance band.

- Input = 1
As current faults such as Current too low or similar are identified, the same
spot is repeated with a second program execution. If the current is now
within the tolerance band, the timer remains <Ready> for further se-
quences, no message is output. A message (Fault or Warning) will be is-
sued and the timer is switched to stopped condition if the current is not within
the tolerance band after the second sequence.

NOTE

Current monitoring must be switched on for the Repeat (Reweld) function.

- Input > 1
The input determines the maximum number of automatic repeats of spots
with the current value below the tolerance band. The sum of all repeats is
counted and compared to the entered value.
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 Example: maximum rewelds = 2

WLD100%

t
Current ok

Current OK
after repetition

Current OK
after repetition

Current too low

1st spot

1st spot with
repetition

2nd spot 3rd spot

1st spot with
repetition

4th spot

2nd spot with
repetition

5th spot

Current OK
after repetition The repeat function

was used two times
consecutively.

The timer stops with
the fault message
current too low.

Current measurement:

[8] Fade-out time
Input of this function is dependent on timer type.
For current measurement, the current rise time can be suppressed. The fade-out
time specifies the duration of time during which no measurement is performed in
the beginning of a current pulse, see page 10-39 or section 8.20.3.

[9] Trail current
Input of this function is dependent on timer type.
For current measurement, the trail current can be suppressed, see page 10-39 or
section 8.20.3.
- On : Trail current is incorporated into the measurement result.

- Off : Trail current is not incorporated into the measurement result.

[10] Measurement Circuit Test (Measurement Loop Check)
Checks the current sensor prior to each weld. Current monitoring needs to be en-
abled and monitoring stopped disabled. 
Input of this function is dependent on timer type.
- On : Measurement Circuit Test is active, sensor errors are detected.

- Off : Measurement Circuit Test is inactive, sensor errors are not
  detected.

NOTE

If measurement circuit test (loop check) is switched on and an error occurs, the message
�Circuit open� or �Secondary monitoring circuit is shorted� is displayed.

10
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Additionally for this program:

[11] Start Inhibit (P), P = program-specific start inhibit
- On

The sequences of all programs are inhibited, regardless of the timer-spe-
cific start inhibit (T).

- Off
The sequences of all programs have been enabled. The timer-specific start
inhibit (T) can still influence the program sequence.

Timer-specific Inhibit Program-specific Inhibit Schedule
(Sequence)

OFF
OFF
ON

OFF
ON

Invalid

Enabled
Inhibited
Inhibited

NOTE

When starting a program whose program-specific start inhibit is switched on, the mes-
sage �Weld Schedule Stopped� is displayed.

[12] Elec. No. (Electrode No.) 
- This parameter determines which electrode number the program should use.

Examples Progr. no.

Electr. no.

1  2  3  4

1
or

  1  2   3  4

1       2
or

 1  2  3  4
    

1  2  3  4

The maximum number of electrodes available is number 0 to 31 (depending on timer
type). Each electrode is assigned different parameters for describing the life and com-
pensation behavior of each electrode (electrode maintenance concept). 
In order to guarantee a selective reset it is not allowed to use the electrode number 0.

[13] Weld/No weld (P), P = program-specific weld/no weld
Activation of thyristor unit is enabled or disabled.

- On
Activation of the thyristor unit is enabled for the selected program but still
dependent on the external Weld/No weld and/or on the higher-level internal
Weld/No weld (T).

- Off
Activation of the thyristor unit is disabled independently from the external
Weld/No weld (timer input) or the higher-level internal Weld/No weld (T).

NOTE

Program start with internal Weld/No weld (P) = Off initiates a sequence without welding
current, independent of the external weld/no weld setting or the internal weld/no weld (T).
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Timer-specific
Weld/no weld (T)
setting internal

Program-specific
Weld/no weld (P)
setting internal

Weld/no weld
setting exter-

nal

Firing is:

ON
ON
ON
OFF

ON
OFF
ON

Invalid

ON
ON
OFF

Invalid

ON
OFF
OFF
OFF

[14] Schedule - Welding modes, see section 8.3

- Single spot (SINGLE), (for spot welding, projection welding, butt welding ...)
The start signal initiates a sequence and the <Weld Complete> is given at
the end of it. Afterwards, Start has to be turned off and then on again to initi-
ate another [sequence].

- Repeat (REPEAT), (for spot welding with manually operated devices)
The start signal initiates several sequences consecutively until the start sig-
nal is no longer present.
When Start is active, the solenoid valve will be switched off when the hold
time (HOLD) has elapsed, and the electrode gun is opened. Then, an off
time (OFF) will be initiated. During this time, the electrode gun can be posi-
tioned for the next spot. Then the solenoid valve will be activated again and
the electrode gun will be closed.
This sequence is repeated as long as Start is active. The repeat mode is
also suited for manual guns.

- Seam, (for seam welding)
The [1. weld time] is operated as programmed. The [2. weld time] is perfor-
med as long as the start signal is present. A running [2. weld time] is swit-
ched off synchronously (zero crossing) to the mains if the start signal is
cleared. After the end of the [weld time] the [hold time] (HLD) still runs out.

NOTE

Seal welds and stitch welds are to be distinguished.
Stitch welds:
When driving the roller electrode over the material that is to be welded the latter gets con-
nected by single welding spots. The time between the welding times of the two spots is
the cool time.
Seal welds:
With seal welds the cool time gets very short, down to 0 cycles. Thus, the spots are close
to each other or they even overlap.

10
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[15] Regulation, see page 11-10.
Determines the measuring method of regulation.

- Standard
The same regulation mode (PHA, KSR, KUR) is used for all [weld times] (1.
to 3. weld time).

- Mix
Each [weld time] ] (1. to 3. weld time) works with an individually selected reg-
ulation mode (PHA, KSR, KUR).

[16] Monitoring
Determines the measuring mode of current monitoring.

- Standard
The actual current values are monitored during the entire [weld] and [cool]
times, see also section 8.20.1 and 8.21.1.

- Mix
The actual current values of each [weld time] are monitored separately us-
ing individual reference values (without considering the cool times), see
section 8.20.2.

[17] Spot-Repeat, see section 8.15
With low current or no current the sequence is repeated if the function is enabled.
There is no connection with Series of welds below lower threshold point. The func-
tion works together with the parameter [7] �max repeat welds�.

- On
The function Spot-Repeat (spot repetition) is enabled for the selected pro-
gram. If the actual current values lie below the tolerance band the spot is
repeated.

- Off
The function Spot-Repeat (spot repetition) is disabled for the selected
program.
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10.11 Pressure calibration

NOTE

The availability of the pressure calibration function depends on the timer type used.

To ensure a uniform welding quality, a reproducible electrode pressure must be available.

A timer with a pressure output and calibration (scaling) function offers the possibility of
programming the required electrode pressure directly in kN.

Pressure calibration is used to achieve synchronicity between the command pressure
values of the timer and actual pressure values at the electrode gun (measured with a ref-
erence pressure gauge). The command value input in kN is adjusted to the display of an
external reference pressure measuring unit.

NOTE

A calibrated pressure gauge is required as reference pressure gauge for pressure
calibration.

Reference
pressure gauge

kN

Pressure transducer

Electrode gun with reference pressure gauge
10
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During pressure calibration, the command values of two working points are input for the
pressure regulation valve as % values. The actual pressure values resulting for the re-
spective working points are input to the timer via the operator interface. From these mea-
surements, the timer calculates factors for the desired synchronicity of command values
and actual values.

For pressure calibration, the electrode gun must be closed. The reference pressure
gauge is inserted between the electrodes.

Measurement must be performed without welding current (guaranteed if the pressure
calibration routine is used).

During calibration, the given pressure values are output as % values. The values mea-
sured during calibration with the reference pressure gauge are input at the programming
unit. The timer determines the adjustment factors during pressure calibration.

Pressure calibration must be performed for each electrode gun (electrode) connected to
the timer and when exchanging a component in the pressure circuit. To do so, the secon-
dary circuit of the timer that is calibrated must be closed (without material).

NOTE

Value settings during pressure calibration: Pressure values in % should possibly be
adjusted so as to ensure that calibration is performed with the lowest and highest
pressure required for the welding task.
Please make sure that the electrode pressure is stable during measurement and can be
displayed by the reference pressure gauge.

NOTE

The value of the conversion factor input is changed by pressure calibration and must not
be changed afterwards by an input.

NOTE

The value of the zero adjust input is changed by pressure calibration and must not be
changed afterwards by an input.
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10.11.1 Pressure calibration - Operation

CAUTION!

Make sure that there are no persons in the direct vicinity of the electrode gun. 
Only input calibration values which the electrode gun can support mechanically,
otherwise, there is danger of personal injury and/or damage to the machine.
If you do not know the behavior of the electrode gun, use low values in the
beginning of calibration and increase these values until the working pressure is
reached in additional calibration sequences.

D Select the command button Scaling in the plant layout or select Operation - Modify
 - Scaling.

D Select the timer and the program.

D Select Pressure Scaling.

The Calibrate Pressure window is displayed. The values 30% and 60% of the maximum
pressure are displayed as default values. These values can be changed, however, they
should correspond to the minimum and maximum working pressure. Now connect the
reference pressure gauge and close the electrodes.

NOTE

In order to perform Pressure Calibration a program must have been selected. This will
trigger the pressure output with the base pressure (Programming - Welding-Parameters
- Pressure) immediately.

Store values:

Store the input values for later scaling tasks.

!

10
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Command buttons:

First measurement

D Select the command button <OK>. The pressure regulating valve is triggered with
the entered upper scaling value (percentage of the basic pressure value). Now the
electrode gun is to be closed with the on-off valve.

The window for entering the measured value is displayed at the same time as the begin-
ning of the first measurement.

D Read the actual pressure value from the measuring instrument.

D Enter the first measured value in the upper input field.

D Reopen the electrode gun.

Second measurement

D Select the command button <OK>. The proportional valve is triggered with the en-
tered lower scaling value (percentage of the basic pressure value) and the elec-
trode gun is pressed together.

D Read the actual pressure value from the measuring instrument.

D Enter the second measured value in the lower input field.

D Select the command button <OK>.

On the basis of the inputs, the timer calculates the conversion factor and the zero shift.
Then the message Scaling done ... will appear.

<kN Display>
After the successful pressure calibration the pressure values given in [kN] can be set as
default parameters. They are displayed in the unit [kN]. With the menu <kN Display> this
function can be turned on and/or off.
If you modify the welding installation in such way that the scaling values are not exact
anymore, you can deactivate the display <kN Display>.
The output value for the pressure regulation valve is still dependent on the zero shift and
the factor kN/V.



Basic SetupBOS-5000

10-371070 078 218-104 (99.09) GB

10.12 Current Scaling

Reproducible preselectable current values are required to ensure a uniform welding
quality in connection with current measurement, current monitoring and current regula-
tion. The entire measuring and control loop consists of individual components with differ-
ent tolerances. The sum of these individual tolerances may result in current deviations.
To avoid the accompanying differences in quality, current scaling should be performed.

The timer offers the opportunity of programming welding currents directly in kA and of
displaying the actual currents as kA values. In practice, there may be a difference be-
tween commanded and actual current values, as well as between the current displayed
on the programming unit and measured with welding current meters. To attain synchron-
icity between the actual value determined by the timer and the actual value displayed on a
reference welding current meter, current scaling should be performed.

With the help of current scaling, the entire measuring and control loop is adjusted to the
display of an external reference welding current meter.

In addition to current feedback for the measuring and control loop, a reference welding
current meter with an appropriate current sensor must be installed in the welding circuit
for performing the scaling procedure.

Electrode gun with reference welding current meter

Reference
welding current

meter

kA
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During current scaling, the current values of two working points are simultaneously deter-
mined via the current measurement input of the timer and the reference welding current
meter. The selected working points should be in the actual working range of the welding
equipment.

NOTE

A calibrated meter is needed as reference welding current meter for current scaling.

kA
Reference

welding current
meter

Current feedback

Measuring and control loop
Timer

Welding current circuit with Reference welding current meter

Thyristor unit

Scaling must be performed for every gun (electrode) connected to the timer. For this pur-
pose, the secondary circuit of the welding equipment to be scaled must be closed (with-
out material, i.e. short-circuited).

Irrespective of the programmed mode, the timer uses the PHA mode with the specified %I
values from the scaling window for current scaling. The 2nd weld time (2.WLD, one pulse)
programmed in the selected welding program is used as weld time.
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During the scaling process, the programmed fade-out time and the trail current are ac-
counted for. The settings of the reference welding current meter must be identical.

Measurement curve in the timer and in the reference welding current meter

t

I kA

t

Timer

Reference welding
current meter

fade-out

time

trail 
current

I kA

The values measured by the reference welding current meter during current scaling must
be entered at the programming unit.

The timer determines conversion factors based on current scaling. When the welding se-
quence is repeated and the corresponding measured values of the reference welding
current meter are input, the conversion factors will be averaged. Thus, the danger of
reading inaccuracies is reduced.

NOTE

Current scaling alters the toroid sensitivity. Afterwards the toroid sensitivity must not be
altered by another input.

10
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10.12.1 Current scaling - Operation

CAUTION!

Make sure that the electrode gun is properly closed. Otherwise, there is danger of
welding splashes!

WARNING!

During scaling, the welding schedule is performed with special scaling parameters.

NOTE

Settings for current scaling: In order to obtain identical settings for all systems, we
recommend writing a special welding program for current scaling in all timers.
The following values are to be selected in such a way that their conversion in the timer can
be done without danger.

Recommendation:
2.WLD: select 10 to 15 cycles. This duration will ensure proper averaging and low
dependence on transient recovery processes.

Up/Down slope:
Do not activate up/down slope and specify the most constant conditions possible in order
to achieve low dependence on transient recovery processes.

Current values:
should be set so that the same measuring range can be set at the reference welding
current meter for both working points during the scaling process.
This helps to avoid sudden changes in the current value measurement.

The fade-out times of the timer and the reference welding current meter must be identical.
Fade-out time = 2 cycles or 40 ms.
Switch trail current measurement off.

Toroid: 
Place measuring belt in defined position and note correct position of sensor ends when
using  velcro fasteners. Properly close the lock of the measuring belt. Make sure that the
lock is outside the secondary window.

!

!
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D Select the command button Scaling in the plant layout or select the menu items
Operation - Modify - Scaling.

D Select the timer and the program.

D Select Scaling (Current Scaling).

The Scaling window will be displayed. The values 50 SKV (scale values) and 30 SKV are
shown as default values. These values can be changed, however, they should corre-
spond to the upper and lower limit of the current range. Close the electrode gun without
sheets to be welded.

[1]
[2]

Store values:

Store the entered values for later scalings.

D Select the command button <OK> and the window Scaling will be displayed.

NOTE

With Weld/No weld turned on and after activating the command button <Start Wld>  in
the Scaling window current starts to flow. 
Comply with the safety instructions.

CAUTION!

Prior to entering a current value, a sequence must be performed. The sequence can be
started externally or by pressing the command button <Start Wld>.

!

10
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First Measurement

D Select the command button <Start Wld>. Measurement of the first working point is
performed with the entered scaling values [1].

D Read the actual current value from the reference welding current meter.

D Enter the measured value in the upper input field.

D The command button <Enter> takes over the entered measured value.

This procedure can be repeated several times for calculating average values by reselect-
ing <Start Wld> and <Enter>.

D Select the <Continue> command button.

The following actions refer to the second measurement:

Second measurement

D Select the command button <Start Wld>. Measurement of the second working
point is performed with the entered scaling values [2].

D Read the actual current value from the reference welding current meter.

D Enter the measured value in the lower input field.

D The command button <Enter> takes over the entered measured value.

This procedure can be repeated several times for calculation average values by reselect-
ing <Start Wld> and <Enter>.

The following figure shows two measurements with value input for the first measuring
point. The second measuring point is also determined by two measurements, but the sec-
ond input still has to be saved by selecting the <Enter> command button.
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[1]

[1] Display showing the number of measurements and mean value calculation inputs.

The timer will now determine the toroid sensitivity, toroid correction (turns ratio), current
at 0 SKV and current at 50 SKV.

Result of current scaling

Current scaling takes effect on the following input in the window:

- toroid sensitivity [1]

[1]

NOTE

Subsequent changes done by direct inputs for the toroid sensitivity alter the values
calculated through current scaling.

10
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Your notes:
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11 Welding parameters

By entering the welding parameters, you assign the timer the specific functions of your
welding task. The parameters for the Schedule (Sequence) are programmed. For com-
pensating the electrode wear stepper programming is available. The monitoring function
serves as quality assurance.

- Parameters used in the welding Schedule (Sequence), such as [Squeeze Times],
[Weld Times], [Cool Times] and [Hold Times] and regulation modes

- Stepper Curves for [Current] and [Pressure]

- Monitoring of Weld Current, [Weld Time] with tolerances

- Specification of Base Pressure value and Pressure profile

- Freely Programmable Outputs for the different phases of the Schedule
(Sequence).

Starting Window

...

Help

Timer-Reference Spot-Reference Operation

File Services Modify Diagnostics

Programming F9

SelectionBasic-Setup

Stepper

Current-Monitoring

Time-Monitoring

Monitor-Stepper

Pressure

Services

Freely Programmable Outputs

Schedule (Sequence)

Pressure-Stepper

Welding-Parameters

NOTE

For some timers programming of certain welding parameters is not possible. These pa-
rameters are timer-specific.

11
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Operation of Welding-Parameters

When clicking on Programming  the windows Timer-Select and Program-Selection are
opened. If no timer or spot has been selected, an appropriate dialog will be opened.

NOTE

Before you can program welding parameters, you must select a Timer or a Spot.
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Your notes:
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11.1 Schedule (Sequence)

A Schedule flowchart is a diagram, which displays the welding process as a function over
time as the x axis. This time axis is thereby subdivided into different segments, see secti-
on 8.9.

They determine the weld and cool times of your Schedule(s) (Sequence(s)).

Schematic welding process over time (Flowchart)

t1.SQZ  SQZ 1. WLD 1. CT

2. WLD

( UST) (DST) 3. CT 3. WLD  HLD  OFF
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11.1.1 Basic-Setup affecting the Schedule

In the Basic-Setup menu, parameters which have a direct influence on the welding
Schedule can be specified for all programs or for a single program only.

Basic-Setup:

D Select Starting Window - Operation - Modify - Programming (Quick Program-
ming) - Basic-Setup - Electrode Setup (Stepper-Setup) / Sequence-Setup

Example: The Basic-Setup of the start inhibition is �On� for all programs or for the se-
lected program, which means that any Schedule (sequence) is inhibited. If a schedule
(sequence) is to be tested after programming of the welding parameters, then the timer
specific and program specific inhibit state must be turned to OFF in the Basic- Setup. 

Program 1

Program 2

Program 3

Program 4

Off

Off

On

On

Start Inhibit affecting all Programs:

= released

= inhibited

= released

= inhibited

Start Inhibit Programs

O

F

F

Program sequence is:

Program 1

Program 2

Program 3

Program 4

Off

Off

On

On

Start Inhibit effecting all Programs:

= inhibited

= inhibited

= inhibited

= inhibited

Program sequence is:
Start Inhibit Programs

O

N
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11.1.2 Interface Signals which Interact with Schedule

The following input and output signals affect the Schedule in the welding process:

[1]

[1]

[2]

[2]

Timer

Input signals Output signals

Weld/No Weld, external

Program selection

Parity

Start

Solenoid

Monitor contact

WI inquiry

WI release

External end of weld time

Control ready

Weld

Without monitoring

WC contact

Warning

Welding fault

Freely prog. outputs

Weld/No weld

Weld

This example corresponds to a timer with discrete I/O-Signals. There are timers with a
limited and/or extended I/O-area.
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[1] After issuing the signal <Solenoid>, the program waits for the answer with the
signal <Monitor contact>.

- Monitor contact: Gun is closed or/and
- Pressure is up or/and
- other monitoring

[2] After issuing the signal <WI Inquiry> (Welder Interlock), the program waits for a
response with the signal <WI release>.

11
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11.1.3 Starting Schedule (Sequence)

D Select Starting Window - Operation - Modify - Programming - Welding-Parame-
ters - Schedule (Sequence).

[1][2]

[3]

[4]

[5]

[6]
[7]

Command buttons:

- <OK> 
transmits data to the timer or cancels transmission, closes the window.

- <Dat. -> WT> transmits data to the timer.

- <New Sel> corresponds to the Selection menu in Programming, see chapter 12.

- <Prog +> next program (current program number +1).

- <Prog -> previous program (current program number -1).

- <Act.Val.> see section  7.4.7.
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Inputs, selections and displays

The Basic-Setup settings initiate or limit the input range of some of the data and inputs
displayed in the Schedule (Sequence) window (e.g. the Standard regulation mode in the
Basic-Setup has the effect that only one regulation mode can be selected for all weld
times in Schedule (Sequence)).

Programming of the fixed displays in the Schedule (Sequence) window is made in:

Schedule (Sequence):

D Starting Window - Operation - Modify - Programming (Quick Programming) - Ba-
sic-Setup - Sequence-Setup

%I-Corr. (E), %I-Corr. (P), [%I-Correction] (Electrode), [%I-Correction] (program):

D Starting Window - Operation - Modify - Correction

Control Stopped:

D Starting Window - Operation - Modify - Programming  - Basic-Setup -  Sequence-
Setup

Monitoring:

D Starting Window - Operation - Modify - Programming (Quick Programming) - Ba-
sic-Setup - Sequence-Setup 

D Starting Window - Operation - Modify - Programming (Quick Programming) -
Welding-Parameters - Current Monitoring - Time Monitoring

%I Step.-Value, Stepper value:

D Starting Window - Operation - Modify - Programming (Quick Programming) -
Welding-Parameters - Stepper

[1] 1. HC a. PAUSE [1. Half-Cycle after Cool Time]], see section 8.16.
The default value is 55 scale values (%I). During the Schedule (Sequence) the current of
the 1. half-cycle after cool time is limited to this programmed value.

11
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[2] Slope, see section 8.7

ON:
Starting with the [UST] the generated [current] will be gradually increased from a [starting
current] to the [commanded current] of the [2nd Current Block] or the [2.WLD]. Starting
with the Down Slope Time [DST] the generated [current] again will be gradually de-
creased to the [final current] at the end of [DST].

The number of line cycles or milliseconds for the [UST] and [DST] and the current values
for these times can only be entered, if Slope is enabled.

OFF: 
The generated [current] rises at the beginning of the [2.WLD] immediately to the pro-
grammed [current] value and drops at the end of the [2.WLD] abruptly to Zero.

[3] Reg.-Mode: Regulation Mode
Regulation principles of the timer:

- Phase angle control PHA, see section 8.17

- PHA function without regulation without monitoring. This operation is pos-
sible without toroid.

- PHA function without regulation with monitoring. A toroid is needed in the
current circuit.

- Constant-current regulation KSR (current regulation), see section 8.18

- KSR function with regulation without monitoring.
Even though regulation takes place during welding the timer remains opera-
tive when currents are non-conforming.

- KSR function with regulation with monitoring.
For robot electrode guns (and many other applications) this should be the
default setting. 
Fault messages might occur, e.g. �low current�. If the current is too low an
automatic spot repetition can be enabled.

- KSR function without regulation without monitoring.
This is an �emergency operation mode� in case of disturbances in the toroid
circuit. In this case always check your welding spots.

- Constant-voltage regulation KUR, see section 8.19

- KUR without monitoring.
With KUR the voltage regulation is always active, but the current is not moni-
tored.

- KUR with monitoring.
The current in the welding circuit is monitored with regard to a tolerance
band.
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In the Standard regulation mode, one regulation mode applies to all [weld times] within a
sequence. The Mixed regulation mode provides for individual settings of the regulation
mode for each [weld time] of the schedule (sequence). 

Regulation mode:

D Starting Window - Operation - Modify - Programming (Quick Programming) - Ba-
sic-Setup - Sequence-Setup

NOTE

If an inverter is used, the PHA regulation mode must be activated prior to current scaling.
Once current scaling has been completed, the KSR regulation mode may be selected.

The regulation is completely separate from monitoring. The correlation of the values to
the functions is shown in the following overview:

Regulation Monitoring

Regulation Modes
 PHA, KSR, KUR

Monitoring ON, OFF

Standard, Mixed regulation Standard, Mixed Monitoring

Command value %I, kA Reference current kA

Control stopped ON, OFF Monitoring stopped ON, OFF

Stepper curve % Stepper curve %

Tolerance band %

NOTE

The regulation function works separately from monitoring. It is possible to monitor without
regulation, or to regulate without monitoring.

11
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The separation of Regulation and Monitoring provides the following advantages:

- Entering separate values. When entering the commanded values, the indepen-
dent value in monitoring helps to detect entry errors, by means of a fault message
at the next Schedule (Sequence) run (and vice versa).

- With password entry, it is possible to assign the entry of commanded values and
the entry of monitor values to different user groups. This compensates for any cor-
ruption from false external parameters by the operating personnel. The monitor
values and thereby the range of good welds results can not be changed by this
user group.

- Separation increases transparency. It allows for example for combinations be-
tween the regulation mode KUR and Current Monitoring.

Because of this separation, the following additional parameters must be entered under
Basic-Setup.

- Monitoring ON / OFF

- monitored Stepper curve

- Reference current

With the reference current it is possible to accept the actual measured value as the new
reference current, see section 11.3.

[4]  %I (Scale Units)
The firing angle range in the current half wave is divided up into Scale Units. The firing
angle and thereby the [current] can be controlled by programming a %I value.

Input of %I: Regulation modes PHA or KUR must have been selected and transmitted to
the timer.

[5] kA: Kilo Amperes
The current entry for the measuring unit Kilo Ampere (kA) is intended for KSR control
mode.

Upper current limit:
Starting Window - Operation - Modify - Programming - Basic-Setup - Stepper-Setup .

If the stepper is active the stepper portion is subtracted from the maximum input value.
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[6] 1.SQZ, SQZ, 1. WLD, 1. CT, UST, 2. WLD, DST, 2. CT, 3. CT, 3. WLD, HLD, OFF,
see section 8.9

The unit of measurement for the various programming entries which control time, is the
line cycle or milliseconds (ms control). To determine the time, enter the number of line
cycles or milliseconds. The entry range is displayed in the bottom window line.

Programming of the [2.CT] is only possible if the [number of pulses] in the last entry field is
larger than 1, which indicates current output in a pulsed manner.

[7] Impulse, see section 8.8
This parameter is used for the entry of the number of [impulses] for the [2nd Current
Block], in case of pulsed current output, with enabled slope including [UST] and [DST].

11
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Your notes:
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11.2 Stepper

The [%I] (current or phase angle, pressure) is adjusted to compensate for wear of the
welding electrodes depending on the counts (wear). Starting with a certain initial output
power, the [%I] will be changed for Start, Stepper and Tip Dressing, following a predeter-
mined curve form, see section 8.10.

The compensation for Start, Stepper and Tip Dressing can be activated independently
from each other.

Regardless from the type of stepper function, a <Prewarning> can be programmed. The
<Prewarning> is a message before the <End of stepper value>.

The active Stepper function works with linear interpolation. Depending on the wear
counter (count value), the compensation value will be calculated individually for each
spot from the next coordinate point.

- All settings for electrode maintenance are located in this window.

- Counts (wear) factor (Count value) can be entered for each program.

- Application of a selection from ten stepper curves and ten tipdress curves for the
stepper.

0.8 1.0 2.0

Counts (wear) for different welding tasks

Commanded cur-
rent value

Correction Thyristor unit (current)
+ =

Stepper
+

Effect of the stepper with other parameters
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11.2.1 Basic-Setup which Affects the Stepper Function

In the Basic-Setup menu you may program 10 different curves for the Stepper function.

Stepper-Curves:

- Starting window - Operation - Modify - Programming (Quick Programming) -
Basic-Setup - Stepper-Curves

11.2.2 Interface Signals which Interact with Stepper

The following input and output signals affect the stepper function in the welding process:

Timer

[1]

[1]

[3]

[3]

[2]

Tipdressing necessary

Input signals Output signals

Electrodes have been dressed

Tip Dress request

Prewarning

Electrodes have been replaced

End of stepper

[1] With active dress function, the <Tip Dress Request> (color change in the timer
symbol of the plant layout) is generated after reaching the programmed wear. After
the dressing of the electrodes the signal <Electrodes have been dressed> is ex-
pected.
If there is no <Electrodes have been dressed> signal until the end of stepper the
timer sends the message Tipdressing necessary. Further [sequences] are not
possible.

[2] The <Prewarning> determines the amount of wear before reaching the End of
Stepper (maximum wear), at which point the warning signal <Prewarning> (color
change in the timer symbol of the plant layout) is issued.
With some timer types, different wear values (counts) may be entered for the <Tip
Dress Request> and the <Prewarning>.
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[3] The signal <End of stepper> commands a change of electrodes. The executed
change is reported to the weld timer with the signal <Electrodes have been re-
placed>.
The response of the timer is set to <End of stepper>:
Starting window - Operation - Modify - Programming - Basic-Setup - Global Step-
per-Setup
Depending on the settings, further [sequences] are possible / are not possible at
the <End of stepper>.

Current

Counts (wear)

%

Prewarning

Stop at
End of Stepper

Electrodes have 
been replaced

No. of dressing operations

Example :
Counter starting section 2.0
Counter stepper section 10.0
Count (wear) factor 1.0
Prewarning 1.0

9.0
10.0

Prewarning

Counts (wear)
9.0 10.0

Electrodes have been replaced

Example: Sequence without reset �Electrodes have been replaced�
and w/o stop at End of Stepper

no sequence stop

End of Stepper

Tipdress Curve

*1 Stepper Curves

*1

*1

*1

End of Stepper
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A special case is dressing without stepper with short tip dressing intervals. In this way the
[current] is changed with each tip dressing event, but not within the tip dressing interval. A
Stepper of 100% at the end of the stepper section must be entered in this case.

Current

Counts (wear)

End of stepper

100

%

130

115

Principle of current stepping and Tip Dressing without Stepper

Parameters :

2nd Tip Dress request1st Tip Dress request
30 60 90 Spots

100 % Final value of current stepping in stepper section

130 % Final value of current stepping in tip dress section

0.0 Counts (wear) start section

30.0 Counts (wear) stepper section

0.0 Counts (wear) prewarning

1.0 Counts (wear) factor

2 Dressings
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11.2.3 Starting Stepper

D Select Starting window - Operation - Modify - Programming - Welding-Parameters
- Stepper.

[1]

[2] [3] [4] [5]
[6]

[7]

[8]

[9] [10] [11] [12]

[13]
[14]

[15] [16] [17]

[6a]

[6b]

[6c]

NOTE

The structure of the window (input fields) depends on the timer type in use.

Command buttons:

- <OK> transmits data to the timer or cancels the transmission, closes the window.
- <Dat. -> WT> transmits data to the timer.
- <New Sel> corresponds to the Selection menu, see section 12.
- <Prog +> next program (current program number +1).
- <Prog -> previous program (current program number -1).
- <Curr.value> The Stepper percent values are converted into absolute current va-

lues and displayed. The inputs for the Stepper in percent and the Current values
can be changed, see section 11.2.4.

NOTE

The current values display can only be called up if KSR mode has been preselected.

- <Act.Val.> see section 7.4.7.
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NOTE

Curve sections displayed in blue color have no effect on the stepping process.
Possible reasons:

- Stepping is disabled.

- No wear has been programmed for these sections.

- Stepping = 100% has been programmed for the stepper section.

- The tip dressing function is disabled.

- No wear value has been programmed for the prewarning.

If the curve section for the start section is shown in blue color ([6c] e.g. wear start section
input value = 0), the Stepper function works without a percent change for this section.

A green curve display for the start section ([9] wear start section input value > 0.0)
indicates active Stepper for this section. Stepper is performed with the programmed
stepping values in percent, depending on the electrode�s wear counter.

A blue curve section in the stepper section ([6a], e.g. Stepper input value = 100%)
indicates that stepping is performed without a percent change in this section.
 
The green curve display ([6a], e.g. Stepper input value � 100%) in the stepper section
indicates that Stepper is performed with the programmed percent stepper values
depending on the electrode�s wear counter and the stepper curve selected for this
section.

A blue curve section for the tip dressing section ([16], e.g. Dressings = 0) means that
stepping is performed in this section without a percent change. The tip dressing function
is not active.
 
The green curve display ([16], e.g. Dressings � 0) in the tip dressing section indicates
that Stepper is active with the programmed stepper values in percent, depending on the
number of dressings and the selected tip dressing curve.

If the curve section for the prewarning section is displayed in blue color ([12], e.g. wear
prewarning input value = 0.0), no <Prewarning> signal is output.

If the curve section for the prewarning section is displayed yellow/red ([12], e.g. wear
prewarning input value >0.0), the <Prewarning> signal is output.
The stepper values can be changed in the Current values window. 
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Inputs and displays:

The diagram in the Stepper window shows a schematic representation of the curve
shape.

The curve shape of the Stepper function is programmed in the Stepper-Curves or Tip-
dress curves window of the Basic-Setup.

Stepper and Tipdress Curves:

D Starting window - Operation - Modify - Programming - Basic-Setup - Stepper-
Curves - Tipdress-Curves.

[1] Stepper On/Off
The stepper function is turned on or off. If the stepper function is active, the Pressure-
Stepper function becomes active, too.

[2] Start
The Start section precedes the stepper section for starting up a new electrode. This sec-
tion as a rule is very small, it includes between 5 to 50 spot welds and is only required in
special cases (galvanized sheet metal).
It can work with its own stepping value.

NOTE

A wear [9] of 0.0 must be entered for this section if the Start section in the Stepper function
is to be skipped.

[3] Stepper
The Stepper section defines the Stepping without electrode tip dressing. Beginning with
the [base current], the [current] will be changed, according to the programmed curve form
to compensate for electrode wear.
It can work with its own stepping value.

NOTE

A percent value for current stepper [6a] = 100% must be entered for this section if a con-
stant current is to be applied in the stepper section.

[4] Tip Dressing
A mechanical treatment of the welding electrodes by dressing or polishing helps to re-
duce wear and delays the end of stepper. The [current] is being reduced after tip dressing.
The new reduced [current] value represents the starting point of the new stepper curve for
the tip dressing curve which is programmed by parameter [6b]. 
It can work with its own stepping value.
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NOTE

A number of Dressings = 0 must be entered for this section if the tip dress section is to be
skipped.

[5] Prewarning, see section 8.10

NOTE

A count (wear value) = 0.0 must be entered for this section if the prewarning section is to
be skipped.

Counts (wear)

%
*1 *1 *1

*1 Counts (wear) Tip Dress request, prewarning

End of stepper

PrewarningTip Dress requestTip Dress request

last cycle

Electrodes have
been dressed

Electrodes have
been dressed

Current

Example: two dressings and prewarning

*2

*2

*2 *2 
Stepper
curves

Tipdress Curve

With the tip dressing function active (Dressings > 0), specifying a wear prewarning serves
with some timer types also to output the signal <Tip Dress Request>. Which means that
for each tip dressing cycle, along with wear prewarning, the signal <Tip Dress Request>
will be output.
With some timer types, different wear values (counts) may be entered for the <Tip Dress
Request> and the <Prewarning>.
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[6] Current
A change in Stepper is entered as a percent value, and as such it is independent from the
absolute [base current] in the welding program. The Stepper percent value may remain
unchanged after a change of the [base current] in the welding program.

All entries relate to a [base value] (100%) at the end of the Start section, i.e. the beginning
of the Stepper working section.

Three entry fields are available for programming the Stepper current:

- [6a] The value entered in the top entry field determines the Stepper in percent at
the end of the stepper section.

- [6b] The value entered in the middle entry field determines the Stepper in percent
at the end of the tip dress section.

- [6c] The value entered in the bottom entry field determines the Stepper in percent
for the start with a new electrode.

NOTE

A percent value for Stepper = 100% must be entered for this section if the Stepper section
is to be skipped in the Stepper function.

[7] Step.-Cv. (Stepper Curve)
You can program 10 different stepper curves. The stepper curve determines the current
slope within one stepper cycle in the Stepper section for the Stepper and the Pressure-
Stepper functions. The curve characteristics are defined in:

Stepper-Curves:

D Starting window - Operation - Modify - Programming - Basic-Setup - Stepper-
Curves

[8] Dress.-Cv. (Tipdress Curve)
You can program 10 different Tipdress curves. The Tipdress curve determines the cur-
rent slope within the entire tipdress section and applies from the first to the last stepper
cycle. The curve characteristics are defined in:

Tipdress-Curves:

D Starting window - Operation - Modify - Programming - Basic-Setup - Tipdress-
Curves
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[9] Start Counts (Wear),  see section 8.11
The electrode is subject to wear with each spot weld. The wear for the Start section is
programmed under the X axis of the Stepper. It is a component of the wear for the Stepper
section.

Computing wear:

Wear =    (Spot weld   x   Wear factor)

NOTE

The count value = 0.0 (wear) must be entered if the start section is to be skipped in the
Stepper function.

[10] Stepper Counts
The maximum admissible wear until the end of stepper or tip dressing is programmed.
 

[11] Tipdress Counts
The Tipdress counts value determines the counts that initiate output of the <Tip Dress
Request> (cf. Interface signals affecting Stepper section). For some timer types, no se-
parate counts can be programmed, the prewarning counts are used for outputting the
<Tip Dress Request>.

NOTE

The count value = 0.0 (wear) must be entered if no Tip Dress Request is to be output.

[12] Counts Prewarning
The Counts prewarning value serves to determine the amount of wear which initiates the
output of a <Prewarning> before the end of stepper (maximum wear).

NOTE

The count value = 0.0 (wear) must be entered if no prewarning is to be output.

[13] Count-Factor
The Count-Factor applies to the displayed stepper and represents the wear resulting
from welding a spot of a specified welding task.

Example: see section 8.11.
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[14] Wear/comp
Specification of counts (wear) per part (input not available for all timer types). This param-
eter indicates the amount of wear units produced on the electrode by each part. With this
input the number of remaining parts in the prewarning table is calculated, see volume 1,
section 7.6.1.

[15] Counts
The current electrode count (wear) is displayed.

NOTE

The actual value of Counts (wear) can be input in the Actual values window. Thus, a used
but not yet totally worn electrode may be used, see volume 1, section 7.4.7.

[16] Dressings max.
This input field serves to enter the maximum admissible number of dressings
(input � 1: activate tip dressing function) up to the end of stepper.

NOTE

A value of Dressings = 0 must be input if the tip dressing function is to be skipped.

[17] Dressings Act.
The number of completed dressings will be displayed.

NOTE

The actual value of Dressings can be input with Act.Val. - Set counter. Thus, an electrode
that has already been tip-dressed can be used again, see volume 1, section 7.4.7.

11
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11.2.4 Current values

The percent Stepper values are converted into current values and vice versa. The actual
currents are displayed in kA.

NOTE

The Current value window is only available for selection if KSR mode is active.

[2] [2] [2]

[3] [3] [3]

[1]

[4] [4] [4]

Command buttons:

D <OK> 
Transmits data to the timer or cancels the transmission, closes the window.

Column [1] shows the percent values from the Stepper window sections [6] ([6a], [6b],
[6c]). From these values and the [base currents] [3], the resulting currents are calculated
and displayed in columns [2]. If a percent value [1] or an absolute value [2] is changed,
the related other value is re-calculated.

Inputs and displays:

[1] Percent Stepper. The values in the framed fields may be changed.

- 1.Stepper-Phase:
Final Stepper value in the Stepper section.

- last Dressing:
Final Stepper value in the tipdress section.

- new Electrode:
Initial Stepper value with new electrode.

[2] Calculated command current on the basis of the Stepper and the [base currents].

[3] Programmed current values in kA.

[4] Measured actual current values in kA.
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Example electrode maintenance

Without start section, but with tipdressing and with prewarning, tipdress curve 2 is linear.

2. 3. 29. 30.

115

Tip dress request O
dressed I

10
Prewarning

320
Counts (wear)

1st tip dressing

Prewarning

End of stepper

30. Counts (wear)29.2. 3.1.

Current

110

115

100

with Stepper

2Stepper curve

Counts (wear)

Counts (wear)

Current

Current
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Your notes:
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11.3 Current Monitoring

- Current monitoring and regulation are separate functions.

Current monitoring checks the actual current, which flows during the welding process and
compares the feedback value against programmed reference values and upper and
lower tolerances. The current thus measured can also be accepted as a new base refer-
ence current for the monitoring process.

Any deviation above the tolerance band is reported. The response of the timer is output
as <Welding fault> or <Warning> on the programming unit.
If the measured values are lower than the conditional tolerance band a counter can be
incremented, compared and then a spot repeat can be performed. 
The timer�s response to current values in the conditional tolerance band can be pro-
grammed with an adjustable counter.

Current Monitoring must be viewed together with Weld Time Monitoring. Both quantities,
current and weld time, determine the amount of energy and thereby the quality of the spot
weld. If both monitoring functions are conducted with correct reference values, then they
contribute considerably to quality assurance.

A transient decay current is still flowing after power turn-off, while welding with DC cur-
rent, which also goes into the energy equation. Current Monitoring addresses this area as
well if desired.

11.3.1 Basic-Setup Parameters which Affect Current Monitoring

- Monitoring Std/MIX (Standard and Mixed Monitoring)

- Monitoring Stopped for all programs

- Current measure (fade-out time and trail current, setting depends on the timer type
in use)

Monitoring Stopped

D Starting window - Operation - Modify - Programming - Basic-Setup - Sequence-
Setup

Menu item Fault-Set-up allows you to determine the response of the timer (<Welding
fault> or <Warning>) to a deviation of the monitored values.

Fault Allocation:

D Starting window - Operation - Modify - Programming - Basic-Setup - Fault-Set-up
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11.3.2 Interface Signals which Interact with Current Monitoring

The following input and output signals affect current monitoring in the welding process:

[1]

[3]

[1]

[1]

[4]

[5]

Timer

External Weld Time Termination

[2]

Input signals Output signals

Toroid input

Weld complete (WC)

Without Monitoring

Control Ready

Welding fault

Warning

[1] The current sensor (toroid) measures the amount of the welding current and re-
turns the value to the toroid input of the welding timer. Based on the parameter set-
tings made in Current Monitoring, the welding timer issues <Weld complete
(WC)> (if welding current is correct) and maintains the signal <Control ready> at
the end of the [sequence].
The output of <Weld Complete> if the welding current is not correct is program-
mable.

[2] The <External weld time termination> stops the welding process immediately.

[3] If current monitoring is turned off at the programming unit the signal <Without
Monitoring> is output.

[4] When current values fall outside the programmed limits, with monitoring enabled
and allocation as fault, the signal <Control ready> will be cleared and the signal
<Welding Fault> will be issued.

[5] When current values fall outside the programmed limits, with monitoring enabled
and allocation as warning, the signal <Control ready> will be maintained and the
signal <Warning> will be issued.
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11.3.3 Starting Current Monitoring

D Select Starting window - Operation - Modify - Programming - Welding-Parameters
- Current Monitoring

If in monitoring mode Standard current monitoring is active for all weld times, entries are
possible in the column Standard only. If monitoring mode Mix has been selected, inputs in
columns 1. Weld-time, 2. Weld-time, 3. Weld-time are possible.

For Current Monitoring in monitoring mode Mix, see section 8.20. The organization of the
window is dependent on the type of the timer.

[2]

[3]

[2] [2]

[3] [3]

[4] [4] [4]

[5] [5] [5]

[6] [6] [6]

[7][7] [7][8] [8] [8]

[3]

[2]

[4]

[5]

[6]

[7] [8]

[1]

[9] [9] [9] [9]

NOTE

In the Standard Monitoring mode, Current Monitoring applies to all weld times of a weld-
ing program. Use of the Mixed Monitoring mode is recommended for higher quality re-
quirements, since each weld time allows separate monitoring. In such a case the
Monitoring Parameters must be entered separately for 1. WLD, 2. WLD and 3. WLD.

11
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Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat.-> WT> transmits data to timer.
- <New Sel> corresponds to the Selection menu, see chapter 12.
- <Prog +> next program (current program number +1).
- <Prog -> previous program (current program number -1).
- <Act.->Com.> accepts the displayed actual values as command values (refer-

ence currents), see section 11.3.4.
- <Act.Val.> see section 7.4.7.

Inputs, selections and displays:

NOTE

A selection of the objects of a window is shown, depending on the timer used and the
selected program functions.

[1] Display
- current power correction of the electrode, %I-Corr. (E).
- current power correction of the program, %I-Corr. (P).
- current monitoring value for %I correction Monitor Step.-Value. 

(For %I Correction see volume 1, sections 7.4.2 and 7.4.3).

[2] Current Monitoring On/Off
Current Monitoring in the Standard monitoring mode is enabled for all weld times, while
Current Monitoring in the Mixed monitoring mode must be turned on or off separately for
each weld time. Any deviation of the monitored values above or below the programmed
value generates a message, which may either be a <Welding fault> or a <Warning>,
depending on the Fault Allocation, (note effect on ready state of the timer).

[3] Upper Tolerance Band (Set)
D Input (Set) of the admissible current deviation in % above the commanded current

(reference current) for Current monitoring.
A deviation of the actual current above this limit results either in a <Warning>, whereby
the timer remains in the ready state, or a <Welding fault> is indicated and the timer is
stopped.

+ Upper tolerance in %

Lower tolerance in %

100% reference current in kA

Conditional tolerance band
Repeat factor

X

X X

X

X X

X  Actual current value

[3]

[5]
[4] [6]

 

GOOD
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[4] Lower Tolerance Band (Set)
D Input (Set) of the admissible current deviation in % above the commanded current

(reference current) for Current monitoring.
A deviation of the actual current below this limit results either in a <Warning>, whereby
the timer remains in the ready state, or a <Welding fault> is indicated and the timer is
stopped.

[5] Conditional Lower Tolerance Band (Set)
D Input (Set) of the conditional current tolerance in % of the commanded current (re-

ference current) for downward Current monitoring, taking into account the repeat
factor, see section 8.15.

If a deviation of the current below the admissible tolerance band occurs, spot repetition
can be performed (Max. repeat welds). A spot below the lower tolerance band is repeated
only once.
Max. repeat welds:
Select Starting window - Operation - Modify - Programming - Basic-Setup - Sequence-
Setup 

[6] Repeat Factor (Set:/Act.:)
D Input (Set:) and display (Act.:) of the repeat factor of consecutive welds in the con-

ditional tolerance band, see section 8.15.
Current values in the conditional tolerance band will cause the internal �repeat factor�
counter to be incremented. Exceeding the command value of the �repeat factor� counter
results either in a <Warning> whereby the timer remains in the ready state, or a <Weld-
ing fault> is indicated (message output at the programming unit: �Series of welds below
lower threshold point�) and the timer is stopped.

Example: Conditional Tolerance Band: Repeat Factor 3

Fault or Warning

GOOD

X X X

X

X X

X  Welding current value

[3]

[5]
[4] [6]X X

+ Upper tolerance in %

Lower tolerance in %

100% reference current in kA

Conditional tolerance band
Repeat factor

11
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[7] Reference Current (Set)

D Input (Set: reference current) for Current monitoring. An actual value can be ac-
cepted as new command value (reference current) with the <Act.->Com.> com-
mand button.

In the Standard Monitoring mode, the measuring time includes the beginning of the
[1.WLD] up to the end of the [3.WLD] as well as all [cool times], see section 8.20.

In the Mixed Monitoring mode, the measuring times are restricted to the individual [Weld
Times] [1.WLD], [2.WLD] and [3.WLD]. If the [2nd current block] is made up of several
[impulses], the measuring time corresponds to the duration of the individual [impulses],
see section 8.20.

On this current a deviation of the actual current is monitored.
For example, illustration (2. weld current) in section 11.3.3:
Here 6.43 kA mean �GOOD� current.
In this area, a deviation of +10% (6.43 kA + 10% = 7.07 kA) or -14% (6.43 kA - 14% =
5.53 kA) is admissible. If stepping is activated, then this value always refers to the spot
with wear = 0.0 (new electrode), see section 11.2.

100%

+ 10%
Tolerance

+ 10%

- 14%

   0%

Reference Current

Actual value

kA

Example: Calculation of the Commanded Reference Current from the
Actual Reference Current

Calculation

* momentary current, dependent on the wear (counts)

- 14%
Tolerance

* Current

Wear (Counts)

[8] Act. ref. current
Display of the measured actual current value (rms) of the last welded spot. In monitoring
mode Standard with [pulses] in the [2. weld time] and/or [slope] the average value is dis-
played via the measuring time, see section 8.20.1. 
The actual current can be taken over into the command value window of the reference
current with the <Act. -> Com.> command button.
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[9] Middle PHA (Act.:)
Display of the actual values of the mean phase angle of the current weld.

The actual values of the resulting mean phase angle are displayed independently from
the selected control function.

11.3.4 Accepting Actual Current as Reference Current

[1]

[2]

[3]

[4]
[5]

3

[1] The actual current is accepted as the reference current (Set:) for those programs
that work with the displayed electrode [5].

[2] The actual current is accepted as the reference current (Set.:) for the entered pro-
gram [4].

[3] The actual current is accepted as the reference current (Set.:) for the displayed
programs (in the example these are programs 1, 3, 4, 5, 6 and 9).

11
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Your notes:
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11.4 Time Monitoring

Time Monitoring controls the actual duration of all weld times and compares the actual
value with a programmable reference time and an admissible time tolerance, see section
8.21.
The actual or measured weld time can be accepted as a new command (reference time)
value.

The timer reports any deviation beyond the tolerance band. The timer may respond with a
<Welding fault> or a <Warning> and the message is output at the programming unit.

Time Monitoring must be viewed together with Current Monitoring. Both quantities, time
and current determine the amount of energy and thereby the quality of the spot weld. If
both monitoring functions are conducted with correct reference values, then they contrib-
ute considerably to quality assurance.

When welding with DC current, larger currents are still flowing after power turn-off, which
must also go into the energy equation. Time Monitoring also addresses this area.

NOTE

The change of a weld time, with time monitoring enabled, requires also a change in the
related reference time. If this is not done, the reference time deviation will eventually be
outside the tolerance band specified for monitoring, resulting in a warning or fault mes-
sage. This helps quality assurance, since it helps to detect careless changes.

Time tolerance +/- 3 cyc.

- +

Reference time = 9 cycles, tolerance +/- 3 cycles

WLD Faultless
Fault/Warning

Weld Time too short
Fault/Warning

Weld Time too long

Reference time

Reference time

WLD

t

t
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11.4.1 Basic-Setup Parameters which Affect Time Monitoring

- Monitoring Stopped

Monitoring Stopped:

D Starting window - Operation - Modify - Programming - Basic-Setup - Sequence-
Setup

The menu item Fault-Set-up serves to determine the response of the timer (<Welding
fault> or <Warning>) to a deviation above or below the monitored time values.

Fault Allocation:

D Starting window - Operation - Modify - Programming - Basic-Setup - Fault-Set-up
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11.4.2 Interface Signals which Interact with Time Monitoring

The following input and output signals affect the Time Monitoring in the welding process:

[1]

[2]

[1]

[3]

[4]

Timer
External end of weld time

WC

Control Ready

Welding Fault

Warning

Input signal Output signals

[1] The signal <External end of weld time> ends the welding process directly. The
signal <Control ready> is cleared.

[2] The signal <External end of weld time> does not prevent output of the <WC>
signal.

[3] When weld time values fall outside the programmed limits, with monitoring en-
abled and allocation as fault, the signal <Control ready> will be cleared and the
signal <Welding fault> will be issued.

[4] When weld time values fall outside the programmed limits, with monitoring en-
abled and allocation as warning, the signal <Control ready> will be maintained
and the signal <Warning> will be issued.

11



Welding parameters BOS-5000

11-40 1070 078 218-104 (99.09) GB

11.4.3 Starting Time Monitoring

D Select Starting window - Operation - Modify - Programming - Welding-Parameters
- Time Monitoring

[1]

[2]

[3] [4]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat.-> WT> transmits data to timer.

- <New Sel> corresponds to the Selection menu, see chapter 12.

- <Prog +> next program (current program number +1).

- <Prog -> previous program (current program number -1).

- <Act.->Com.> accepts the displayed actual values as command values (refer-
ence time), see section 11.4.4.

- <Act.Val.> see section 7.4.7.
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Inputs, selections and displays:

[1] Time Mon. On/Off (time monitoring)
Time Monitoring is turned on or off for all weld times. 

[2] Tolerance (Set:) (admissible time deviation, set value)
D Input (Set:) of the admissible time deviation (cycles or milliseconds) from the refer-

ence time for Time monitoring.
Any deviation from the tolerance band causes either a <Warning> message and the
timer remains in the ready state or a <Welding fault> message and the timer is stopped.

[3] Ref. Time (Set.:) (reference time set value)
D Input (Set:) of the reference time  in cycles or milliseconds (ms-timer) for Time

monitoring.
The reference time is the entered command time (Set.:).

[4] Ref. Time (Act.:) (reference time actual value)
The measured actual reference time is displayed in cycles or milliseconds (ms timer).

The measured actual reference time (cycles or milliseconds) can be accepted as the new
command value (set reference time) via the command button <Act.->Com>.

The deviation of the actual time is monitored with regard to this time.

See example illustration in section 11.4.3:
Here 10.0 SKV (scale units) means �Good� Time.
In this area a deviation of  +1 SKV (10.0 SKV + 1.0 SKV = 11.0 SKV) or -1 SKV (10.0 SKV
- 1.0 SKV = 9.0 SKV) is admissible.
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11.4.4 Accepting Actual Time (Act.:) as Command Time (Set.:)

[1]

[2]

[3]

[4]
[5]

3

[1] The actual time is accepted as a reference time (Set.:) for those programs that
work with the displayed electrode [5].

[2] The actual time is accepted as the reference time (Set.:) for the program displayed
under [4]: Prg. No.

[3] The actual time is accepted as the reference time (Set.:) for the displayed pro-
grams.
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11.5 Monitor Stepper

- Monitoring and Regulation are separate functions.

When using the Stepper function the [current] (phase angle) is changed in order to com-
pensate the electrode�s wear according to the stepper curves. Starting with a certain ini-
tial current, the outgoing electrical [current] (%I) is stepped in the sections Start, Stepper
and Tipdressing, following a predetermined curve shape, see section 11.2.

When a command value for a welding program has been programmed and Stepper is
active, the current may change from one spot to the next. In this case, the Monitor Step-
per function provides the possibility to program separate stepping values in percent if, at
the same time, a certain current is to be monitored.

The characteristic of the curve and the end of stepper (wear) of the electrodes are the
same in the display of the Stepper and Monitor Stepper, but the percent value of the Moni-
tor Stepper may be different.

NOTE

A current sensor (toroid) is required for the Monitor Stepper function.

11.5.1 Basic-Setup Parameters which Affect the Monitor Stepper Function

In the items Stepper-Curves and Tipdress-Curves of the Basic-Setup menu, 10 different
curves for Stepper / Monitor Stepper can be programmed.

Using the menu items Stepper-Curves/Tipdress-Curves, you may program the following
parameters:

- curve shape

- current changes (%I Change)

- wear counter values (Count Values)

Stepper Curves and Tipdress-Curves

D Starting window - Operation - Modify - Programming - Basic-Setup - Stepper-
Curves / Tipdress-Curves
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11.5.2 Interface Signals which Interact with Monitor Stepper

The following input and output signals affect the Monitor Stepper in the welding process:

[1]

[2]

[1]

[1]

[3]

Timer

Input signal Output signals

Toroid input

Welding fault

Control Ready

Weld Complete (WC)

Warning

(actual current value)

[1] The current sensor (toroid) measures the welding current and sends the value to
the toroid input of the timer. As long as the actual current value is within the pro-
grammed tolerances, the welding timer issues <WC> (if welding current is correct)
and maintains the signal <Control ready>.
The output of the signal <Weld Complete> with a faulty weld current can be pro-
grammed.

[2] When current values fall outside the programmed limits, <Control ready> will be
cleared and the signal <Welding fault> will be issued (assuming that current val-
ues outside the programmed limits are defined as a fault in Basic-Setup - Fault
Set-up). The operating status of the welding timer will be changed to Stop.

[3] When current values fall outside the programmed limits, <Warning> will be issued
(assuming that current values outside programmed limits are defined as a warning
in the Basic-Setup - Fault-Set-up). The operating status of the welding timer re-
mains in <Control ready>.
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11.5.3 Starting Monitor Stepper

D Select Starting window - Operation - Modify - Programming - Welding-Parameters
- Monitor-Stepper.

[1]

[1a]

[1b]

[1c]

[2] [3]

[4]

NOTE

The organization of the window (input fields) is dependent on the type of timer used.

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat.-> WT> transmits data to timer.
- <New Sel> corresponds to the Selection menu, see chapter 12.
- <Prog +> next program (current program number +1).
- <Prog -> previous program (current program number -1).
- <Curr.value> The Stepper values given in percent are converted into absolute

current values and displayed. The inputs for the Stepper in percent and the current
values can be changed, see section 11.2.4.

NOTE

The current values display can only be called up if KSR mode has been preselected.

- <Act.Val.> see section 7.4.7.
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NOTE

Curve sections displayed in blue work without monitor stepper.
Possible reasons:
- Stepping is disabled.

- No wear has been programmed for these sections.

- Stepping = 100% has been programmed for the stepper section.

- The tip dressing function is disabled.

- No wear has been programmed for prewarning.

If the curve for the start section ([1c] input value, stepper, wear, start-section = 0.0) is
displayed in blue it works without the monitor stepper function.

A green curve for the start section ([2] input value, stepper, wear, start-section > 0.0)
shows that monitoring for this area is active. Stepping is monitored with the programmed
monitoring value in percent.

If the curve in the stepper section ([1a] input value, monitor, stepper = 100%) is displayed
in blue it works without monitor stepper.

A green curve in the stepper section ([1a] input value, monitor, stepper � 100%) shows
that monitoring for this area is active. Stepping is monitored with the programmed
monitoring value in percent.

If the curve in the tipdressing section ([4] Stepper, Dressings = 0) is displayed in blue, it
works without monitor stepper. The tipdressing function is not active.

A green curve in the tipdressing section ([4] Stepper, Dressings � 0) shows that
monitoring in this area is active. Stepping is monitored with the programmed monitoring
value in percent.

If the curve in the prewarning section ([3] Stepper, input value, wear, prewarning = 0.0) is
displayed in blue, prewarning is not programmed.

If the curve in the prewarning section ([3] Stepper, input value, wear, prewarning > 0.0) is
displayed in yellow/red, the stepper works with prewarning.
The stepper can be changed in the Stepper window.
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Inputs and Displays:

NOTE

All unchangeable values displayed in this window correspond to those in the Stepper
illustration, see section 11.2.3.

[1] Current (%I)
The monitoring value of the stepper is given in percent and is thus independent from the
absolute values of a welding program. If the [current] of a welding program is altered, the
monitoring value can be taken over.

All entries refer to a basic value (100%) at the end of the start section, i.e. at the beginning
of the stepper section.

Input fields for programming the monitoring value:

- [1a] The input field at the top determines the monitoring value at the end of the
stepper section.

- [1b] The input field in the middle determines the monitoring value at the end of the
tipdressing section.

- [1c] The input field at the bottom determines the monitoring value when starting
with a new electrode.

11
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11.6 Pressure

NOTE

The Pressure function is not available in all timer types. Depending on the type of the
timer used, activation of the pressure regulating valve is analog or digital.
It is set in the window Basic-Setup - I/O-Parameters.

The value for activating a pressure regulating valve is given via an output. The pressure
value determines the electrode pressure and is composed of four components:

- [Base-Pressure]

- [Press.-Prof.] (Pressure Profile)

- Pressure-Stepper

- Pressure correction

Timer

Base pressure
Pressure profile
Pressure-Stepper

Pressure value

Pressure

F

Program number

Net-pressure

When the program is activated the corresponding base pressure is output.

Electrode
gun

[Base pressure]

The [Base Pressure] is a pressure value that is available from the beginning of the pro-
gram selection at the pressure output and can be modulated by a [pressure profile]. The
[Base Pressure] is a programmable welding parameter. Each welding program can be
given an individual [Base Pressure]. The [Base Pressure] is influenced by the Pressure
Stepper, the [Pressure Profile], and the pressure correction.

[Press.-Prof.] (Pressure Profile)

A [Pressure Profile] can be employed during the welding process in addition to the [Base
pressure], in order to modulate the [Base pressure]. The [Pressure Profile] can be pro-
grammed via 10 steps with the pressure value and the pressure time. It starts with the
squeeze time [SQZ] and ends with the hold time [HLD]. If the sum of all pressure times
exceeds the total length of the welding program from the squeeze time [SQZ] up to the
end of the hold time [HLD], then the [Pressure Profile] will be cut short at the end of the
hold time [HLD]. Only [Base pressure] is active after this.

11
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NOTE

After exchanging a component (e.g. the electrode gun) pressure scaling has to be re-
done.

CAUTION!

Pressure values that are too high can cause damages to the welding installation.

11.6.1 Basic-Setup which Affects the Pressure Function

The following parameters can be programmed in the Basic-Setup menu:

- Max Pressure (Maximum Pressure)

- Conv.-Factor (Conversion Factor)

- Zero adjust (Zero Adjustment)

NOTE

The conversion factor and a possible zero adjustment should better be calculated with
Pressure Scaling.

Pressure parameterization:

D Starting window - Operation - Modify - Programming - Basic-Setup  - Electrode
Setup (Stepper Setup).

!



Welding parametersBOS-5000

11-511070 078 218-104 (99.09) GB

11.6.2 Interface Signals which Interact with the Pressure Function

The following input and output signals affect the pressure in the welding process:

[1] [1]

[1]

[1]

[2]

Timer
Program no.

Start

Monitor contact

WI release

Pressure port

Input signals Output signal

[1] Program selection generates the programmed [Base pressure value] for driving
the pressure solenoid valve. The control awaits a response by the signal <Monitor
Contact> in order to start the [sequence].

[2] Absence of the <WI release> or <Monitor Contact> MC  signals delays the exe-
cution or the output of the programmed [pressure profile].

t1.WLD 2.WLD 3.WLD

t

Monitoring contact MC

Welding sequence with pressure profile and delay x by delayed WI release

x

x

x x

SQZ

t

t

WI inquiry

WI release

Pressure profile

HLD

Base pressure
value

Program selection

11
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11.6.3 Starting Pressure

D Select Starting window - Operation - Modify - Programming - Welding-Parameters
- Pressure.

[1]

[2]

[3]

[4]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat.-> WT> transmits data to timer.

- <New Sel> corresponds to the Selection menu, see chapter 12.

- <Prog +> next program (current program number +1).

- <Prog -> previous program (current program number -1).

- <Act.Val.> see section 7.4.7.

Inputs and selections:

[1] Base pressure
The [base pressure] becomes active at the pressure output upon program selection.

It is affected by the following parameters:

- [Press.-Prof.] (Pressure Profile)

- Pressure-Stepper

- Pressure Correction
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[2] [Press.-Prof.] On/Off (Pressure Profile On/Off)
Used to toggle modulation of [Base pressure] by the [Pressure Profile] On/Off. The [Pres-
sure Profile] is determined by the pressure value and pressure time.

[3]  Pressure Value
The max. 10 pressure values for the pressure profile can be entered in kN.

[4] Pressure time
A maximum of 10 pressure times of the pressure profile can be entered in scale units, or in
milliseconds.

NOTE

If the sum of all pressure times exceeds the total length of the welding program from the
squeeze time [SQZ] up to the end of the hold time [HLD], then the [Pressure Profile] will be
cut short at the end of the hold time [HLD]. Only [Base Pressure] is active after this.

11
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11.7 Pressure Stepper

In order to compensate the wear of the welding electrodes, the [Base Pressure] value is
changed by the Pressure Stepper function. In order to activate the pressure regulating
valve the [Base-Pressure] value is changed for the Start, Stepper, and Tip-Dressing sec-
tions according to a preselected curve, starting from an initial value.

The Pressure Stepper works with linear interpolation, i.e., depending on the wear
counter, the mean value of the stepping value is taken from the following coordinates.

11.7.1 Basic-Setup which Affects the Pressure Stepper Function

The following parameters can be programmed in the Basic-Setup menu:

- Maximum Pressure [Max Pressure]

- Conversion factor [Conv.-Factor]

- Zero adjustment [Zero-adjust]

NOTE

The conversion factor and a possible zero adjustment should better be calculated with
Pressure Scaling.

Pressure parameterization:

D Starting window - Operation - Modify - Programming - Basic-Setup  - Electrode-
Setup (Stepper-Setup).

11
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11.7.2 Interface Signals which Interact with Pressure Stepper Function

The following input and output signals affect the Pressure Stepper in the welding pro-
cess:

[1] [1]

[1]

[1]

[2]

Timer
Program no.

Start

Monitor contact

WI release

Pressure port

Input signals Output signal

[1] Selecting the program generates the output of the programmed [Base Pressure]
value for activating the pressure valve. If pressure stepper is active the activation
changes with each new start.
The signal <Monitor Contact> is the feedback signal for the start of the [se-
quence].

[2] Absence of the signal <WI release> delays the [Schedule (sequence)] and/or the
output of the programmed [pressure profile] by always the same duration.
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11.7.3 Starting Pressure Stepper

D Select Starting window - Operation - Modify - Programming - Welding-Parameters
- Pressure-Stepper.

[1]

[2] [3]

[4]

[1a]

[1b]

[1c]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat.-> WT> transmits data to timer.

- <New Sel> corresponds to the Selection menu, see chapter 12.

- <Prog +> next program (current program number +1).

- <Prog -> previous program (current program number -1).

- <Act.Val.> see section 7.4.7.
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NOTE

Curve sections displayed in blue work without pressure stepper.
Possible reasons:
- Stepping is disabled.
- No wear has been programmed for these sections.
- Stepping = 100% has been programmed for the stepper section.
- The tip dressing function is disabled.
- A wear factor for prewarning has not been programmed.

If the curve section for the start section is shown in blue color ([1c] Stepper wear start
section input value = 0.0), the Pressure Stepper function works without a percent change
for this section.

A green curve display for the start section ([2] Stepper wear start section input value >
0.0) indicates active Pressure Stepper for this section. Pressure Stepper is performed
with the programmed stepping values in percent, depending of the electrode�s wear
counter.

A blue curve section in the stepper section ([1a], Monitor Stepper input value = 100%)
indicates that Pressure Stepper is performed without a percent change in this section.
 
A green curve display ([1a], Pressure Stepper input value � 100%) in the stepper section
indicates that Pressure Stepper is performed with the programmed percent stepper
values depending on the electrode�s wear counter and the stepper curve selected for this
section.

A blue curve section for the tip dressing section ([4], Stepper Dressings = 0) means that
Pressure Stepper is performed in this section without a percent change. The tip dressing
function is not active.

A green curve display ([4], Stepper Dressings � 0) in the tip dressing section indicates
that Pressure Stepper is active with the programmed stepper values in percent,
depending on the number of dressings and the selected tip dressing curve.

If the curve section for the prewarning section is displayed in blue color ([3], Stepper wear
prewarning input value = 0.0), no prewarning section has been defined.
A yellow/red curve display of the prewarning section ([3], Stepper wear prewarning input
value > 0.0) means that a prewarning section has been defined.
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Inputs and Displays:

NOTE

All unchangeable values displayed in this window correspond to those in the Stepper il-
lustration, see section 11.2.3.

[1] Pressure
A percent value is entered for pressure change, which makes it independent from the ab-
solute values of the welding program. The Pressure Stepper percent values can remain
unchanged, if the pressure of a welding program is changed.

All entries relate to a base value (100%) at the end of the Start section i.e. the beginning of
the Stepper section.

Three input fields are available for programming Pressure Stepper:

D [1a] The value in the top input field determines the Pressure Stepper in percent at
the end of the Stepper section. An input value higher or lower than 100% is charac-
terized by a color change of the Stepper-Curve, thus indicating changes in the
Pressure Stepper.

D [1b] The value in the middle input field determines the Pressure Stepper in percent
at the end of the tipdressing section. An input value higher or lower than 100% re-
sults in changes of the Pressure Stepper in the tipdressing section.

D [1c] The value in the bottom input field determines the Pressure Stepper in percent
of a new electrode. An input value higher or lower than 100% results in changes in
the Pressure Stepper in the starting section.
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11.8 Freely Programmable Output

Each welding program can drive a freely programmable output (timer-specific) of the
timer. This output may have up to three programmable On and Off Times during the
[Schedule (Sequence)]. It can be used to drive an additional solenoid valve or another
peripheral device.

t1. WLD 2. WLD 3. WLD

t

Monitor Con-
tact (MC)

Example: Freely programmable output and time delay x due to delayed WI release

On 1 On 2

Example with two ON-times and two OFF-times

Off 1 + x

x x x

SQZ

t

t

WI inquiry

x

x

Off 2

WI release

Freely programmable output
11
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11.8.1 Interface Signals which Interact with the Freely Programmable Output

The following input and output signals affect the freely programmable output in the weld-
ing process:

[1] [1]

[1]

[1]

[2]

[3]

Timer
Program no.

Start

Monitor contact

WI release

Freely Programmable Output

Input signals Output signal

External end of weld time

[1] The time cycle of the Freely Programmable Output starts with the beginning of the
squeeze time [SQZ]. The conditions for the start of the [squeeze time] [SQZ] are
<Program Number>, the <Start> signal, the end of the [pre-squeeze time] [1.
SQZ] and the acknowledgement with the signal <Monitor Contact>.

[2] The signal <External End of Weld Time> resets the Freely Programmable Out-
put.

[3] Absence of the <WI release> or <Monitor Contact> MC signals delays the
[sequence] and the timing of the Freely Programmable Output.
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11.8.2 Starting Freely Programmable Output

D Select Starting window - Operation - Modify - Programming - Welding-Parameters
- Freely Programmable Output

[1]

[2] [2] [2] [2] [2] [2]

Command buttons:

- <OK> 
transmits data to the timer or cancels the transmission, closes the window.

- <Dat. -> WT> transmits data to timer.

- <New Sel> corresponds to the Selection menu, see chapter 12.

- <Prog +> next program (current program number +1).

- <Prog -> previous program (current program number -1).

- <Act.Val.> see section 7.4.7.
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Inputs and selection:

[1] Freely Programmable Output: On/Off.
Used to enable and disable the Freely Programmable Output function and the entry of the
On and Off times.

[2] On-Times / Off-Times
Entry of up to three ON- and three OFF-Times in the section from the beginning of the
[squeeze time] [SQZ] up to the end of the [hold time] [HLD]. If the sum of all programmed
times exceeds the total length from start of the [squeeze time] [SQZ] up to the end of the
[hold time] [HLD], then the remaining ON- and Off-Times will be cut off and have no effect
on the output.

The measuring units for programming are cycle or milliseconds.
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12 Selection

- Selection of a timer, program, or spot for Programming

- Selection of a program using a specific electrode (Selection - Stepper)

- Display of programs using the same electrode (Corresponding Programs)

- Display of spots using the same program of the timer (corresponding Spots)

- Information concerning timers and spots.

Starting window

...

Timer-Reference Spot-Reference Operation

File Services Modify Diagnostics

Services Welding-Parameters Basic-Setup Selection

Programming F9

Help

Timer-Selection Shift + F2
Stepper-Selection Shift + F3
Program Shift + F5
Cord. Programs Shift + F6
Spot-Selection Shift + F7
Cord. Spots Shift + F8
Timer-Info Shift + F9
Spot-Information Shift + F11

NOTE

The Timer-Selection and Spot-Selection menu items function like switches. The check
mark in front of the menu item indicates that it is �enabled�.
If a menu item is marked for selection (enabled), the other menu item is automatically
disabled for selection.

12
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12.1 Timer-Selection

A list is displayed of allocated timers for making a Selection of the timer. After Timer-
Selection, then make a Program-Selection.

D Select Starting window - Operation - Modify - Programming - Selection - Timer-
Selection

The Program-Selection window is opened immediately after Timer-Selection. Enter the
program number and confirm it by clicking on<OK> (see section 12.3).

12.2 Stepper Selection

Select one of 32 electrodes for use with the previously selected timer (the number of se-
lectable electrodes depends on the timer type used). Then select a program that uses this
electrode.

D Select Starting window - Operation - Modify - Programming - Selection - Stepper

D Stepper-Number: entry 0 to n (n = number of electrodes depends on the timer
type).

The Program-Selection window is shown immediately after Stepper-Selection.
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In contrast to the Program-Selection window from the Selection window, you cannot en-
ter a program number. Instead, all welding programs which use the selected stepper are
displayed for Selection.

NOTE

Every welding program uses only one electrode. Several welding programs can use the
same electrode.

To effect the allocation: program <-> electrode, use the menu item Sequence Setup in
the Basic-Setup menu, see section 10.10.

12.3 Program Selection

Select a welding program of the previously selected timer.

D Select Starting window - Operation - Modify - Programming - Selection - Program
(Selection)

D Program-No. : Entry 0 to n (n = number of programs depends on the timer type).

12
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12.4 Selection of Cord. Programs

Using this menu item, the programs 0 to 255 (type-specific) are displayed in a table. The
corresponding programs of the selected timer (programs using the same electrode) are
highlighted in the table by a different color.

D Select Starting window - Operation - Modify - Programming - Selection -  Cord.
Programs

1 2

Example: Programs 1 and 2 use electrode 1, i.e. they are corresponding programs.

Command buttons:

- <Cancel>: closes window

- <Stepper +>: next stepper (stepper (electrode) number +1).

- <Stepper ->: previous stepper (stepper number -1).



SelectionBOS-5000

12-51070 078 218-104 (99.09) GB

12.5 Spot-Selection

Please refer to volume 1, section 7.7.2.

12.6 Cord. Spots Selection

This menu item displays a list of all Corresponding Spots relating to the previously se-
lected spot in a window.

NOTE

The Spot-Selection must be active.

Corresponding Spots use the same program of the same timer.

D Select Starting window - Operation - Modify - Programming - Selection - Cord.
Spots

NOTE

Changes made to the program parameters of a corresponding spot will also affect the
other corresponding spots.

12.7 Selection - Timer-Info

Please refer to volume 1, section 7.7.4.

12.8 Spot Info

Please refer to volume 1, section 7.7.5.

12
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13 Messages

13.1 Fault and Status Messages

Messages

- Warnings : The ready status of the timer remains, further [sequences] are not
inhibited.

- Faults : The timer is no longer ready, further [sequences] are inhibited.

NOTE

Internally the timer works with coded numbers. All messages are output on the program-
ming unit in text format.

13.2 Ranges of Messages

[A] Messages concerning the connection WT Õ Programming terminal are displayed
(communication messages) 

[B] Messages concerning the stepper (electrode) status are displayed (Prewarning,
End of Stepper reached, etc.).

[C] Messages concerning the timer status are displayed (battery low, no +24V etc.).
[D] Messages from active monitoring (Weld-time exceeded).

13.2.1 [A] - Communication Messages

Code Explanation

-93

-94

-95

-96 Communication with weld timer cannot be established

-97 Communication with weld timer was disconnected

-98 Upload or Download active in Timer

-99 Objects are not accessible

-100 Incorrect timer type (wrong timer in Ref. Table)

-146 Fatal error layer 8

Error when starting the status message (possibly not enough RAM

memory. Close other applications).

13
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-193 Error during checking of parameters

-194 Timer name is unknown

-195 Timer is unknown

-196 Driver is not installed

-197 Station does not exist or driver is not loaded

-198 Object does not exist

-199 Service is unknown

-200 Error of calling parameters



MessagesBOS 5000

13-31070 078 218-104 (99.09) GB

13.2.2 [B] - Electrode (Stepper) Messages

Code Explanation Additional code

31* End of Stepper Electrode no.

32* Prewarning Electrode no.

33* Tip dress request Electrode no.

34* Tip dress necessary Electrode no.

40* %I (Current) Prewarning Electrode no.

41* Maximum current Electrode no.

13.2.3 [C] - Messages Concerning the Timer Status

Code Explanation Additional code

80 Stop Open circuit / no +24V -

81 Weld without command -

83 Thyristor unit not ready -

84 Battery low -

85 Memory deleted == RAM checksum error -

86 Data Restore active -

87 No weld program == invalid parameter Program no.

88 Hardware fault H/W fault bitcode

89 I/O-bus fault (only for WT with serial I/O bus) -

90 -

91 Main switch tripped -

93 Synchronization fault -

94 Sequence inhibited Program no.

95 Parity error Program no.

96 -

97 -

98 -

99 Welding process, cf. [D] Monitoring code

100 Supply voltage fault -

102 No weld external -

103 No weld internal -

13
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13.2.4 [D] - Messages for Current and Weld Time Monitoring

Code Explanation

1001 Current measurement loop open

1002 Current measurement loop shorted

1003 No voltage 1. HW

1004 Primary voltage measurement fault

1010 No current (standard mode)

1011 No current 1. WLD (mixed mode)

1012 No current 2. WLD (mixed mode)

1013 No current 3. WLD (mixed mode)

1020 Current too low (standard mode)

1021 Current too low 1. WLD (mixed mode)

1022 Current too low 2. WLD (mixed mode)

1023 Current too low 3. WLD (mixed mode)

1030 Current too high (standard mode)

1031 Current too high 1. WLD (mixed mode)

1032 Current too high 2. WLD (mixed mode)

1033 Current too high 3. WLD (mixed mode)

1040 Series of welds below lower threshold (standard mode)

1041 Series of welds below lower threshold 1. WLD (mixed mode)

1042 Series of welds below lower threshold 2. WLD (mixed mode)

1043 Series of welds below lower threshold 3. WLD (mixed mode)

1050 Current measuring range exceeded (standard mode)

1051 Current measuring range exceeded 1. WLD (mixed mode)

1052 Current measuring range exceeded 2. WLD (mixed mode)

1053 Current measuring range exceeded 3. WLD (mixed mode)

1060 Weld time too short

1070 Weld time too long
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A Annex

A.1 Abbreviations, Terms
1. SQZ 1st Squeeze Time or Pre-Squeeze Time: starts after the start signal in the operating modes

single, repeat and seam.
1. WLD 1st Weld Time: current is generated for the first time to pre-heat the part being welded

1. CT 1st Cool Time between 1. WLD and 2. WLD

2. WLD 2nd Weld Time: main weld time

2. CT 2nd Cool Time during operation of the 2nd Weld Time with impulses, distance between the
[Impulses]

3. CT 3rd Cool Time between 2. WLD and 3. WLD

3. WLD 3rd Weld Time: last current output for post-heating the welding material; improves the struc-
ture of the welded material.

CT
COOL

Cool time: time between the current pulses/blocks (1., 2., 3. COOL (CT))

Current Current  measured in %I (scale units) or kA (same as HEAT).

DST Down Slope Time: until the end of 2. WT current is reduced gradually.

EA (EO) Electronic output: in this case +24V through transistor

EOS End-of-Sequence contact: signal is output when the spot has been completed

Ext External, e.g. +24V: voltages for signal transmitters (switches) and actuators (valves) exter-
nal to the timer

Firing
(Ignition)

Weld on/Weld off: enabling and disabling of the firing (ignition) impulses for activating the
power unit.

HEAT Heat in %Ht or kA (same as current)

HLD
HOLD

Hold time: last time of the welding schedule; time following the last weld time, during which
the parts just welded are allowed to cool down

HSA Main switch trip

IMP Number of pulses forming the 2.WLD

LT Power Unit (thyristor or inverter)

NBS Mains load limitation control: for monitoring and influencing the mains load

OFF Off time: time between 2 spot welds during which the solenoid valve is not activated. Avail-
able only in REPEAT mode.

PG Programming unit/welding computer

Post-
Heating
Time

Also called 3. WLD.

Pressure
Contact

Monitor Contact: e.g. monitoring of the pressure in the cylinder that closes the electrodes, or
monitoring of the electrode position; gun closed.

PSG Transformer rectifier unit for the PSU inverter

PSI Medium-frequency power unit

PSL PS power unit

PSP PS programming module

PSS PS timer

PST Thyristor power unit

PSU Weld current inverter (medium frequency)
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RA (RO) Relay output, +24V are output via a contact

REPEAT Repeat mode: for manually operated systems only

SING Single spot mode for automatic welding machines and manual systems

Slope Current increase (or decrease) from an initial to a final current.

Solenoid
valve

Activates the cylinders to close the electrodes.

SQZ Squeeze time: time that elapses before the weld time. The electrodes squeeze the parts to
be welded together.

Stepper Current (heat) stepping for compensating for electrode wear

Temp Temperature

UST Upslope Time; time during which the Current (HEAT) stops after beginning of 2.WLD

WC Weld Complete contact: signal is output when the spot has been completed

WLD Weld time: entire weld time including cool times

WT Weld timer, also called resistance weld timer

A.2 Regulation terms
%Ht Specification of heat in %Ht: represents the electrical phase angle (same as %I)

%I Specification of current in %I: represents the electrical phase angle (same as %Ht)

kA kilo Amperes

KSR Constant current regulation: the current in the secondary circuit is maintained constant by
regulation

KUR Constant voltage regulation: compensation for mains voltage fluctuations

PHA Phase angle (shift) regulation

SKT
(SKV)

Scale Units; correspond to an electrical phase angle.
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A.3 Index

Symbols
%I, 11-12

%I Limitation, 10-21

%I Prewarning, 10-21

Numbers
1. CT , 8-10

1. Half-cycle, 8-19

1. HC a. PAUSE, 11-9

1.SQZ, 8-10

1.WLD, 8-10

1st Cool Time, 8-10

1st Half-Cycle after Cool Time, 8-19, 11-9

1st Weld Time, 8-10, 11-31

2. CT , 8-11

2.WLD, 8-10

2nd Cool Time, 8-11

2nd Current Block, 8-10, 11-34

2nd Weld Time, 8-9, 8-10, 11-31

3. CT , 8-11

3.WLD, 8-11

3rd Cool Time, 8-11

3rd Weld Time, 8-11, 11-31

5 kHz impulse, 10-9

A
Accepting Actual Current as Reference Current,

11-35

Accepting Actual Time as Command Time, 11-42

Accuracy of current measurement, 10-22

Act. ref. current, 11-34

Act.->Com., 11-32, 11-40

Activation of the thyristor unit, 10-27, 10-30

Activation signal, 10-27

Actual Current, 11-35

Actual Time, 11-42

Actual value, 11-25, 11-32, 11-40, 11-45, 11-52,
11-57, 11-63

Actual values, 10-2, 11-19

Allocation: program  electrode (stepper), 12-3

Amount of energy, 11-29, 11-37

Average value, 10-42

B
Base current, 11-26

Base pressure, 11-49, 11-52

Basic Setup, 10-1

Bosch sensor, 10-22

Butt welds, 8-4

C
Change back, 9-4

CNOMO, 10-9

Command pressure value, 10-33

Command Time, 11-42

Commanded current, 11-32, 11-33

Comment, 9-2

Compensation of electrode wear, 11-43

Conditional Tolerance Band, 11-33

Consecutive rewelds, 10-28

Constant Current Regulation, 8-24

Constant Voltage Regulation, 8-22

Control ready, 11-30, 11-39, 11-44

Control Stopped, 10-27

Controller specific values, 10-20

Conversion factor, 10-24, 10-36, 11-50, 11-55

Corr. Spots Selection, 12-5
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Correction settings, 10-15

Corresponding Spots, 12-5

Count values, 10-17, 10-19

Counts. See Wear

Counts prewarning, 11-24

Current, 11-23

Current base value, 11-23

Current block operation, 8-6

Current changes, 11-43

Current Cycle, 8-11

Current deviation, 11-32, 11-33

Current downslope, 8-7

Current fault, 10-28

Current Limit, 10-21

Current measuring range, 10-22

Current Monitoring, 11-29

Current Monitoring Mixed, 8-25

Current Monitoring On/Off, 11-32

Current Monitoring Standard, 8-25

Current rise time, 10-29

Current scaling, 10-37

Current sensor, 8-24, 11-30, 11-44

Current upslope, 8-7

Current values, 11-19, 11-26, 11-45

Curve shape, 11-43

D
Data -> WT, 9-2

Data transmission, 9-2

Delayed WI release, 11-51

Diode Type, 10-12

Diodes, 10-12

Display of programs, 12-1

Display of spots, 12-1

Down Slope Time, 8-11

Dressings act., 11-25

Dressings max., 11-25

DST, 8-11

E
Electrode maintenance, 11-27

Electrode maintenance concept, 10-16, 10-30

Electrode number, 10-30

Electrode pressure, 10-23, 10-33

Electrodes have been dressed, 11-16

Electrodes have been replaced, 11-16

End of stepper, 10-15, 11-15, 11-16, 11-24

Exit, 9-4

External end of weld time, 11-39, 11-62

External Weld Time Termination, 8-15

F
Fade-out time, 8-26, 8-27, 10-29, 10-39, 10-40

Fault allocation, 10-3, 11-32

Fault message, 11-37

Feedback transformer, 8-22, 10-9

Field bus, 8-2

Freely Programmable Output, 11-61

H
Halfcycle, 10-21

HLD, 8-11

Hold Time, 8-11, 10-31, 11-64
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I
I/O Parameters, 10-5

Ignition type, 10-9

Impulse, 8-11, 11-13

Impulses, 8-8

Information concerning spots, 12-1

Interface Signals
Current Monitoring, 11-30
Freely Programmable Output, 11-62
Monitor Stepper, 11-44
Pressure Function, 11-51
Pressure Stepper, 11-56
Schedule, 11-6
Stepper, 11-16
Time Monitoring, 11-39

Inverter, 10-23

K
kA, 11-12

Kilo Ampere, 8-24, 11-12

KSR, 8-24, 11-45

KSR with regulation and with monitoring, 8-24

KUR, 8-22

KUR (voltage control) with current monitoring,
8-23

L
Linear current response curve, 10-23

Log memory, 10-2

Lower Tolerance Band, 11-33

M
Mains voltage compensation, 8-22

Max Pressure, 10-23

Max. repeat welds, 10-28

Max. Welding Time, 10-28

Maximum pressure, 11-50, 11-55

Maximum secondary current, 10-12

Maximum wear, 11-24

maximum welding current, 10-12

Mean phase angle, 11-35

Measurement Circuit Test, 10-29

Measurement Loop Check, 10-29

Medium-frequency welding, 8-2

Messages, 13-1

Middle PHA, 11-35

Mixed, 8-25

Mixed Monitoring Mode, 11-34

Monitor Contact, 11-51, 11-56

Monitor Stepper, 11-43

Monitoring, 10-32, 11-11

Monitoring Parameters, 11-31

Monitoring Stopped, 10-28

N
Nominal transformer ratio, 10-9

Number of Diodes, 10-12

Number of Transformers, 10-11

O
OFF, 8-11

OFF Time, 8-11, 10-31

On and Off Times, 11-64

Output, 11-61
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P
Param. -> WT, 9-3

Parameters, 9-1, 10-2

Parity, 10-6

Percent Stepper, 11-20, 11-26

PHA, 8-20

PHA without regulation, with monitoring, 8-21

Phase angle, 10-21

Phase Angle Regulation, 8-20

Postheating time, 8-6

Pre-Squeeze Time, 8-10, 11-62

Preheating time, 8-6

Prelift, 8-16

Pressure, 10-23, 11-49, 11-59

Pressure calibration, 10-24, 10-33

Pressure correction, 11-52

Pressure output, 10-33

Pressure profile, 11-49, 11-51, 11-52

Pressure regulating valve, 10-23, 10-34, 10-36,
11-49, 11-55

Pressure Stepper, 11-49, 11-52, 11-55

Pressure Stepper percent change, 11-58

Pressure time, 11-49, 11-53

Pressure value, 11-49, 11-53

Prewarning, 8-12, 11-16, 11-22

Prim. Transf. Ratio, 10-9

Primary current control, 10-11

Program, 9-3, 12-3

Program Selection, 12-3

Programming, 11-2

Projection welds, 8-4

Pulse operation, 8-9

Q
Quality, 11-29, 11-37

Quality assurance, 11-29, 11-37

Quality requirements, 11-31

R
Ready, 10-28

Reference Current, 11-35

Reference current, 11-29, 11-34, 11-35

Reference pressure gauge, 10-33

Reference time, 8-28, 11-37, 11-41, 11-42

Reference time command value, 11-41

Reference value, 11-29

Reference welding current meter, 10-37

Reg.-Mode, 11-10

Regulation, 10-32, 11-11

Regulation Mode, 11-10

Regulation modes, 10-32

Repeat, 10-31

Repeat factor, 11-33

Repeat mode, 8-4

Reweld, 10-29

S
Safe Delete, 10-2

Scale Units, 8-20, 11-12

Scaling, 10-20

Schedule, 8-9, 11-4, 11-8

Schedule (Sequence), 8-9

Schedule - Welding modes, 10-31

Schedule flowchart, 8-9, 11-4

Seal welds, 8-5

Seam, 10-31

Seam mode, 8-5

Secondary current, 10-12

Selection - Timer Info, 12-5

Selection of a program, 12-1

Selection of a timer, 12-1

Selection of corresponding programs, 12-4

Sensor errors, 10-29

Sequence. See Schedule
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Single spot, 8-4, 10-31

Slope, 8-7, 8-9, 11-10

Spot, 12-5

Spot Information, 12-5

Spot Selection, 12-5

Spot weld, 8-4

Spot-Repeat, 10-32

Squeeze Time, 8-10, 11-62, 11-64

SQZ, 8-10

Standard, 8-25

Standard Monitoring Mode, 11-34

Standard Time Monitoring Mode, 8-28

Start, 11-62

Start Counts (Wear), 11-24

Start Inhibit, 11-5

Start Inhibit (P), 10-30

Start Inhibit (T), 10-27

Start Inhibited, 10-27

Start interlock, 8-15

Start section, 11-21, 11-24

Starting window, 9-1, 10-1, 11-1, 12-1

Stepper, 8-12, 9-3, 9-4, 10-15, 11-15, 11-21,
12-2

Stepper counts, 11-24

Stepper Curve, 8-12, 10-16, 11-23, 11-43

Stepper On/Off, 11-21

Stepper parameters, 9-4

Stepper percent change, 11-20

Stepper section, 11-21

Stepper working section, 11-23

Stepper-Setup, 10-20

Stitch welds, 8-5

Stop at end of stepper, 10-15

Supply Volts, 10-9

Switch, 12-1

Switch-Off Temperature, 10-12

T
Thyr. Temp, 10-9

Thyr. Type, 10-9

Thyristor unit, 10-27

Thyristor-Unit Setup, 10-8

Time Monitoring, 11-37

Time Monitoring On/Off, 11-41

Time tolerance, 11-37

Timer data, 9-1

Timer Info, 12-5

Timer Selection, 12-2

Tip Dress Request, 8-13, 11-16, 11-22, 11-24

Tip Dressing, 8-12, 11-21

Tip dressing interval, 11-18

Tipdress counts, 11-24

Tipdress Curve, 10-18, 11-23, 11-43

Tipdressing necessary, 11-16

Tolerance, 11-41

Tolerance band, 8-28, 11-29, 11-32, 11-33, 11-41

Toroid, 10-40, 11-30, 11-44

Toroid correction (turns ratio), 10-43

Toroid input, 11-30, 11-44

Toroid sensitivity, 10-22, 10-39, 10-43

Trail current, 8-26, 8-27, 10-29, 10-39, 10-40

Transformer Ratio, 10-11

Transformer Type, 10-11

U
Up Slope Time, 8-10

Upper Tolerance Band, 11-32

UST, 8-10

V
Voltage measuring circuit, 8-22
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W
Warning, 11-29, 11-30, 11-32, 11-37, 11-38,

11-39, 11-44

WC, 10-6, 11-30, 11-39, 11-44

WC Period, 10-7

WC Start Time, 10-7

WC with error, 10-6

Wear, 8-14, 11-24

Wear counter, 11-55

Wear counter values, 11-43

Wear factor, 8-14, 11-24

Wear/comp, 11-25

Weld Complete, 8-17, 10-31

Weld Transformer Selection, 10-10

Weld/No Weld (T), 10-27

Weld/No Weld int. (P), 10-30

Welding fault, 11-29, 11-30, 11-32, 11-38, 11-39,
11-44

Welding schedule, 8-9, 11-4

Welding system, 8-1

WI release, 11-51, 11-56, 11-62

Without Monitoring, 11-30

Z
Zero adjust, 11-50

Zero adjust value, 10-24

Zero adjustment, 11-55

Zero shift, 10-36
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